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LIKE THE POLAR bear that hibernates for extended
periods of time, one of India’s best-written blogs was
in hiding for a year. It re-emerged mid-January, and
Indian media professionals are secretly celebrating.

Sadly, though, for all our intellectual and tech-
nical superiority, there are few Indian blogs worth
a mention. Rajesh Jain’s views on emerging tech-
nologies—emergic.org—is probably India’s best blog
across all categories; and Pradyuman Maheshwari’s
aforementioned brutal take on the Indian media—
mediaah.com—comes quite close.

Both Jain and Maheshwari are just two of a breed
of what is now a sunrise sector on the Web. At last
count, LiveJournal, one of the Web’s most popular
blogging tool, had nearly 6 million registrations, of
which 2.5 million are active. Various studies on the
Net mention a disputable, but believable figure: a
new blog is created every 7.4 seconds. In the recently
concluded US presidential elections, several blog-
gers were given media status by the government,
and some blogs were as keenly followed by the
voting public as were CNN.com or Fox TV network.

Here is the bitter truth about blogs, though:
They just do not have the reach of a top-notch tele-
vision channel, nor do they have the clout of a high-
selling newspaper. Yet, like the independent
aspirant in the elections who is sure not to win, but
is an irritant to big-party candidates, blogs will
make life a bit uneasy for existing media players.

Because, more than anything else, the blog is a
release. Against urban angst; to propagate knowl-
edge; to say the things you always wanted to say, but
did not know where to publish, or worse, did not
have anyone who would agree to publish.

Columnist Om Malik writes in Business 2.0, a
respected US-based business and tech magazine:
“We are seeing the rise of a new news network,
thanks in large part to technology. Average Joes and
Janes are now armed to the teeth with technology
that can capture and distribute news almost 
anywhere.”

He could not have out it more succinctly.
With blogs, the Web has finally delivered on its

promise—to create an alternate social structure; one
where an individual makes as much an impact as a

multi-core media behemoth. What holds bigger
promise is that traditional media, despite the fact
that they use technology in every possible way to
shore up their core competence areas, are averse to
investing monies in new avenues, either out of igno-
rance or out of apathy. 

This is the baggage bloggers do not carry. 
It is this that will make the blog Your Voice.

The Blog As Your Voice

Editorial

“With blogs, the Web
has finally delivered on

its promise—an alternate
social structure”

Sachin Kalbag Executive Editor

sachin_kalbag@jasubhai.com
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Act Of War: Direct Action
Spanning one large mission, this real-
time strategy experience puts you
squarely in control of counterterrorist
forces to defend the world’s cities
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The Punisher
An action-packed game based on the
popular comic character
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■ Python 2.4
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■ D-Fend 2.0.62.42
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source Content Management System
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By Demand
You get to choose what goes on Digit
Interactive. This month, you chose:

Mandrake 10.1
Flatout

Online Digit Patrons
It really does

pay to be loyal!

Find out more

on www.
thinkdigit. com

Digit Reader Poll

This Month’s Question

Has anyone ever
attempted to clone your
mobile phone? 

Yes, and it was scary!
No, I never give out my

mobile phone
Mobile cloning? What is

mobile cloning?

Log onto www.thinkdigit.com
and vote

General Discussion
From Linkin’ Park to Doom III, 
it’s all here

Digit Discussion
Your feedback on the Magazine, the

DVD, the CD and the Web site

QnA
Thousands of answers to every 

hardware or software query you have

Bazaar
Have money, will buy! Buy 
or exchange hardware or
software

DIGIT FEBRUARY 2005

taste technology at www.thinkdigit.com

Subscribe
No more snail-mail! No need to visit post
offices! All you have to do is log on to
www.thinkdigit.com/subscribe and 
use your Credit Card to make sure you never
miss another issue of your favourite magazine!

January 2005

Software Discussion
Discuss software—from the best
tools to the greatest games

Hardware Discussion
The hangout haven for 
hardware geeks

There’s something for everyone on the Digit Forum www.thinkdigit.com/forum
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Amar Singh
Politician 

High-flying Rajya Sabha
MP Amar Singh is

known for his close
association with the who’s
who of corporate India and
Bollywood. Technology,
though, is not one of his
strengths. He admits he is

still adapting to
technology, and is

candid enough to
admit his overall
tech ignorance.

What does
technology mean

to you?
Technology amazes me

since I grew up in harder
times. Today, when I see a
paperless office or a tiny
chip storing huge chunks of
data, I realise the power of
technology. 
What gadgets do you use?
My Nokia cell phone is
indispensable. My office
handles most of my
correspondence on e-mail. I
also have a home theatre
system.
How tech savvy are
politicians?
Most politicians cannot
take decisions on
technology. 
Do you surf the Net?
Yes. There are Web sites in
my name and I like to
check those. We also have a
basic party website.
Is e-Governance possible
for Uttar Pradesh (UP)?
I believe it is. I met Infosys
CEO Nandan Nilekani, who
plans to frame an IT policy
for UP. We are trying to
computerise land records
and build Internet kiosks,
and Nandan has promised
to turn UP into the new
Silicon Valley.

Pentop Computing
LeapFrog Enterprises’ new FLY ‘pentop computer’ is
a talking pen that can translate words and help
with maths and spelling. A user can draw a calcu-
lator, touch the handwritten digits to perform an
operation, and hear the answers announced.

Twin Menace
‘Evil twins’ are the latest menace to the security of
WiFi Internet users, warn experts in the UK. An ‘evil
twin’ is a bogus base station. Victims may transmit
valuable personal information, not suspecting that
these are being intercepted by cybercriminals.

The Government of India
recently inaugurated the

registration process for ‘.in’
domain names. A special
‘Sunrise’ period, from
January 1, 2005, was
allotted to trademark
holders to register their .in
domain names.  

Corporates as well
as individuals
holding registered
trademarks could
register their .in
domain name till
January 21. Post
January 21,
registration was
thrown open to 
the public. 

Applicants who
did not register
their domain
names ran the
risk of losing
their domains to
cybersquatters.
At present, there are five
lakh trade names registered
in India.

INRegistry
(www.registry.in/), the
official .in registry,
appointed by the
Government of India,
operates under the aegis of
the National Internet
eXchange of India (NIXI).

NIXI is a not-for-profit
organisation that seeks to
facilitate improved Internet
services in the country.
INRegistry functions as an
autonomous body within
the NIXI fold to maintain
the .in ccTLD (country code
top-level domain, which is
used and reserved for a

country or a dependent
territory) and ensure its
operational stability,
reliability and security.
INRegistry will also
implement new initiatives
undertaken by the Ministry
of Communications and

Information Technology
that falls under the aegis of
the Department of
Information Technology.

Accredited registrars
such as Net4India
(www.net4india.co.in),
OnlineNIC (www.onlinenic.
com), DirectI (www.
directi.com) and Good 
Luck Domains (www.
goodluckdomain. com) 
will facilitate the
registration process.

Says Jasjit Sawhney,
CEO, Net4India, “The
‘Sunrise’ period has been
designed to avoid problems
of trademark infringement
and cybersquatting. There
is also a Dispute Resolution

Policy using which,
companies can attempt 
to claim their name back 
if they feel someone is
using one that they have a
right to.”

Most of the top
corporate organisations in
India have registered their
main brand and/or
company names already for
the trademarks they hold.
“Net4India alone would be
registering more than
10,000 names/extensions by
February 16. This is more
than the total ever
registered in the seven to
eight years that the manual
process has been in place,”
says Sawhney.

SECURE YOUR WINDOWS

More
Security
Updates For
Windows

Microsoft Corp is
warning users that

they need three security
updates, including one that
applies even to computers
that have downloaded the
company’s massive fix for
Windows XP. Two of the
flaws which carry the
company’s most severe
threat rating affect versions
of its dominant OS going
back to Windows 98. 

One even affects users
who have downloaded

Enter
GET .IN

‘.in’ Domain Names Up
For Grabs

Illustrations Harsho Mohan chottoraj



Service Pack 2 (SP2), a major
security upgrade for
Windows XP released last
summer, after a series of
crippling attacks.

However, SP2 was never
expected to solve all of
Microsoft’s security
problems, according to
Stephen Toulouse, a
security program manager
at the Washington-based
company. “We knew we
were going to be providing
updates for SP2. The goal
was always around
reducing the number of
critical updates,” he said. 

The third flaw, with a
lesser threat rating of
‘Important’, affects
machines running
Windows XP and Windows
Server 2003. All three, in a
variety of ways, could allow
an attacker to take control
of another computer. 

The flaw that affects
SP2 takes advantage of a
problem with Internet
Explorer that could allow
an attacker to gain control
of a computer if the user
were persuaded to visit a
malicious Web site. 

The other severe flaw
could be exploited if a user
employs a specially
formulated cursor or icon
that secretly allows the
attacker to gain control of
another person’s computer. 

The new security fixes,
released as part of
Microsoft’s regular
monthly security updates,
come a week after
Microsoft said it would
begin offering a free
program to remove the
most dangerous infections
from computers. Many
users have already 

received that removal tool.  
Last week, the company

also began offering a free
program to remove
spyware. Spyware can
monitor computer users’
activities, send annoying
pop-up ads and slow
computer performance.
Microsoft has also
confirmed plans to sell its
own anti-virus software,
which would compete
against programs from
McAfee, Symantec 
and others.

MS RESEARCH IN INDIA

Microsoft
Research
Facility
Inaugurated

Microsoft, the global
software, services and

solutions giant, has
launched its research facil-
ity in Bangalore. 

Microsoft Research
India (MSRI), the third
such facility outside the US
and only the sixth of its
kind in the world, was
inaugurated by Minister of
State for Science and
Technology and Ocean
Development, Kapil Sibal.

The state-of-the-art
facility will initially focus
in areas of Geographic
Information Systems (GIS),
technologies for emerging

markets, multilingual
systems and sensor
networks. On the occa-

sion, MSRI and the
Ministry of Science and
Technology signed
Memorandum of
Understanding (MoU) to
partner in science and
technology projects.

The first collaborative
project will be in GIS to
bring in a variety of satel-
lite imagery, remote sens-

ing and other geographic

Sunny Sharma, Mumbai
Manish Patwardhan, Mumbai

Broadband
BSNL's new
broadband
service
offering
speeds

between 256 Kbps and 2
Mbps, accessible in 198
cities across India. Plans
start as low as Rs 500 and
go up to Rs 9,000.

Data
Transfer
Limits
Under the
Home 500 plan,
consumers are
restricted to 1
GB of data transfer per
month. Under other plans,
the usage limitation will
range from 2 GB to 10 GB.

Does anything work perfectly on the

Microsoft Windows XP OS?    After installing Norton AntiVirus,
there were more viruses than before! Sonam Talwar, Gujarat

Ads and spyware! DAP mademy PC run at snail’s pace!
Abhishek Jain, Rajasthan

Tally—the exact opposite of anything

that is easy and user-frien
dly!

Durgesh Dhargalkar, Goa
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Security Watch

E-mail Hoax

The problem
Phishers are stooping to new
lows, exploiting would-be
humanitarians. Web security
firm Sophos said on January
17 that there is a mass e-
mail floating around that
poses as a plea for aid to
help the victims of last
month’s Tsunami disaster.
The e-mail is a vehicle for
spreading a virus.

The worm appears with
the subject line, “Tsunami
donation! Please help!”
Recipients are asked to open
an attachment titled
‘tsunami.exe’. If the
attachment is opened, the
virus gets forwarded to other
users in the address book.

Damages
Sophos said that, so far, it 
had received only a small
number of reports of the
worm affecting users. 

The e-mail appears to be
primarily a vehicle for
spreading the virus. It could
also initiate a denial-of-
service (DoS) attack against a
German hacking Web site, in
which that site’s server would
be bombarded with messages
and thereby put out of action.

Precautions
It’s easy to protect yourself
against this one. Just do not
open the attachment and
delete the mail.

One Silly Question Which software would you like to do away with?   

Is Lotus Notes boring or what? Toomany complications…never liked it!
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Pulse

Tech Support Sites

EExxppeerrttss  EExxcchhaannggee  
A free lunch does not exist. Take this
site: it lets you search for free, but
when you are about to get an answer
to your question, you realise you need
to register ($9.95 or Rs 433 per month)
for the complete answer. A definitive
tech support site, you can search for
solutions, question tech experts or as
registered users, browse whitepapers
and request webcasts. Not bad.

EErrrroorr  MMeessssaaggeess  
Add this site in the favourites of your
browser! Just what you need, when you
get an error message on Windows and
you are stuck. Did IE say something like
‘Mprexe Caused an Invalid Page Fault
in Module Kernel32?’ On this site, you
will find a link to MS Knowledge Base
article with details about the error and
how to resolve it. 
AAnnsswweerrss  TThhaatt  WWoorrkk  
It’s a pity that all good things online are
no longer free. The Ultimate
Troubleshooter at ‘Answers That Work’ is
priced at $25 (Rs 1088) for a single
license. You can search ‘Libraries of
Answers That Work’, ‘The Task List’ that
help you figure out what a certain
running process does and more. The
libraries contain answers to numerous
problems. Worth a dekko but once again,
be ready to pay.

www.generation.net

www.answersthat-
work.com

www.experts-
exchange.com

data in a geographically
indexed database.

“MSRI will make much
of the government’s non-
sensitive geographic data
available to the public in a
format that is easy to
browse and comprehend,
with intuitive visualisation
of data. Eventually, such a
system could enable people
to exchange information,
much like the Internet, but
indexed by region and
geography,” said MSRI man-
aging director P Anandan.

Research for this proj-
ect will involve work 
from relevant fields of
computer science, includ-
ing GIS, graphics, user
interfaces, spatial databas-
es, image processing and
computer vision.

MSRI plans to employ
about 24 scientists, interns
and support staff in the
first year.

MSRI is also initiating
several projects in the ICT
space by funding university
research projects.

“We have selected spe-
cific projects through the
request for proposal (RFP)
process from various insti-
tutions across the country
and awarded them

$250,000 (Rs 1.09 crore) 
in total funding for 
these projects,” added
Venkatesan.

Some of the institutions
where the projects will be
undertaken are Birla
Institute of Technology and
Science, Pilani; Indian
Institute of Information
Technology and Indian
Institute of Science,
Bangalore; and the Indian
Institutes of Technology
(IITs) in Mumbai, Delhi,
Kanpur and Chennai.

Incidentally, China and
India are the only two
countries outside the US
where Microsoft has the
entire scale of operations,
including software develop-
ment centres, sales and
marketing offices.

ROBO-COLLEGE!

Rocking
Robotix

The National Robotics
competition of IIT

Kharagpur, ‘.:Robotix:.’,
held with Kshitij, the
annual techno-
management festival of 

A Round-up of Technology News from Across the GlobeThe Digital World

EQUATORIAL GUINEA

A device is being developed that will allow
the recording of sophisticated wildlife data
on a palmtop. Connected to GPS satellites,
it will record the precise location and time

of animal sightings. Such data collection
could help save endangered species.

CANADA

January 17, police arrested eight men and seized
computers and thousands of pictures when they
smashed a child pornography ring of
unprecedented scale in Ottawa. The Ottawa Police
High Tech Crime Unit said officers swooped against
an operation to buy child porn over the Internet.

GERMANY

Metro Group, the world's third-largest
retailer, said on January 20 that it had
completed the implementation of RFID
readers and tags at its largest distribution
centre in Germany.

SWITZERLAND

One of the country’s two makers of
Swiss Army knives is going the tech
way. Victorinox is promoting its
‘SwissMemory’ series, comprising 512
MB ‘USB’ knives.

SPAIN

Police have arrested a man suspected of
writing a virus capable of spying on users
through their Webcams. The  programmer
from Madrid allegedly distributed the virus
over a file sharing network.

RUSSIA

President Putin recently convened a
meeting focusing on the creation of
technology parks. The Russian IT and
communications minister said Russia
would invest some $650 million (Rs 280
crore) in the IT sector in five years.

CHINA

Three Incredibly Useful Sites

China is fast becoming a nation of
prolific Internet users. A recent
report says two-thirds of Chinese
Internet  users will purchase
something online this year and
young people favour getting their
news on the Internet instead of TV.

DIGIT FEBRUARY 2005
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the IIT, will be held from
February 4 to 6, 2005 at the
IIT Kharagpur campus. 

The event covers various
fields in Robotics including
mechanical design, image
processing based computer-
controlled robotics,
microcontroller-based self-
contained robots and
artificial intelligence (AI). 

This year, PowerBoats,
Cannon Balls, Lodestones,
and Mission Mars /
Conquerors are what the
categories have been named.

Started in 2001 as an
Intra-IIT technical event,
Robotix today enjoys
worldwide participation.
This year’s event has
already received 350
registrations, and more are
coming in. The ‘Mission
Mars’ event this year has
teams from Georgia Tech,
Arizona State University,
SUNY Buffalo and
University of Texas
participating. A team from
Pakistan has also
confirmed participation.

Another highlight 
of this year’s edition will
be an exhibition by KRAIG
(Kharagpur Robotics and
Artificial Intelligence
Guild—a student club). 

The robots to be featured
include:

EPIA-based multi
purpose test-bed robot: This
robot will demonstrate the
tele-operation and
exploration of unknown
space; sensorial features are
IR sensors, Sonar, Flame
Detector, Human Detector
and a camera to top it off.

An all-terrain vehicle:
This is based on a variant of
the rocker boogie echanism. 

Mister-X: A robot that
will be programmed to
draw a picture of Gandhiji

on card paper.
An analogue line tracer:

This can make decisions 
at junctions.

A robot that can be
controlled wirelessly: The
objective is to give
intelligence to the
computer and make this
robot perform a variety of
tasks without any changes
in hardware. 

More details of the
event and activities
planned are available at the
Web site, www.kshitij.
iitkgp.ernet.in.

PLAY AND FAIL

Kids Playing
Computer
Games Fail
In Studies

Anew study being
conducted by leading

scientist Prof Robert
Winston suggests that
children who spend hours
playing computer games
and watching television are
failing to develop skills
needed to succeed at school.

According to the Daily
Mail, he added that
youngsters are not
acquiring long-term powers
of study and application
they need in class. This is
mainly because the games
they play and the TV
programmes they watch
require only short-term
bursts of concentration.

The programme
surveyed a group of
primary school pupils and
found one in five had
played ‘Grand Theft Auto’—
a notorious 18-certificate
game where players steal

Pulse

Photograph Jiten Gandhi

Last Month’s Winner!
Nishant A. Patil, Mumbai is the
winner for his caption: “No
honey...this is not how they
send junk mail...!”

Send your captions to
beatthat@thinkdigit.com and
win a book!
Webster’s New World
Computer
Dictionary By
Bryan
Pfaffenberger,
published by
Pearson Education

One of the robots from last year’s edition of Robotix

Every month, Digit will carry a caption for a photo. Come up with

something funnier, and beat the Digit team at their own game!

Digit Caption
“Carttops for Sale”
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cars, kill people and pick
up commercial sex workers!

“Many children who
love computer games find it
hard to concentrate on the
sort of tasks that require
slow application and are
necessary for school
success,” said Prof Winston.

To reach his
conclusions, Prof Winston
studied the impact of
computer games on
children’s ability to tackle
various tasks. He found that

those who spend long
periods playing quick-fire,
adrenaline-pumping games
often lack a long- term
attention span. Children
who have PCs and TVs in
their bedroom tend to sit in
front of the screen into the
early hours instead of
getting enough sleep.

“Children are sleeping
between two and five hours
less than their parents did
at the same age. This affects
performance at school and

the behaviour at home and
some of this is due to
games,” he added.

“Digital media may well
have some dangers as well
as some advantages for
children. Modern children
are spending three to four
hours a day in front of a PC
or TV screen of some kind,
often unsupervised,”
lamented Winston.

IS THIS THE REAL THING?

A New
‘Broadband’
On The Block

BSNL launched the first
ever ‘Broadband’ service

in the country on January
14, 2005. Prior to this, the
Department of
Telecommunication (DoT)
officially recognised
‘broadband’ as ‘Internet
with connection speed at a
minimum of 256 Kbps’. 

With the launch of its
‘DataOne’ services, BSNL
has become the first
Internet Service Provider
(ISP) to promise bandwidth

up to 2 Mbps in
two packages,
namely, the ‘Home

Plan’ for single
terminals and the

‘Business Plan’ that
allows multiple terminals
to access the Net on a
single connection.

Based on Asymmetric
Digital Subscriber Line
(ADSL) technology,
DataOne allows copper
telephone pairs to be
used to provide a

broadband connection. 
DataOne starts at Rs

500 per month and goes up
to Rs 9,000 per month
(Business Plan). Other
players in the market, such
as Airtel Broadband and
Reliance Broadband, are
still offering speeds of 64
Kbps, and they are calling
that ‘broadband’! 

While Airtel offers the
64 Kbps package at Rs 249
per month, DataOne offers
256 Kbps at Rs 500. Reliance
also offers bandwidth
speeds between 64 Kbps and
100 Kbps, but nothing
compared to the 1 Mbps
being offered by BSNL.

As the largest telecom
service provider in India,
BSNL has an edge over
private players. 

N Chenjaya, general
manager, BSNL, says, “We
think broadband will be a
success because our
network is our strength. We
have a good reach across
the country and can reach
out to the masses faster.”

The private players
would agree. With plans to
use the power of the
Internet for e-governance
and to put into place a
centralised State Wide Area
Network (SWAN) across
various states in India,
BSNL will now be in both
voice and data spaces

GENDER 

BENDERS

Raring to go, Aniket sets out like an expert. Rebooting the
PC, he presses the ‘Delete’ key that leads to the BIOS setup
utility. But hey, the screen looks different and the advanced
BIOS features option is nowhere to be seen! Fortunately,
Aniket notices the ‘Boot’ tab. He alters the order of the boot
devices and sits back relaxed. Not bad at all.

Aniket Shingote v/s Amruta Sawant
Boot A PC From A (bootable) CD

2 min 
13 sec

1 min 
34 sec

Edgy to start with, Amruta lightens up once she hears the
task. Calmly, she reboots the PC and waits. Before we can
even bat an eyelid, she suddenly presses F8, which directly
takes her to the ‘Select Boot Device’ table. Presto! She
carries out the changes effortlessly, all the time chuckling to
herself. Piece of cake!

Designed to detect Tsunamis as small as one
centimetre, DART systems consist of a

seafloor Bottom Pressure Recording (BPR) sys-
tem and a moored surface buoy. The BPR runs an
algorithm that generates predicted water height
values and compares new samples with the pre-
dicted values. 

An acoustic modem transmits data—on an
hourly basis—from the BPR to the buoy, which is
then relayed through a Geostationary
Operational Environmental Satellites (GOES)
satellite link to ground stations. Ground stations
demodulate the signals and broadcast the
readings to Tsunami Warning Centres worldwide.

DART—Deep-ocean Assessment and Reporting of Tsunamis
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GADGET GLUTTONY

CES 2005: 
Setting The
Stage For
New Ideas  

With over 140,000
attendees from 115

countries witnessing the
introduction of thousands
of new products and
technologies from more
than 2,500 exhibitors, the
Consumer Electronics Show
(CES) that ended in Las
Vegas on January 9, lived
up to its billing, and
proved to be the biggest
stage for new products 
on earth! 

The four-day event 
saw executives from
consumer technology,
broadcasting, cable,
motion picture and
numerous other industries
converge in Las Vegas to
hear from technology
industry visionaries and
view a showcase of hot new
products and trends in
audio, accessories, home
networking, mobile
electronics, video and
wireless equipment. 

The 2005 edition also
set several major show
records including number
of attendees (1,42,585,
subject to audit),
exhibitors (2,550) and
exhibit space (1.531 million
net square feet).
International attendance

also grew to more than
23,028, up from 18,000 at
the 2004 edition.

Featuring a broad array
of exciting product and
technology introductions
and announcements, many
of which provide
consumers with
unprecedented control over
when, where and how they
watch movies, listen to
music, view their digital
photos and access other
information, education and
entertainment content. 

Showing the strength of
the transition to High
Definition Television
(HDTV), the show featured
the latest developments in
display technologies and a
variety of products and
innovations that build
upon HDTV.

In addition to being a
product showplace, the
2005 edition included a
star-studded array of
industry luminaries
delivering speeches and
participating in over 350
conference sessions. 

Speakers included
Microsoft chairman and
chief software architect Bill
Gates, Craig Barrett, CEO,
Intel Corporation, Ron
Garriques, executive VP,
Motorola, Carly Fiorina,
chairperson, HP and Rich
Templeton, president and
CEO, Texas Instruments.

Some of the most
noteworthy launches at the
show were: 

TV and Video: Sling
Media's Slingbox that lets
you actually redirect live or

PVR-recorded television to a
wireless computer and
Samsung's 80-inch plasma
flat TV that earned them
the bragging rights at 
the show!

Media Devices: Belkin
TuneStage that enables
iPods to wirelessly stream
music to home stereos 
and simultaneously serve
as a remote control, 
Archos Portable Media
Assistant PMA 430 that has
a 30 GB hard drive and can
screen movies from TV,
DVD and VCR and
Olympus’ M:robe 500 and
100 MP3 players with
touch-screen, camera and
20 GB (5 GB in the M:robe
100) hard drives.

Gaming: Gizmondo
unveiled an eponymous
portable gaming device
that's a Swiss Army Knife
among handheld consoles
being an on-the-go gaming
platform delivering
wireless text messaging and
e-mail, GPS capabilities, a
digital camera, and a
portable video player.

Telephony: Samsung,
LG and BenQ launched new
smart phones (some with 
a 2-megapixel camera),
Netgear Pre-N launched
their Wireless Router 
while Corinex's Internet
Video Phone.

Notebook: Toshiba 
R15-S822, the first Sonoma-
enabled notebook. 

Software: Meedio, a
company that's been
working diligently on a
software alternative to
Windows Media Centre,
released a digital video
recorder (DVR) package
called Meedio TV. 

Photography: Kodak's
EasyShare One, their first
Wi-Fi enabled camera,
Pentax's Optio WP, a
waterproof digital camera,
Minolta Magiolor, a
PictBridge 1.0 compliant
photo-friendly laser (yes,
laser) printer.

Home Theatres: Philips
launched its Pronto-
branded touch-screen
controllers.

Compiled by Meera Vankipuram,
Preethi Chamikutty, Ahmed Shaikh,
Ram Mohan Rao and Aditya Kuber 

What is Sonoma?
Sonoma is the code name for
the second generation of the
mobile Centrino notebook
platform. The platform
includes a Pentium M
processor, the chipset and
the Wi-Fi card.
How does Sonoma improve
over the original Centrino
platform?
The Pentium M processor
now has a front-side bus
increase from 400 MHz to
533 MHz. There is now
support for dual-channel
DDR2 memory and graphics
support for the PCI-Express
bus architecture. The chipset
is new and has been code-
named Alviso. The Centrino’s
integrated graphics has been
upgraded by including the
Intel Graphics Media
Accelerator 900—-the first
DirectX 9.0 integrated
graphics solution for
notebooks. There will also be
the newly-released Intel
PRO/Wireless 2915ABG
network connection.
Who released Sonoma?
As a successor to the Centrino
platform, Sonoma was,
naturally, released by Intel. 
Why do we need Sonoma?
The answer is performance.
Support for PCI-Express had
to be brought in to Intel’s
mobile platform at some
stage. Intel is touting
Sonoma and the
accompanying Alviso chipset
as key breakthroughs in
mobile performance and
functionality, especially in
areas such as digital media
processing.
When Sonoma released?
Sonoma was released on 19
January 2005.
Where can I find a
notebook that has support
for Sonoma?
Intel expects system builders
and OEMs to offer as many as
150 notebook models based
on the Sonoma release. For
example, Toshiba unveiled its
latest tablet PC at the 2005
CES. The new Toshiba R15-
S822 that launches in
February includes support
for Sonoma. Lexar’s new digital music player that was launched at CES 2005
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The Codebreakers
ties, evaluate systems’ security practices and
report loopholes as well as remedial measures to
the owners.

They can perform security audits for compa-
nies—testing a system for vulnerabilities and sub-
mitting a report. This kind of work may not even
require the services of an ethical hacker per se.
Alternatively, they could actually attack a security
system, seek out the vulnerabilities that a mali-
cious hacker could easily exploit and, of course,
report or fix them.

India’s ‘underground overlords’ of the IT
realm are nestled in small—mostly, home—offices
in the quiet suburbs of Mumbai, Delhi and sev-
eral other cities across the country. These code-
breakers and security experts are busy scouring
networks to seek and destroy vulnerabilities.

Ethical hacker Shomiron Das Gupta, a Certi-
fied Information System Security Professional
(CISSP) and GIAC Certified Intrusion Analyst
(SANS Certified), was formerly employed with
ICICI InfoTech as a security consultant, before

Meera Vankipuram

he word ‘hacker’ conjures up an image: an
evil person keen on disrupting systems for
fun’s sake—and so that he (a hacker is usu-

ally a ‘he’) can boast to his friends about the sys-
tems he’s breached. The term ‘ethical hacker’,
may, therefore sound like an oxymoron. 

However, ‘ethical hackers’ do exist, and these
masters of their craft are the mirror image of
what people think of hackers. They possess pretty
much the same skill set, but use them for the
exact opposite reason—to identify vulnerabilities
in systems so that corrective action may be taken.

The term ‘hacker’ originally referred to those
involved in creating a new program or making
changes to existing, complex software.

Ethical hackers employ the same tools and
techniques as malicious hackers, or ‘crackers’, but
they do not damage the target systems, nor steal
information. They test networks for vulnerabili-

Fear and hatred are the emotions that hackers normally evoke. But there are two kinds of
this breed as well. Meet the ethical kind

Im
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In the business of security (L
to R): Shomiron Das Gupta
(CISSP),  Jagdish Mahapatra
(BDM, Cisco Systems), KK
Mookhey (CISA)



moving out to start his own security firm, Net
Monastery. He also founded the EHA (Ethical
Hackers’ Association) “to increase awareness
about security in the tech community and to edu-
cate programmers on measures to avoid mistakes
that attract bugs or cause vulnerabilities.”

Says Das Gupta, “Hacking is more about
instinct than hardcore programming skills. You
have to understand network architecture and be
adept with hacking tools. But to be an ethical
hacker, one has to build trust… which takes time
to establish but can be lost easily.”

KK Mookhey, a Certified Information Systems
Auditor (CISA) with over four years of security

experience, agrees.
“The gains are low in
malicious hacking,
and really, it makes
stupid business
sense to cross that
line,” he says.

Both swear by
the Code of Vulnera-
bility Disclosure—
inform the vendor
first on discovering a
vulnerability, ask for
a time period and
assurance that the
flaw will be fixed.
“Else, you threaten
to go public,” says
KK, whose team has
discovered vulnera-
bilities in soft-
ware from vendors
like Microsoft,
Oracle, Nortel and
Macromedia.
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Das Gupta and KK represent the growing
breed of young security professionals in India. In
the recent past, India has seen a host of teenage
prodigies emerge in the security space. Sixteen-
year-old Namit Merchant, for example, is the
youngest ever CISSP—a widely-recognised certifi-
cation, which requires a minimum of three years
of full-time professional computer security expe-
rience, prior to taking the test.

Ankit Fadia, a teen prodigy, was just 16 when
he authored The Unofficial Guide to Ethical Hacking.
A Computer Security and Digital Intelligence Con-
sultant, he is now one of the best-known ethical
hackers in India.  

The S-Word 
Security threats for companies (SMBs and
enterprises) have gained prominence in the
last few decades. With more and more govern-
ments and companies jumping onto the ‘world
wide web’ bandwagon, seamless connectivity
(through Virtual Private Networks, for exam-
ple) across branches is crucial for efficient
functioning of a business network.

Today, viruses and worms proliferate on the
Web within a matter of minutes. Not only do
networks and security systems need to react
instantaneously, security companies also need
to develop more complex and stable solutions.
SMBs usually employ a team comprising a Sys-
tems Administrator and security experts to
monitor networks, 24x7.

Some of the best-known names in the secu-
rity industry include MIEL e-Security, Mahindra
SSG, SecureSynergy, HCL Comnet, IT Secure,
and Cisco Systems. Security firms offer services
such as penetration testing, vulnerability
assessments, security audits, consulting 
and education. Many security companies 
also develop security assessment and 
intrusion-detection tools, and engage in secu-
rity-related research. 

Careers In Hacking
Says Jagdish Mahapatra, business development
manager, Cisco Systems, India and SAARC,
“Organisations are beginning to realise that secu-
rity has to be top priority on their IT investment
budget. It’s the level of protection that causes the
dilemma. Most SMBs have a security policy in
place, but these have to be updated on a regular
basis based on the company’s needs, the current
environment and threats.”

Security firms employ ‘certified ethical
hackers’ to perform audits as well as develop
security tools. But are they wary of hackers?
“Anyone who can wreak havoc is a useful 
tool for a security company. Especially 
while building a security system for a 
network, hackers come in handy—they come up
with different ways of penetrating the net-
work,” says Mahapatra.

Security engineer Kartikeya Puri of MIEL
eSecurity, says, “Though security companies
develop exploits, some organisations prefer just
random audits—by running tools like Nessus, a
vulnerability scanner—to generate reports. You
don’t really need to be a hacker for that! Even
my ten-year old brother can run that tool! Secu-

TToooollss,,  ddiissccuussssiioonn  ggrroouuppss  &&  vviirrttuuaall
ssyysstteemmss
Insecure.org:
http://www.insecure.org/
Pull The Plug:
www.pulltheplug.org
Whoppix Penetration Testing
Toolkit: 
http://www.whoppix.net/
The PacketStorm IP Network
Emulators:
http://www.packetstorm.com/
K-OTik Security (French):
http://www.k-otik.com/
Phrack (Hacker E-zine):
http://www.phrack.org/
Hacker's Lab:
http://www.hackerslab.org/

Honeypot Project (Online honeypot
deployment):
http://www.honeynet.org/
Crackmes.de (Challenges for
reversers, newbies, white hats and
black hats):
http://www.crackmes.de/
Eric S Raymond’s homepage:
http://www.catb.org/~esr
Carnegie Mellon Software
Engineering Institute:
http://www.cert.org
The SANS (SysAdmin, Audit,
Network, Security) Institute:
http://www.sans.org
Ethical Hacker's Association (India):
http://www.netmonastery.com/eha
/eah.htm

CCoonnffeerreenncceess
DEFCON:
http://www.defcon.org/
Black Hat conference:
http://www.blackhat.com
COMDEX:
http://www.comdex.com/

Ethical Hacking 101 - Resources You Can Use

Stage 1: Scanning, sniffing the
network to discover vulnerabilities 

Stage 2: Exploiting 
vulnerabiilites to gain access 

Stage 3: Causing damage,  cov-
ering tracks (replacing system bina-
ries with custom-made commands,

manipulating intrusion detection sys-
tems/logs/audit data)

Stage 4: Using mail server to gen-
erate spam/ running an IRC server,

scanning other PCs on network)

Infographic Jayan K
 N

arayanan

Anatomy of an Attack



rity engineers normally protect the critical
resources of a company—server side applica-
tions and Web sites.”

Hierarchies In Cyberia
At the bottom of the hacker hierarchy is a ‘script
kiddie’—a malicious hacker with little or no
skill. These guys can cause a lot of damage with
their shoot-in-the-dark methods. A ‘white hat’ or
‘sneaker’, who also breaks into networks or
seeks vulnerabilities, does so for ‘altruistic’ rea-
sons. ‘White hats’ usually report bugs or vulner-
abilities to the vendors. 

‘Black hats’ or ‘Crackers’, on the other hand,
are on the lookout for vulnerabilities in net-
works and software, and enjoy destroying vul-
nerable networks.

Top-notch hackers—usually referred to as
‘Wizards’ or ‘Gurus’—have been associated with
some of the biggest names in the software busi-
ness. The best-known amongst these are Richard
Stallman, founder of the Free Software Move-
ment and GNU projects, which nurtured the
development of the GNU/Linux operating system
(OS), and Linus Torvalds, who developed the
Linux kernel in 1991. 

Hackers get to match wits at events such as
DEFCON (www.defcon.org) dubbed the “largest
underground hacking event in the world”, the
Black Hat conference (www.blackhat.com)—a
melting pot of hackers, security experts, govern-
ment officials and network administrators, and
COMDEX (Communications and Data Processing
Exposition)—a hardware and software tradeshow.

Enemy At The Gate 
Vulnerabilities abound in networks. Security
professionals are privy to this knowledge, espe-
cially during audits. They have no reason not to
distribute this knowledge for profit or even
exploit the vulnerability.

According to Puri, some of the most potent
hacking attacks include distributed denial of
service; idle scanning—exploiting the bugs on a
server running on the network and then taking
control of the rest of the infrastructure; sniffer
attacks—where a sniffer is installed on one of

the servers and compromises the information
flow; attacks on the border routers/ switches;
overflows (buffer/heap/stack-based) in server soft-
ware; and social engineering attacks. 

Once a network has been compromised, the
intruder gains ‘Administrator’ privileges, and
using certin tools (‘root kits’) disables security
auditing. At the end of their stay, using the same
tools, the intruders simply turn on auditing again. 

Says Prakash (name changed), a cracker-
turned-security engineer from Bangalore, “Most
networks cannot guarantee 100 per cent security.
Online banking systems in India, for example, are
vulnerable to attacks. But it involves a lot of
work—traffic to the site has to be sniffed, data has
to be encrypted, the network scanned for vulner-
abilities, firewalls disabled, and so on. But a break-
in is certainly possible.”

Dancing With The Devil
For every successful ethical hacker or systems
administrator, there is a hotshot cracker waiting
to get the better of him. Although there is big
money involved, the cat-and-mouse game
between security experts and malicious hackers 
is also a battle of extremely creative minds.
Hackers are constantly upgrading their knowl-
edge, while virus writers continue to unleash
their creativity on the Web. 

Genuine hackers “seek to create, nurture and
contribute to the evolution of more efficient com-
puter networks”. 

“Ethical hacking is subjective; its interpreta-
tion varies—I could enter a network and snoop
around without causing any significant harm.
Does that make me any less ethical?”, asks Puri. 

Yet, he confesses it is hard to stay ‘ethical’
when one has knowledge and access to sensitive
and potentially lucrative information. 

Thomas Anderson or Neo, from The Matrix, a
“program writer for a respectable software com-
pany... and a hacker guilty of virtually every com-
puter crime we have a law for...”, is merely a
stereotype. Not all hackers are malicious and not
all ethical hackers are saints. But which hat would
you rather wear? 

meera_vankipuram@thinkdigit.com
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Innttrruussiioonn  DDeetteeccttiioonn:: The processes
involved in detecting inappropriate,

incorrect or anomalous activity
happening in a network. 

Intrusion Detection Systems (IDS) are
employed to determine if a computer
network or server has fallen prey to an
unauthorised intrusion.

HHoonneeyyppoottss::  Closely monitored network
decoys that help distract intruders from
attacking more valuable machines on a
network and causing damage. 

Honeypots ring the early warning
bells about an attack and help study
exploitation trends. Deployment of
honeypots usually does not affect

critical network services or
applications.

CChhaalllleennggee::  A virtual system designed by
programmers with various hacking-
related goals/problems to be solved 

EExxppllooiitt:: An application designed to
penetrate known vulnerabilities in a
network or software 

SSnniiffffeerr:: A tool that that captures
passwords and other data while in transit
within the computer or over a network 

SSoocciiaall  eennggiinneeeerriinngg:: The practice of
conning people into revealing sensitive

data on a computer system, often on the
Internet. In other words, exploiting the
weakest link—more often than not, users 

VVuullnneerraabbiilliittyy  ssccaannnneerr:: A tool that scans
computers on a network for known
weaknesses. Port scanners look for “open
ports” to gain entry into the network. 

MMaann  iinn  tthhee  mmiiddddllee  aattttaacckk  ((MMTTMM))::    Here, an
attacker reads and modifies messages
between two parties without letting either
party know that their link has been
compromised. 

The attacker normally observes
and intercepts messages that travel to
and from the victims’ PCs.

Hackerspeak: Jargon Explained

Ethical hacking is
subjective; its
interpretation
varies—I could
enter a network
and snoop around
without causing
any significant
harm

Kartikeya Puri, 
MIEL eSecurity



30 DIGIT FEBRUARY2005

Take a Crack 
and Win
Webster’s New World
Computer Dictionary
By Bryan Pfaffenberger
Published by Pearson Education

Rules and Regulations
Readers are requested to send

in their answers by the 15th of the
month of publication.

Employees of Jasubhai Digital
Media and their relatives are not
permitted to participate in this
contest.

Readers are encouraged to
send their replies by e-mail.
Jasubhai Digital Media will not
entertain any unsolicited
communication.

Jasubhai Digital Media is not
responsible for any damage to
your system that may be caused
while you are solving the
problem.

So you downloaded
Service Pack 2 for
Windows XP? How do
you go about creating
a bootable Windows
XP installation CD
with SP2 integrated
but using your 
existing CD? 
Send your solutions
to takeacrack@
thinkdigit.com 

Last month, we asked you 
how you could safely
overclock your CPU.
Unfortunately, none of 
the entries we received were
good enough to deserve the
prize. So here’s the soution:

Most processors allow
overclocking only to a
certain extent. Others, by
virtue of their design, allow
it a little more. Most
processors today have their
clock multipliers locked and
this prevents them from
being tweaked through that
component. In such cases,
the bus speed needs to be
used, but you need to take
care when you do this so
that the rest of the system is
not adversely affected.

Keep in mind that your
warranties will not cover any
damage cause by over-
clocking; so be very sure of
the extent to which you can
push your system safely. 

The first by-product of a
tweaking experiment will be
the generation of heat in
your critical components. So
before you embark on this
task, ensure you have
adequate cooling for
components like the
processor, RAM and
motherboard chipset. 

Steps To Overlock
Your CPU

Consult the manual to  
make sure that your 
motherboard supports 
overclocking through 

jumper settings or BIOS 
tweaks. Only when you are
sure that you can change the 
CPU’s core voltage, clock 
multiplier or bus speed,
should you go about 
pushing your system harder. 
To overclock:

Enter the BIOS by
rebooting your computer and
hitting the [DEL] or the [F2]
key. The exact steps will vary
according to your BIOS type
and version. Refer to the
motherboard manual to help
locate the FSB frequency and
the CPU voltage settings.

Increase the CPU FSB
frequency in small
increments of, say, 2 MHz.
Change the CPU Speed/
Voltage Settings to ‘Manual’
to let you change them.
Note: Throughout this
exercise, monitor your
system temperatures and
voltages very closely. It is
critical that they remain
within limits for your system
to run reliably. Failing to do
so will result in shortening
the life of your processor or
even failure. It is important
to start out your

overclocking at the rated
settings and work your way
up in small increments 

Save your settings and
reboot the machine. The PC
should boot normally. Check
for any signs of instability.
Run a CPU-intensive program
or game like Half-Life 2 to
stress the CPU and make
sure it is working fine.

Reboot and enter the BIOS
again. Increase the CPU
voltage, again in small
increments. Restart and
repeat the previous step.
Continue till you feel the
machine has been pushed to
its limits.

Reboot and enter the BIOS
again. Increase the CPU
voltage, again in small
increments. Restart and
repeat the step 4. Continue
the process till you feel the

machine has been pushed to
its limits. A stable over-
clocked system is one that
has the right balance
between CPU FSB, voltage
and bus speed settings.
Overclocking is achieved by
trial and error and we
cannot overemphasise the
importance of safety.

Creating a
bootable
Windows XP
installation CD
with SP2

THIS MONTH’S CHALLENGE

How To Safely Overclock Your CPU

LAST MONTH’S CHALLENGE

Win!

Changing the CPU FSB frequency

Changing the CPU Voltage
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Varun Dubey

Man’s need for speed is perhaps the
strongest driving force behind his inno-
vations; blazingly fast Ferraris and

supersonic jet planes bear testament to this.
Computing, of course, has not been left
untouched. In fact, the advances in technology
in terms of processing power have been so rapid
over the past 10 years that had they been repli-
cated elsewhere, we would have already visited
the most distant galaxies!

One aspect of computing—the PCI bus—has,
however, remained untouched for almost a
decade! We demystify the latest buzzword in the
tech world—PCI express. 

Everyone On The PCI Bus!
We need to first understand how PCIe works, and
why it is needed, let’s first understand the basic
working of a ‘bus’. A bus is a bunch of conduc-
tors, and is primarily a means of transferring
data from one system component to another. For
example, a bus is used to transfer data from your
hard disk to the printer, or from the processor to
the memory, apart from other functions. PCI
uses the shared bus architecture, where the
devices attached to the bus share the bus’ band-
width when working. 

It is interesting to note that the PCI bus is the
oldest, slowest bus (or piece of technology, if you
will) on your motherboard. Considering that it
connects everything else—the latest video cards
to the processors to the latest memory—it’s a bit
scary. In the infographic (on page 33), note how
underserved devices connected to your USB or
Firewire port or even your SATA-based hard disks
are. This is the crux of the problem—the band-
width requirement of a device is not satisfied by
the PCI bus; the bus itself becomes the bottle-
neck that needs to be rectified for the solution.

For the second problem, consider a hard disk.
Under the aegis of PCI, if this disk needs to
communicate with the CPU, it will have to go via
the Southbridge, stop at the Northbridge for
refreshments and finally arrive at its destina-
tion, fighting latencies all along the way. “Laten-
cies”, you ask? Well, yes, notice how the USB, the
FireWire and the Gigabit LAN ports are all shar-
ing the same 133 MBps bus. Fighting for
resources means system slowdown. This is prob-
lem number two in PCI-land.  

The third problem with the PCI architecture
is that it is a one-way lane. That is, when the CPU
is talking to the Northbridge, no other device
can access the CPU. This leads to a scramble for
bandwidth and adds to system slowdown.

A slow bus fighting with fellow devices for
resources, and clogging at the Northbridge, are

The Magic Bus
Is PCI express
the bus you have
been waiting 
for? Time to get
on it…

The Magic Bus
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a few of the problems your system faces every
day. Let’s find out how PCI Express will save us.

On The PCI Expressway
The most interesting thing to note is the legacy
PCI bus hanging at the bottom right of the info-
graphic (below). PCI becomes a subset of PCIe. To
understand how PCIe betters this, let’s first
understand the basic structure of PCIe.

Unlike PCI, PCIe is a two-lane transfer system.
This lets data come and go simultaneously. In
PCIe, each of the dedicated connections/paths
between the switch and the device is called a
link. A PCIe x1 link has one lane, which can
transfer data to and fro simultaneously, provid-
ing transfer speeds of 2.5 GB/s one way, such that
an x1 link has a total transfer capacity of 5 GB/s.

Now, if we add another lane to this, we get an
x2 link, wherein each lane can transfer 5 GB/s,
making the total available bandwidth 10 GB/s.
We can theoretically have x32 PCIe connections
with transfer speeds of 20 GB/s.

To put things into perspective, if you could
manage a x32 PCIe connection between, say,
your 80 GB HDD to another 80 GB HDD, you
could transfer the entire 80 GB of data in about
four seconds! But how does all this bandwidth
help us?

Remember how in PCI, if the processor was
talking to the Northbridge, it was inaccessible to
other elements of a system due to the single-
channel nature of PCI? The dual-channel feature
of PCIe overcomes this and allows multiple
devices to communicate with each other. 

PCIe will replace the entire bus architecture
on a motherboard and would be the interconnect
between various devices and bridges as well as
the interconnect between the bridges.

PCIe is incredibly scalable and allows addi-
tional links to be provided as and when band-
width requirements increase. For example, for a
Gigabit LAN card, an x1 lane is sufficient, but for
replacing your 8X AGP card, a motherboard
burning an x16 link is necessary and possible.

Another aspect that has changed in PCIe is
the legacy concept of PCI bus mastering. PCIe
features a switch system that sits in the centre,
and all the system devices connect to it via a
dedicated link similar to the bus connecting the
CPU to the Northbridge. This is called a ‘Point-to-
Point Interconnect System’.

What this switch does is route all the
PCI/PCIe data through itself, allowing two
devices to talk to each other—if the communica-
tion does not involve any cache-specific data or
instructions, this switch will simply offer the two
devices a dedicated and direct link to share with
each other. This obviously makes information
exchange between devices extremely fast.

What Does This Mean? 
The question now is, how well does all this trans-
late to real-world usage. Will your games finally
run enormously faster and better?

Well, not really. The performance difference
between AGP 4x (1 GB/s) and AGP 8x (2 GB/s) is
negligible. So, PCIe x16 cards will not make
Doom 3 run any faster because there simply isn’t
that much data to transfer.

Immediate beneficiaries would be people
into video-editing; the performance of their
machines would see a huge boost due to the
dual-channel capability. This is because periph-
eral devices such as hard disks or external
FireWire devices will be able to reap the bene-
fits that additional bandwidth and reduced
latencies offer.

Our recommendation is that you should 
not upgrade to PCIe unless you work heavily 
on video editing. If, however, you are about 
to upgrade anyway, go ahead and get a PCIe-
based motherboard—PCIe as a standard is 
an inevitability.

A word of caution, though: a motherboard
can only support either AGP or PCIe. So if you buy
a PCIe motherboard, you will have to buy a PCIe
graphics card as well. On the upside, PCIe is back-
ward-compatible with older PCI components.

PCIe would be
the interconnect
between various
devices and
bridges as 
well as the
interconnect
between the
bridges 
themselves 
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The numbers in red express the transfer speeds supported by the devices. Those in black are the transfer speeds allowed by the bus they are
connected to, in this case, PCI.

Infographic Sivalal. S

The PCI Versus PCIe Architecture
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What’s On Offer?
Along with the obvious advantage of the PCIe
bus, these boards offer a gamut of features previ-
ously unheard of: if you go out to buy a PCIe
motherboard, expect to be bombarded with
feature-rich boards. We take you through the
best of what you can expect from these boards.

Video
The latest PCIe chipsets from Intel, the 915, 925
and their variants, come with an on-board Intel
Graphics Media Accelerator, which has Direct-X 9
support, and is stipulated to match the perform-
ance of the GeForce FX5200. The 915G and 915GV
chipsets also have native support for HDTV and
widescreen LCDs, with support for multiple
monitors. The AMD solutions from nVidia do lit-
tle to better this, what with the nForce4 chipset
shipping without any onboard video at all!

ATi Radeon Xpress200/200P chipsets do
much better, with their on-board video solution
having 128 MB of memory, matching the
performance of a Radeon X300. It also has built-
in dual-display support (Analogue and DVI) along
with SURROUNDVIEW, which is essentially
support for three or more monitors. 

Both Via K8T890 and K8T890PRO as well as SiS
756 and 965 chipsets do not feature any onboard
video. So on this front, ATi leads the pack.

Audio
This is where the Intel chipsets emerge as clear
winners. With on-board support for eight-chan-
nel Hi-Definition audio with a 192 kHz sampling
rate, which can play everything from High Defi-
nition Dolby DTS to vanilla CDs without prob-
lems. It even supports up to 15 simultaneous
audio streams.

The various AMD-based PCIe chipsets support
eight-channel audio, but this is not High Defin-
ition. In fact, the Via K8T890 only has integrated
AC-97 six-channel audio, though it does come
with an eight-channel audio PCI controller.

The much-touted Soundstorm integration into
nForce4 did not materialise, and we get the simple
eight-channel integrated audio, which again, is
not high-definition. Likewise with ATi and SiS. The
Gigabyte K8NXP-9, though, improves on the
nForce4 chipset and provides six programmable
audio jacks. No High-Definition audio, though. 

Storage And Memory
Every PCIe chipset comes with at least four SATA
connections, with the Gigabyte K8NXP-9 offering
eight. All offer ATA connections and most of
them also have the capability to be configured in
various RAID flavours: nForce4, suppors0, 1, 0+1

Digital Passion l In Sight

RAID, and they also allow you to change the
RAID configuration on the fly.

Another cool piece of technology that has
made its way to today’s motherboards is CQ, or
Native Command Queuing. This technology
enables a hard disk to decide the order of read-
ing data to minimise data throughput time—so
you can watch a movie even when some encod-
ing is going on in the background, without
stressing out your hard disk.

The nForce4 and Intel chipsets support this
technology; however, neither the ATi Xpress200
nor the VIA or SiS chipsets support this feature.

It should be noted here that not all these
boards support DDR2. For example, the VIA
K8T890 series supports only DDR memory. The
Intel 915GV and 915G support both DDR and
DDR2. Note that the 915GV Express chipsets
support only the latest LGA775 socket Pentium 4s.

Network Support And Other
Connections 
All these chipsets provide a variety of connectiv-
ity options. Each of these PCIe chipsets provides at
least eight USB ports and one FireWire, with the
nForce4 providing 10 USB and two FireWire ports.
Apart from this, it also supports Gigabit LAN.

Interestingly, the Gigabyte K8NXP-9 offers
two on-board GigabitLAN ports. One is an nForce
4, and the other, added by Gigabyte, utilises a
PCIe x1 link. This apart, the motherboard ships
with an additional PCI Wireless LAN card as well!
The card is a Gigabyte addition and is not on-
board. The ASUS A8V-E Deluxe does feature an
on-board wireless LAN conforming to the 
802.11g standard. 

For gamers who will be upgrading anyway,
ATi and nVidia have released their versions of
the PCIe x16 graphics cards, which are available
without having to pay a premium! 

Unlike ATi, though, which launched native
PCIe cards, nVIDIA’s solutions use a PCIe-to-AGP
bridge and have merely offered bridged versions
of their current AGP 8X cards. However, the
performance difference due to the bridge is
negligible and you can enjoy playing your
favourite games on high-end cards such as the
6800 GT and the Radeon X850.

In The Future
The sheer convenience of the serial connections
offered by PCIe and the bandwidth available could
change the motherboard manufacturing process
entirely by giving greater flexibility in terms of
component placements. We might see modular
PCs where the I/O system is removable from the
processor and could connect to it via PCIe sockets.

This does not signal the death of USB and
FireWire, though, because by the time the above
scenario is realised, they would be so integrated
with our lives that even the modular PCs would
need to provide legacy support for them; just as
PCIe boards provide support for the older gener-
ation PCI cards.

Despite some glitches like non-compatibility
with AGP, PCIe technology is remarkable. It has
tremendous industry support, and not without
reason. The bus is well on its way. 

varun_dubey@thinkdigit.com

Intel developed the 32-bit PCI bus, which runs at 33 MHz
with a transfer speed of 133 MB/s
The 64-bit version of the PCI bus, running at 33 MHz
with a transfer speed of 133 MB/s
64-bit version running at 66MHz with speeds up to 512 MB/s
64-bit version running at 133MHz with speeds up to 1 GB/s
4.3 GB/s

PCI

PCI-X

PCI-X
PCI-X
PCI-X 2.0

TechnologyVersion

The reason PCI-X is not implemented in desktops is the extremely high cost
of manufacture of PCI-X boards

PCI: The Evolution Path

If you go out to
buy a PCIe
motherboard,
expect to be
bombarded with
feature-rich
boards
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Beyond Music

Socks
A set of knit socks to dress
up as well as protect your

iPod. Chose from six
colours.

Price: $29 (Rs. 1276) 

iSkin
Offers all-round surface
protection. Beveled top

surface enables direct plug-
in of accessories.

Available in a variety of
colors.

Price:  $25 (Rs. 1100)

Battery Pack
A reliable backup battery option, the
Battery Pack provides an alternate power
source for your iPod, when it’s internal
battery runs out of charge. The Pack uses
four standard "AA" alkaline batteries,
and  has a useful charge-level indicator.

Price: $59 (Rs. 2596)

Charger
A car power adapter,

which connects directly to
a stereo input jack, to play
the iPod while on the road.

Price: $40 (Rs. 1760)

NaviPod IR Remote 
A five-button infrared

remote and receiver, the
naviPod places the iPod's

audio controls at your
fingertips

Price: $50 (Rs. 2200)

The Apple iPod is much more than just a music player. An audio recorder, portable stereo system,
digital library, organizer, portable hard drive …the list is endless.  What's more, your favourite
‘digital companion’ has an ocean of accessories to choose from. Here are a few samples: (For a
complete list of accessories, head to: http://www.apple.com/ipod/)
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Media Reader
Use the iPod as a temporary backup
device. Transfer photographs from
digicam memory cards to your iPod (when
your card is full) while on the move or on
vacation. Supports CompactFlash (Type 1
and 2), SmartMedia, Secure Digital (SD),
Memory Stick, or MultiMediaCard (MMC) 

Price:  $100 (Rs. 4400)

Leather Organizer 
Apart from ensuring a snug fit for the
iPod, the leather case can hold your
business and credit cards, cash and the
iPod’s earphones. Offers easy access to
the display and wheel.

Price: $25 (Rs. 1100)

Car Holder
Supports your iPod in the
car. The Air-Grip suction
cup keeps the iPod secure
and stable, lets you adjust
height and reposition the
iPod easily. A cable-
management clip helps do
away with tangled cords.

Price: $30 (Rs. 1320)

iTrip FM Transmitter
Use the iTrip FM Transmitter to
play music through your car's
FM radio. Custom-made for the
iPod, the iTrip lets you select
radio stations directly from the
iPod. This plug and play device
doesn't require batteries. 

Price: $35 (Rs. 1540)

Infographic  B
inesh Sreedharan  

Text: M
eera Vankipuram
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Ram Mohan Rao

W ho are you? In the ages past, you were
what people knew you as; what your
friends knew you to be; what your

customers expected from you. In this digital age,
you are merely data.

Your e-mail ID is more relevant to this
connected world than your birth name. Today,
your Web site’s URL brings you more business
and recognition than any other avenue. How
many friends do you have online—virtual person-
alities you haven’t even met—as against those
offline? Social interactions too, are fast taking a
digital role. That we are living in a connected
world is such a truism that the statement holds
no value and will soon be as useful as stating
that the world is round.

When data thus defines your wealth, shapes
your standing in society, becomes your ego and
ID, it gains value. If you happen to have a desir-
able identity—a bank account number with a
sizeable balance, for example—that identity
invariably attracts thieves.

What if you were to wake up tomorrow and
find out that you have been leading a double
life; that someone out there has been your
virtual Mr Hyde misappropriating your money,
using your credit card number to commit
fraud, abusing your online portfolio? How
would you feel to learn that your hard-earned
cash and reputation has been virtually sold and
abused? Unlikely to happen, you say? Identity
theft is scary because it is easy. Even you can do
it... with a little patience and the right bent 
of mind. It is a low-risk, high-gain and low-
penalty crime.

The fastest-
growing crime in
the US, ID theft,
is a real threat in
India too with
the growing
reach of
technology

The Face Behind
The Mirror
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Identities are most often stolen for finan-
cial gains. There happen to be other forms of
identity theft, such as offering someone else’s
name as one’s own when arrested—this is
called criminal identity theft. But the vast
majority of ID theft involves the transfer of an
unfortunate person’s money into the hands of
a happy thief.

What, Me Worry?
It can happen to anyone. In fact, it happens to
a staggering number of people; according to an
estimate, one in twenty people in the US have
had their identity stolen. One of the reasons
for the proliferation of this crime is a large
number of electronic transactions conducted
on trust.

Say, you receive a cheque in the mail from a
friend. You note down the bank routing number
and the cheque number and make a call to your
credit card company saying you want to pay your
bill by cheque. 

You can do this over the phone. You are
simply required to state the routing number on
the cheque you received from your friend, the
next cheque number, and the amount the credit
card company requires from you and of course,
you say the chequebook is yours. Your payment
will go through. 

You have just paid for your bills using your
friend’s account, unknown to him. That’s how
simple it is! Of course, the person who sent you
the cheque can easily track down where his or
her money went, but this example just goes to
show how very trust-based most bank transac-
tions are-at least in the US.

For identity theft to occur, personal infor-
mation must be obtained. In the US, the two
prime pieces of personal information are the
social security number and the mother’s
maiden name. This information can be uncov-
ered—and usually is, when ID theft occurs—by
going through someone’s mail or trash, looking
for bank and credit card statements, pre-
approved credit offers and tax information.
Other more direct ways include stealing infor-
mation from a wallet or purse such as identifi-
cation, credit or bank cards, completing
change-of-address forms to redirect mail, and
obtaining credit reports by posing as a landlord
or someone who has a right to the information.

But it is not only data like lost Social Security
numbers and credit cards that attract ID thieves.
Sources of personal information that are
publicly available include property records,
court records and marriage and divorce certifi-
cates. ID thieves can not only rob your mailbox
and hack into your computer, but also do things
like monitoring your cordless phone and
rummaging through low-key stuff like product-
warranty cards.

The Internet opens up whole new avenues
for identity theft—phishing included. A recent
example involved the setup of a copy of part of
the PayPal Web site to acquire members’
personal details (See box: “How phishing works” on
page 41). Trojans—viruses that remain resident
on one’s computer and can submit information
to someone else—can monitor keystrokes to

access passwords and other personal informa-
tion. In fact, several virus attacks are intended
just to track personal information. 

A common phishing scheme involves e-
mails that appear to be sent by your bank,
requesting that you log in to your online
account to confirm some details. You are meant
to follow the links in the e-mail, to a fake page
that appears to be a genuine online banking
site. Some estimates say that phishers are able
to convince up to five per cent of recipients to
respond to their e-mails and take the intended
action. In fact, computer-savvy people, too, get
fooled by such e-mails.

The Internet, while providing resources for
people to avoid ID theft, has also helped in its
spread: the most frightening—and thorough—
way of stealing an identity is by purchasing it at
one of the many identity-search companies that
have come up on the Internet. For as little as Rs
2,200, these companies sell people’s Social Secu-
rity numbers, mother’s maiden names, home
and employment addresses, previous addresses,
credit history and more.

The Ways Of The World
Phishing, viruses and paid information apart,
consider some of the multifarious ways of steal-
ing identities:

In a recent case in California, a hospital
executive died. In the obituary was a lot of
personal information like the mother’s maiden
name. An identity thief got the Social Security
number of the deceased and used it to steal
thousands of dollars from his widow.

Ford Motor’s customer credit reports,
containing more than 13,000 records of
identifying information such as Social Security,
bank account and credit card numbers, had
been lodged in a supposedly secure database at
Experian, one of the three major credit bureaus
in the US. Hackers bypassed security by posing
as employees of Ford and got access to all the
personal information.

Even fingerprints can be reproduced and
used. “If I steal your password, a credit card
company can issue you a new password,” says
Chris Hoofnagle, legislative counsel for the
Electronic Privacy Information Centre in
Washington, DC. “But if people are able to lift a

Online Versus Offline ID Theft

Trevor Healy, vice-president, Payments at VeriSign, a California-based
online certification agency that secures transactions, says: “Online fraud

is very different from offline fraud. Online fraud is committed in three
categories: online theft, which is virtual shoplifting; identity theft, stealing
identities, so you can either sell those identities or actually use those
identities for shoplifting; and cash theft. 

“In the online world, what we are witnessing is that the level of scale is
drastically different. In the offline world, if you steal an identity from a
merchant’s trash can if the merchant is silly enough to put credit card slips
in there. You may get five or six cards and use those to create a fraud. 

“But in the online world, if you break into a merchant’s system, you
could steal literally hundreds of thousands of identities. So the level of
scale in the online world, if a fraud occurs, is much bigger. Everybody,
though, is focused on product theft—the virtual shoplifting—first and
forefront, and not on the other possibilities.”

For as little as 
Rs 2,200, some 
companies sell
Social Security
numbers, 
mother’s maiden
names, home
and employment
addresses, credit
history and more
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latent fingerprint of yours and reproduce it in a
mould—and this can be done—you can’t be
issued a new fingerprint. So how do you prove
you are you?”

Even children are not safe from this identity
theft. In April 2003, the story of Lisa Barraza’s
son was uncovered. Barraza’s seven-year-old son
is a typical youngster, except for the fact that
since the age of one, he has piled up over
$100,000 in credit card debt. How can a child so
apply for credit cards and spend that kind of
cash? He Obviously can’t, says his mother. 

Barraza first learned of her son’s debt
problems when she found a credit card in his
name. “My son’s social security number was
hijacked,” says Barraza. 

Bruce Schneier, founder and CTO of
Counterpane Internet Security of Cupertino,
California, and a recognised authority on
security, says, “The reason identity theft is so
powerful is that much of our security today is
based on your identity.”

New Avenues
When data becomes increasingly centralised,
things become easier for ID thieves—they can
increasingly do one-stop data shopping. The cell
phone is becoming a repository of the most
sensitive personal data, and thus finds itself a
lucrative target for attackers. Single-sign on serv-
ices, such as Microsoft’s Passport service, open
another easy avenue for ID thieves. If a thief gets
hold of one Passport ID, he or she has pretty
much everything to take on the victim’s identity. 

Similarly, if a thief gets hold of your bank
account number and online banking PIN, there’s
no limit to what havoc he can wreak with your
finances, routing money to other accounts, send-
ing out e-cheques, and the like. 

However, many people argue along the lines
that you are “more likely to be struck by light-
ning than becoming a victim of fraud or iden-
tity theft when they use electronic bill payment
and account services”. The essential thing here is
to keep your password or PIN safe.

The same goes for the online use of credit
cards. Although many people argue that using
your credit card online is safer than using it
offline because fewer people see your card
number physically, the fact is that several

unscrupulous sites will authenticate your
credit card without verifying your billing
address and the CVV number (the three-digit
authentication number on the back of your
credit card). Fortunately, such authentications
are on the decline, and more and more finan-
cial institutions now require you to provide the
CVV number and verify the billing address. If
you’re still paranoid, you can think of using
services like HDFC Bank’s NetSafe system
wherein you are assigned a credit card number
for single use, with a limit that you choose,
based on your real credit card details.

You Could Be Your Own Enemy
RFID chips are particularly interesting. These
chips are used in a variety of situations. For
example, in healthcare, they are implanted
under the skin. The intended use is to give
medical practitioners access to the medical
details of the person when he or she is unable to
communicate. But how easy would it then be to
steal such a person’s identity? 

Some argue that all one would need to do is
to purchase an RFID scanner, scan the victim as
he or she passes by, clone a new chip with the
same number and implant it under their own
skin. This issue—that of the stealing of informa-
tion via RFID tags—may become easier as RFID
readers find their way into cell phones. 

In early 2004, Nokia created a reader for RFID
tags for its 5140 phone. This is based on NFC
(Near Field Communication) technology—which
means that the phone needs to be put within an
inch of a tag to be able to read it. A recent report
from ABI Research says the first NFC smartphone
will be out this year and goes on to predict that
by 2009, more than half of all handsets will have
it inbuilt.

Wireless LANs, or WLANs, are another poten-
tial area of attack. Merwyn Andrade, a contribu-
tor to the 802.11i security specification and chief
technical officer at Aruba Wireless Networks,
warns that ID theft could become a problem for
companies using WLANs. For example, users
with 802.11i wireless phones might save their
passwords and PINs on the phone. “This would
be like keeping your keys to your house in your
wallet and then losing the wallet,” he says. “Once
802.11i is pervasive, people might miss that they
have to worry about authentication.”

Solutions
ID theft is the fastest growing crime in the US
and is rising fast in India as well. As credit cards
and online transactions, amongst other things,
become more commonplace in India—banks in
India are fast catching on to credit history report-
ing and the PAN card number may soon become
what the Social Security number is in the US—it
is only natural that identity thieves here will
take up the same techniques. 

Thinking of it as a worldwide problem, what
is the answer? It probably lies in the further
centralisation of data and the padlocking of that
data using a mix of several techniques, includ-
ing, possibly, biometrics and secure tokens.

Biometrics refers to identifying one by some-
thing one is, rather than something one has or

The Future Of Phishing

Dr Jonathan Tuliani, in an article floating on the Internet titled “The
Future of Phishing”, believes that the next few years “will see the

emergence of Internet man-in-the-middle attacks”. In such an attack, the
user is tricked as in a usual phishing scenario, except that instead of just the
user communicating with the attacker, the attacker is also communicating in
real-time with the bank. “Two (or even 10) factor authentication is of no
help, since the attacker does not interfere with the login process. Both the
user and the bank are unaware of the presence of the attacker and believe
they have a secure connection directly from one to the other. 

Once established, the man-in-the-middle has complete control. He can
modify instructions, even transfer funds to a different account or simply cut
the user off and submit whatever instructions he desires to the bank.

“To combat this threat, it is necessary to move away from session-based
security (based on a secure log-in), to message-based security (based on
explicit authentication of individual transactions).”

The reason
identity theft is so
powerful is that
much of our
security today is
based on your
identity

Bruce Schneier, 
Founder and CTO,
Counterpane Internet
Security
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knows. Examples of machine readable biometrics
are fingerprints, retinal or iris patterns, hand
geometries and facial features. A secure token is a
physical device: an example is USB secure tokens,
which are designed to store a person’s digital iden-
tity. When someone attempts to log in to applica-
tions via a PC, virtual private network, or wireless
network, he or she is prompted to enter a unique
PIN. If the number matches that on the USB token,
access is granted. The number stored on the token
is encrypted for additional security. 

The most secure method of identification is
“two-factor authentication”. This would be some-
thing like a PIN plus something you have (a key
or an access card). Biometrics adds levels of secu-
rity by combining something you know with
something you are (for example, a fingerprint).
Additional levels of security can be implemented
by added factors such as a username and pass-
word plus a biometric and a token.

Be Very Afraid...
Cases of ID theft abound; some more mentionable
than others. In one notorious case in the early ’90s
in the US, the thief was a convicted felon. He not
only incurred more than Rs 43.5 lakh in credit
card debt, he obtained a home loan, and bought
homes, motorcycles, and handguns in the victim’s
name. The icing on the cake was that he called his
victim to taunt him, saying he could continue to
pose as him for as long as he wanted. ID theft was
not a crime.

While the victim and his wife spent more than
four years and over Rs 6.5 lakh to restore their
credit and reputation, the criminal served only a
brief sentence for making false statements to
procure a firearm.

This case prompted the US Congress in 1998 to
create a new Federal offence of identity theft.
Creating an offence of it is one thing, but ID theft
is a low-risk and high-payoff crime. 

There are several pieces of information 
that make up an identity; we need to 
realise that each of these pieces is potentially
valuable information, and we need to overhaul
the way we communicate and exchange 
this information.

In the long run, technology could come to
the rescue. Before that, the problem will loom
on us until every last one of us keeps every bit of
personal information under lock and key, and
shreds it before throwing it away—physically and
virtually. Paranoia is the need of the times. You
have to pretend like someone’s looking over your
shoulder all the time. 

ram_mohan@thinkdigit.com

How Phishing Works

On November 17, 2003, many eBay customers received an e-mail notification
that their accounts had been compromised and were being restricted.

Included in the message was a link to what appeared to be an eBay Web page
for re-registration. 

The top of the page looked just like eBay’s home page and incorporated all
the internal links. To re-register, customers were asked to provide credit card
data, ATM personal identification numbers, Social Security numbers, dates of
birth and mother’s maiden names.

Fact is, eBay hadn’t sent the original e-mail and the Web page didn’t belong
to them either. Many who received the e-mail carried out the recommended
actions, in the process, giving away vital ID secrets.

1/2 P H AD
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780 gm, a pencil thin
side-profile, a 
space-age exterior, 
a 1.1 GHz heart. 
The X505 is the real
pocket monster

Sony Vaio X505/CP

Take your pick from a jet fighter, an F1 car or
a space ship. Now remove the shell

protecting any of these machines. Carbon
fibre—stronger, more rigid and able to dissipate
heat better than anything else now rests in your
hand. Mould this space-age shell and give it a
laptop shape: 256 mm x 208 mm, 9.7 mm thick
at its front and 21.9 mm thick at the back. Next,
create a motherboard about the size of a
minidisk (2.5-inch diameter) and place an Intel
Pentium M 1.1 GHz processor with 1 MB of L2
cache on it. Place a 20 GB hard disk to the left of
the motherboard, a PCMCIA slot to its right.
Add two integrated USB 2.0 ports and a Firewire
port. Don’t forget the 512 MB of RAM, shared by
the onboard video card. Adorn the creation
with a bright, 10.4-inch LCD display with a
native resolution of 1024 x 768.

Now step back and lift it, with a finger. At
780 gm, the Sony Vaio X505/CP is an incredibly
small, light, and sexy laptop. With an external

wireless card (802.11b/g), an 87 key QWERTY
keyboard along with a pointing stick; and a
battery life of up to four hours, the X505 is any
geek’s dream come true!

Watch the video review of this Notebook on the
digit DVD! 
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Without The Internet

Graphic Atul Deshmukh 

Day 0
It’s been a while since I took a vacation and I’m really
looking forward to my upcoming month-long break. I must
admit, though, that I have this uncanny habit of getting
myself into strange situations. My last day before I took off,
saw me get into one such ‘situation’! Deepak, our Test Centre
head asked me if I was really going to be away from work for
a whole month. I replied with an emphatic “Yes!” Little did I
know that this would also keep me away from the Internet
and not just work for a month. In true military style
volunteering, I had volunteered to spend a month without the
Internet. God save me!

Day 1
The start of a long lazy month… I am really looking forward
to a hot cup of coffee and my morning dose at
www.extremetech.com. With a steaming cup of coffee, I head
for the computer and am aghast to discover that the Internet
is down. How could this be? Without further a do, I call up
the ISP and let the operator have it! After checking up on
some details, I am reminded that I had asked for the
connection to be discontinued for a month. Me? And then,
realisation sets in that I am working on an article and have
to spend a month without the Internet. A bit like being in the
wilderness without any means of communication, if you ask
me… I mutter some apologies and wonder what one can do
to spend time without the Internet. I can already feel the
withdrawal symptoms setting in.

Day 3
To make my month in the wilderness easier, I had a week-
long trip planned with a friend, but that has been postponed
by a few days. 

Day 5
A panicked friend calls up to find out if I’m okay… of course I
am, I tell him. “You haven’t been online for the last five days,”
he reminds me. This actually made me wonder how little we
speak to our friends… it’s almost taken for granted that your
‘friends’ will be online and a smiley can replace the laughter
and smiles you used to share. 

Day 7
I am still at my computer but it just doesn’t feel this same.
No e-mails, no forums… can’t read up on anything or can’t
even download stuff… I could go to a net café, but that would
defeat the purpose of the exercise. Hmmm. It’s 11 pm and I
have nothing better to do than sleep. Well, good night!

Day 10
I can’t take this anymore… so I draw up a list of things I can
do on the computer without having to use the Internet. Games
in single-player mode, e-books from Digit CDs, clean up the
hard drive, listen to music, watch DVDs… not bad, huh?

Day 12
Finally… I leave town today hoping I won’t miss the Internet.  

Day 20
I’m back from the trip and I am a bit tired. My younger broth-
er has a go at me for disconnecting the Internet, but I stick to
my guns… well, almost. I give him some money to go to a net
café and save myself from being talked into reinstating the
severed connection.

Day 22
I’ve caught up a fair bit on what’s been happening on TV.
And I agree ‘Jassi Jaisi Koi Nahin’. Who else
can run Windows on an
iMac? But newspapers
suck as far as TV sched-
ules are concerned. My
trusty Internet lets me go
to website, download the
months schedule, export it
to Excel and mark my
favourite programmes.
Eight long days to go.

Day 25
I met an old friend today
and he asked me to go with
him. Where? For an encounter
with the other kind! He was
just going to a library! It was
nice to experience the unmis-
takeable scent of books once
again. I picked up a couple of
books myself… Believe it! 

Day 30
It’s over… I shall be free of
my misery! World Wide
Web… here I come! But
was the experience any
good? In a way, yes.
The Internet is a tool
and is only good as
long as you keep in
control. Too much of
any good thing can 
be bad!

Bhaskar Banik

The Internet has become an integral part of our lives so
much so that we cannot even stay without it when we

are away from work.
bhaskar_banik@thinkdigit.com
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Wide The New Year started with a whimper. For
me, twice over. My Christmas bonus at
office was a new PC, with a brisk new

processor, plenty of RAM and a shiny new hard
disk. A couple of days spent migrating my data
safely over to the PC was a small price to pay for
the snappy responsiveness of Firefox. Yes, it is
quite a CPU hungry beast, and if you don’t plan
to upgrade your computer you might want to
look at the Moox optimised builds (c6iv*) for the
best you can get on your current hardware.

Anyway, come New Year and the hard disk
went all whiny. No boot screen, no detection by
BIOS, and of course no way to access my data. A
call to tech support and a stand-by hard disk
installation later, I found myself looking at
Windows XP re-installing the second time in a
week. The plan was to get back up to speed on
this HDD, and when the original was replaced,
the partition would be copied over with a disk
image tool like Norton Ghost so I get back to
work in no time. Good thing I hadn’t turned in
my old hard disk yet, so I had all the data back
minus the days I spent un-backed up on the
new PC that I hadn’t expected to fail. 

Lesson One: You
should always back up
your important data.
Disk failure is always a
surprise. The best free
tool for backup is
SyncBack (c6ix). Set up
multiple jobs for your

important data and rest easy.
To cut a short story shorter, a few days after

I was all settled in nicely with patches up to
date and all my programs and UI tweaks just
the way I like them, Windows stopped booting.
The replacement hard disk too was making that
ominous clicking noise. I should have paid
attention to the Icon of Trust numbers. My
Whimper Two was because I had failed to learn
Lesson One. Yet another data loss later, I was
ready to try some data recovery software. R-
Studio didn’t quite manage to read complete
files, but Easy Recovery Pro did the job with
some careful guidance. It helps to remember
your partition sizes as accurately as possible.

I tided over the next week on a lovely wide-
screen Compaq laptop that evoked the right
kind of responses everywhere it went. But not
from me, though. I was in mourning for my
two lost weeks, and didn’t appreciate it as
much as I should have.

When my “new” hard disk arrived a week
later, I was twice burnt, third time shy. It was
time for some serious agni-pariksha, and
PassMark BurnInTest (c6jr) was my flame throw-
er. The free version of this burn-in software
runs for only 15 minutes at a time, but it puts
all the sub-systems—hard disk included—
through the wringer whenever you install a
new component, or buy a new PC. 

If you already have a working old hard disk
you installed into your new and upgraded
CPU/Motherboard, you may want to spare your
hard disk the additional strain that might push
it into never-never land. To burn-in just the CPU
and cooling, you should either eliminate the
other modules from your test configuration in
PassMark BurnInTest or use a dedicated CPU
testing program such as Hot CPU Tester Pro
(c6iy). Do it in the summer with the case closed
to stress your system to the max, but don’t
flame me if the PC suffers a meltdown. 

Once your computer is working fine, go and
download a S.M.A.R.T. monitoring tool such as
ActiveSMART (c6j0) to keep an eye on your
HDD’s reliability. While S.M.A.R.T. monitoring
might give you some warning about impending
failure, nothing substitutes for a good backup
plan. Lesson One is you should always backup.

All power-users have their computer envi-
ronment set-up just-so, with all the myriad util-
ities and shortcuts correctly configured and the
UI tweaked. But going through three installs of
the OS amidst work deadlines does an amazing
job of distilling what you do with a new PC to
just the absolute essentials. Here is briefly what
I ended up with on my “new” PC version 3.0. 

First things first, put up the Windows
Firewall and block all network services before
plugging in the network cable. Yes, sad to
admit, but even our local network is infested
with malware and an unprotected PC (like the
temporary laptop for example) is certain to
catch nasty stuff like Sasser or Nimda. If you are
going on the Internet unprotected, this
research report (c6j2) should set you straight. 

Next come the hours of Windows Update
patches—painful but necessary. I use the free
Avast! Antivirus and keep Spybot and AdAware
handy just in case my Internet Explorer picks
up something nasty. If you don’t install Service
Pack 2, BHODemon (c6j5) will help keep your IE
cruft-free. Of course, I mostly use Firefox with a
dozen extensions, so IE is not much trouble. 

You could choose to install a free third-party
firewall like ZoneAlarm or Kerio Personal
Firewall for complete protection, but since I am
behind a corporate firewall run by an admin
who knows what he is doing, I don’t. You
should also try to not run as an Administrator-
level user and RunAsAdmin (c6j6) helps there.

Customising the Windows UI is managed
with a combination of MS TweakUI and Kelly’s
awesome registry tweaks (c6j8). SlickRun (c6jd)
handles my command-line needs perfectly, and
Folder Pilot (c6jc) turns Explorer into a useful
tool. PopFile (c6jf) keeps my mail spam free and
well categorised, but you could also try
SpamBayes (c6jj). 

NewsPipe (c6jk) gets me my RSS feeds right
in my Outlook and is quite the run-and-forget
program. If you aren’t comfortable running a
command-line Python script, you could give the
free SharpReader (c6jl) a shot.

But if there was only one thing I could talk
about this month, it would be Lesson One:
backup regularly!

Angle  

Sumod Hajela

Sumod Hajela, Associate
Editor (Technology) is Digit’s
Alpha Geek. His pastimes
include creating new software
during lunch hours, and
mastering just about every
computer-related technology
that there is. Write to him at
sumod_hajela@thinkdigit.com

Crash & Learn
One needs to fall over and over
before he can learn to walk—a 
lesson is perhaps never learned
the first time around

The text in brackets should be used like so:
http://snipurl.com/text to get the website
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Hindi hain Hu   !nn
has to be localised. For Linux to be accepted
among the masses, it is necessary that we
localise the common applications and inter-
faces. Translations are key foundations of the
localisation effort, and so we decided to trans-
late common applications such as KDE, GAIM
and GNOME,” says Advani.

How It All Started
IndLinux started working primarily on Hindi
and helped set up localisation teams for other
regional languages. The main goal of IndLinux
is to create a fully Indian language-enabled
distribution system.

The project started around the year 2000
with Advani and Hariharan joining forces. In
the first two years of operations, the main
bottleneck was fonts.

Says Guntapalli Karunakar, coordinator at
IndLinux, “Our major problem was that we did
not have good quality fonts, so the display
wasn’t very good. We have developed our own
fonts—our design team and other artists helped
design fonts, while the technical aspect was
handled by myself and a few others.” When the

Thanks to the
efforts of a
dedicated few,
and the rise of
open source
software,
applications
such as KDE,
GAIM and
GNOME are now
available in
Hindi

Preethi Chamikutty

or long, computers in India have been
restricted to those who understand
English, cutting off a large potential

user base. A movement has been taking shape
since 1997 that could finally brought the power
of computing to the masses.

The Bharatbhasha initiative was launched
with the aim of providing free software to the
masses. With the advent and growth of open
source programs, this has become reality. 

A volunteer project, IndLinux, focusing on
widening the reach of computing to an esti-
mated 1.3 billion people who understand Hindi,
the fourth largest language group in the world,
has been at the forefront of this movement.
Founded by Prakash Advani and Venkatesh
“Venky” Hariharan, IndLinux initially received
support from FreeOS.com and is currently
aided by Netcore Solutions. 

Prakash Advani, who is also the Linux
Practice Head, Onward Novell Software (I) Pvt
Ltd, says, “For any technology to be adopted, it

F
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When I heard about this initiative of translat-
ing software into Hindi, I wanted to contribute
whole-heartedly. Around the same time, the
Voluntary Retirement Scheme (VRS) was
offered at work and I immediately opted for it.
Initially, I could put in only one or two hours of
work daily, but now, I am able to dedicate eight
to nine hours.” 

Shrivastava has been involved with this
project for four years and finds it more satisfy-
ing that his Rs 25,000 per month job. 

Setting Standards
Although translation may sound like an easy
job, there are a set of rules the volunteers have
to follow. For instance, after someone sends in
his part of the translation, it is reviewed and
checked to see if the necessary standards have
been met. 

As a matter of fact, the team has developed
a glossary of words that have already been
translated into Hindi, and volunteers need to
ensure that they do not use a new term for a
word already in the glossary.

Hariharan says, “Hindi is spoken in so many
dialects that we had to check if the translation
was Sanskrit or Urdu-based. For instance, we
argued over which word should replace ‘image’
or ‘photo’. Some had used ‘Chitr’ (of Sanskrit
origin) in their translations, others had  used
‘Tasvir’ (of Urdu origin). We eventually accepted
‘Chitr’, as everyone would understand it.” 

Mozilla Bhi Hindi Mein!
Apart from Linux, Mozilla, too, is being trans-
lated into Hindi. The Mozilla team is not as
large as the Linux team. It has five members—
Pankaj Tamrakar, the team leader, along with
Yash Tamrakar, Namita Chandrakar, Asif Iqbal
and Anthony Sebastian make up the team. 

The team is currently working on Hindi
alone, and the translation is almost done
except for error messages and working on
translating all Unicode-based software such as
Skype and Phpbb.

What was the reason for translating
Mozilla into Hindi? Pankaj says, “In order to
increase the utility of the Internet it is impor-
tant to make it easy. We wanted a safe and
standard Web browser. We had used Mozilla
earlier; our search for the ultimate Web
browser ended with it. Today, some cybercafés
are successfully using the Hindi version 
of Mozilla.” 

The Market 
Indians normally converse with each other in
their local languages. A reduction in the prices
of computers has made them more accessible
to the masses. Hariharan concurs, “One-tenth
of the world’s technological development
occurs in India and yet most Indians do not
take advantage of that. It is ironical that we
develop a lot of software for export purposes
and our own people are left with nothing.”

True as this is, the exercise is far from over. As
Robert Frost would say, “…and miles to go before
I sleep…” is the status of this endeavour. 

preethi_ chamikutty@jasubhai.com

Bharatbasha initiative was launched, ‘Susha’
was the only free Devnagri available. 

Venky, co-founder, IndLinux, explains,
“Back then, software vendors were selling fonts
for nearly Rs 10,000—exorbitant by Indian stan-
dards. It was essential to make things afford-
able. Even if half of of India’s Hindi-speaking
population is illiterate, it still leaves us with
200 million who speak, read and write Hindi.
We wanted to create a platform where anybody
could use applications and software was not
restricted to a chosen few.”

With this aim in mind, IndLinux sta rted
looking for volunteers who would translate for
free. Posting messages on forums, word-of-
mouth, mailing lists and other such initiatives
helped bring in the volunteers. The main appli-
cations that the team started working on were
KDE 3.2, GNOME 2.8 and GAIM. Today, KDE and
GAIM have been completely translated into
Hindi, and GNOME is nearing completion.

Gaining Momentum
When the IndLinux team decided to widen
their scope of work, they held a workshop at
the Homi Bhabha centre in Bangalore. In fact,
invites were sent to only 17 people, but more
than 40 turned up for the workshop, including
a Myanmar national. What started as a small
group is now a full-fledged movement. 

Besides Hindi, the free software is being
translated into other regional Indian
languages including Bengali, Gujarati,
Kannada, Marathi, Oriya, Punjabi and Telugu.
Says Karunakar: “Just like our group works on
Hindi, there are other groups for different
languages. Translations in Hindi, Bengali,
Punjabi, Gujarati and Tamil are at a usable
stage while Malayalam, Kannada, Marathi,
Telugu and Oriya are progressing steadily. We
now have Linux bootable CDs that boot into the
language chosen.” 

Volunteers sign up for translation in their
spare time. Hariharan says, “For open source, it
is very critical to have volunteers. But, before
allocating them any work, we look at their
enthusiasm, commitment and available spare
time. We also have collegians volunteering
with us.” Localisation is a global movement
and Indians are getting involved in translating
software into regional languages. 

The Main Man 
A team spread across the country is difficult to
manage. Nevertheless, the work on the Linux
front has been well coordinated and is nearing
completion. Ravishankar Shrivastava, one of
the main volunteers, has been instrumental in
the Hindi translation of KDE 3.2, GNOME 2.8
and GAIM. 

Shrivastava was technocrat with the
Madhya Pradesh State Electricity Board (MPSEB)
who voluntarily retired in order to dedicate
more time to the translation effort, Shrivastav
has translated more than 80 per cent of
GNOME 2.8, 90 per cent of KDE 3.2 and all of
GAIM—by himself! 

“I was very fascinated by computers and
have also been writing for the past ten years.

Write In

Done something just
as geeky? 
Tell us about it. 
Write to editor@

thinkdigit.com

Even if half of of
India’s Hindi-
speaking
population is
illiterate, it still
leaves us with 200
million who
speak, read and
write Hindi
Venkatesh Hariharan

Co-founder IndLinux
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Team Digit

T
here is this real-life story about customer care in Rhonda
Abrams’ groundbreaking management case study book
Wear Clean Underwear: Business Wisdom From Mom. The story
is about a woman who was using a set of car tyres, and
later found them to be faulty. She took the set of tyres,

and stormed into Nordstrom, a fashion retail chain in the US,
demanding a refund. The clerk at Nordstrom could have refused her
the refund, saying she never bought the tyres there. Instead, he
spoke to the higher-ups, got an approval, and refunded the customer
the entire money spent on the tyres. 

This may be a small event in the history of a multi-billion dollar
company that has over 400 stores. But, it is not about the money
they lost that day. It is about a lifelong customer they acquired
thanks to their customer-friendly outlook.

Not surprisingly, Nordstrom has been consistently rated as a
world leader in customer satisfaction, an aspect of business most
often ignored in companies in India and across the world.

Customer satisfaction is a feeling tough to judge. How do you put
a figure to a smile on your face? How do you rate an emotion that
makes you share your acquisition with others? How do you retain a
customer for life, and if he does come back to you again and again,
what makes him do so? 

With its groundbreaking survey ‘Icons of Trust’, which it insti-
tuted last year, Digit has been trying to understand just that. It is a
survey of perceptions; perceptions that are based upon experience
once the product is bought.

This year, Digit polled more than 3,000 users of technology across
the country in 14 product categories. In an exercise that went on for
more than 45 days, rigorous online as well as telephone polling by
Team Digit gathered more than 11,000 records.

While some of the results were expected, there were some
surprises in store.

The multimedia team managed the online data and Digit’s call
centre undertook the task of calling up hundreds of readers from
its database. What followed was nothing short of a revelation.

Digit’s brand head Prashant Narekuli then crunched the data
into understandable formulas, and then easy-to-refer-to results. As
the complete picture began to emerge, there was an understanding
nod whenever an expected company won. And when a dark horse
breasted the tape first though there was anothers reaction. This
time it was: “Wow, but I never imagined buyers trusted this
company.” Guess what—we had to humbly bow to the reality of the
market. It is only real experience that defines perception.

More than anything else, the Digit ‘Icons of Trust’ results have
been enlightening. From the survey, IT product organisations in
India will figure what makes them good and what makes them
mediocre in the customer’s mind. And buyers will know what prod-
ucts they can bet their money on.

In its second year, the Digit ‘Icons of Trust’
attempts to quantify and rate customer service in
India from IT product companies and the results are
a revelation, to say the least 
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Service staffs are rated as
being decent, and unresolved
problems are a low fraction of the
complaints. However, in line with
most other categories, the aver-
age repair turnaround time
remains at a high two weeks. 

Samsung does very well on
reliability perception, but fails to
match that with service, where
HP walks away with top honours.

Warding off the threat posed
by LCD monitors, CRT moni-

tors scored the second-best in
terms of reliability and service
among all desktop PC compo-
nents. Owned for an average of
about 2.7 years, these workhorses
are the least likely to spring
unpleasant surprises out of the
box; are the least likely to require
major servicing or repair, and in
general, are hardly any trouble to
their owners.

Tushar Dhruv from Kolkata is
a typical happy owner. He says, “I
have been using a Samsung CRT
monitor for the last four years. It
offers good clarity as well as
stability. I will buy from Samsung
again depending on price and
whether I can get a better deal
elsewhere.”

That only five per cent owners
need the services of repairmen in
two years reflects the technologi-
cal maturity of CRT Monitors. 

CRT Monitors
Samsung
does very
well on 
reliability
perception
but fails to
match that
with service

Every tenth
PC owner
had 
unresolved
problems
while under
warranty

in our survey also scores the
lowest on perceived reliability.  

Of course, there are exceptions:
Ashish Choksi says, “My HP desktop
PC is still with me after seven years.
I have not faced any problems as
yet. I am totally satisfied.”

Even more amazing are testa-
ments from assembled PC owners
like Rajendra Prasad, whose five-
year-old PC has served him well:
“The performance is pretty good
except that it hangs occasionally.”

It is unfortunate that for this
critical and complex device, the
service levels are the poorest in the
survey. Every tenth PC owner had
unresolved problems while under
warranty, and HCL owners seem to
be the unluckiest with as many as
one in five not being fixed.

PC assemblers do a little better
on this than the industry average,
but not by much. Combine this
with unhelpful support staff and
you have all the reasons why
desktop PCs tie for the bottom
place in service satisfaction too.

One in 20 new PCs developed
problems within the first

week of purchase, and if you have
owned a computer for two or
more years, you are almost
certain to have had it repaired at
least once. With survey-leading
average ownership duration of
2.75 years, it means a lot of people
fall in this unfortunate bracket.  

Unfortunately, Indian brands
lead on the unpleasant first-week
experience with one in six HCL PCs
and one in 10 Zenith PCs failing
within the first week. No surprise
then that the most complex device

Desktop PCs

The Top Three

Satisfaction Index Reliability Index Overall

Samsung 8.18
HP 8.12
LG 8.11

Repurchase Index (%)
LG 76
Samsung 75
Philips 72

Satisfaction Index Reliability Index Overall

The Top Three
Assembled 7.72
Others 7.44
HP 7.34

Repurchase Index (%) 
Assembled 70
Others 70
HP 70

Samsung

Assembled & HP
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means: by replying to an insert in
Digit magazine, or by responding
to an e-mail request to take the
survey. Both methods were
tagged with a unique numerical
identifier. A respondent would
log on to the survey page using
this number, and once logged off,
the identifier would expire. This
ensured that there was no dupli-
cation in responses.

All respondents were asked
specific questions to gauge their
experiences on Reliability and
Service satisfaction with a
specific product. 

How Was Service 
Satisfaction Measured?
The total response sample was
2,123, based on which a statisti-
cal analysis was conducted to
determine, amongst other
things, the Reliability and
Service indices. To understand
the importance given to each
question, refer the accompany-
ing pie-charts.

From the Reliability Index
and Service Index, an Overall
Satisfaction Grade (OSG) was
generated for the categories. The
grade was meant to indicate 
how a particular company fared
overall, taking reliability and
service into consideration,
within a sub-category.

To do so, the indices in ques-
tion were averaged with a weigh-
tage in mind: both the Reliability

The ‘Icons of Trust’ survey inter-
views were conducted online

(through thinkdigit.com) and tele-
phonically. The research sample
was taken from the existing reader
base of Digit, where 2,123 respon-
dents were interviewed. Respon-
dents shared gave their
experiences with about 5.4 prod-
ucts on an average. To maintain a
homogenous mix of respondents,
people from over 100 cities were
chosen to get experiences over the
entire geography of India.

Readers were invited to offer
their feedback through two

Our Methodology

The minimum average time to fix a problem is 6.5 days!
Most companies we spoke to claimed service turnaround

times of 48 to 72 hours, even in cases where our readers
reported an average of three weeks for the same. The
common story we heard across companies with good service
or bad, is that while they have complete control over the
turnaround time within their service network, it’s the transit
time that turns their speedy service to the time consuming
affair it seems to be. 

Liteon (average turnaround time: 17 days), for example,
claim to offer replacement of their drives for any genuine
problem, within two hours. The catch is that you must take
the damaged drive to one of their 23 volume partners across
India. If you take it to your local retailer, it must be passed
up the chain to the distributor who then forwards it to the

regional volume partner, who will then send the
replacement back down the same route. 

Zenith’s (average turnaround time: 22 days) Devita Saraf
says that customers across the country send in computers to
the retailer for servicing, who must then ship it to the
central service station in Navi Mumbai. While the actual
servicing takes 48 hours, depending on the choice of
delivery method, the transit time could be anything from 48
hours to a week. They claim to do much better on Enterprise
services, though, where they handle the service directly
rather than through retailers. 

The lesson is simple. If you could take a manufacturer’s
word, you should forget your assembler/retailer and go
direct. Call them on their customer support or sales
numbers and learn about your service options. Do let us
know next year whether that works.

Cut Out The Middleman

Category-wise Weightages

Desktop PC
Laptop
Inkjet Printer
Laser Printer
Scanner
CRT Monitor
HDD
Optical Disk Drives
Cell Phone
Home theatre
PC Speakers
UPS
Digicam
Portable MP3 Player

Reliability Index

50
60
50
50
50
55
70
50
60
50
50
60
50
50

Satisfaction Index

50
40
50
50
50
45
30
50
40
50
50
40
50
50

Reliability Satisfaction

30%

13%

18%
23%

Unit developed problems within a 
week of  purchase

Satisfaction with the unit's reliability

Unit needed major repairs/ 
replacement from the time it was
purchased

Product needed to be repaired or
replaced in  the last two years

Unresolved problems during warranty

Satisfied with the service

Average time taken to solve the
problem quickly

Knowledge of tech support provider

Assistance provided by tech support

Assistance provided by non-tech
support

35%
30%

20%
15%

8%

8%
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The ‘Icons of Trust’ survey
interviews were conducted

online (through thinkdigit.com)
and telephonically. The research
sample was taken from the exist-
ing reader base of Digit, where

2,123 respondents were inter-
viewed. Respondents shared gave
their experiences with about 5.4
products on an average. To main-
tain a homogenous mix of
respondents, people from over

100 cities were chosen to get
experiences over the entire geog-
raphy of India.

Readers were invited to offer
their feedback through two
means: by replying to an insert
in Digit magazine, or by
responding to an e-mail request
to take the survey. Both meth-
ods were tagged with a unique
numerical identifier. A respon-
dent would log on to the survey
page using this number, and
once logged off, the identifier
would expire. This ensured that

We spoke with manufacturers about their service networks in an
attempt to correlate their service scores with what they do on

the ground. Companies with well-trained call centre personnel were
appreciated by consumers, and Samsung even managed an upset in
the service score for hard disk drives solely on the basis of their
customer support staff being liked better.

Common sense would say that the closer the service centre is to
the customer, the better the service would be. That is generally true.

All vendors have a central clearing house for service that, at the
minimum, handles the database and has a major repair centre. For
companies such as Zenith, no hardware repair is done anywhere
else. Retailers may only attempt to fix software issues. So whether
the problem has a 15-minute resolution time or requires chip-level
repair, it must be shipped to Navi Mumbai. Most retailers choose to
use cheaper, slower methods resulting in long wait times for the
owner—on an average, 22 days. 

Rashi Peripherals, on the other hand, leverages their 28 service
centres in India to better effect, resolving simpler problems in their
regional centres closest to the customer. This results in Sony optical
disk drives being serviced in 11 days on the average. 

Service That Works

The Repurchase Index

Throughout this survey,
an important factor, the
Repurchase Index, has

been put forth for all manu-
facturers in all categories. 

This Index tells us how
many existing users of a
particular brand would buy
from the vendor again. This
is a percentage of the users
we polled for the survey.
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Such minor niggles, though,
can put off users for good…The
traditionally strong Nikon,
though, still has its loyalists and
these guys wouldn’t give up their
Nikon for anything else. Nikon
rated the highest on the Repur-
chase Index with almost 88 per
cent of its polled users wishing to
buy another Nikon camera. If
only Nikon could spruce up their
service network now.

Photography on the whole is a
small industry in India, and

digital photography is an even
smaller one. While most manu-
facturers never had extensive
service networks in the conven-
tional photography era (yes, it’s in
the past), the need for such a
network is a must today.

Kodak, Nikon, Olympus and
Canon have been the traditional
favourites as far as cameras go.
When it came to satisfaction,
Canon was way ahead of the
competition. Canon has made big
efforts in setting up a service
network and is also churning out
cameras ‘Made for India’. No
wonder then, with all its efforts,
that Canon wins in the category. 

Canon user Dr Tejinder Singh,
Ludhiana, says, “I have been using
it for a year-and-a-half and find it
pretty good. The only hitch is that
the battery drains fast. I would
buy from Canon again only if they
rectify the battery problem.” 

Digital Cameras
Kodak,
Nikon, 
Olympus and
Canon are
found to be 
traditional
favourites  

The Hard
Disk Drive is
the most
critical and
irreplaceable
component
of your
computer

replacement over a two-year
period. This is the highest failure
rate of any single component
category in the survey, matching
that of the much more complex
desktop PC. Please back up your
data right away!

Seagate and Samsung are by
far the dominant manufacturers
in this segment, sewing up 90 per
cent of the responses between
them. Both of them also have
higher rates of failure than the
average of the other brands,
making them both a riskier
choice than most other brands. 

Samsung drives have a
slightly higher chance of crash-
ing, but have fewer repeat prob-
lems than Seagate drives, giving
them better perceived reliability.
Seagate takes seven days to repair
your drive and Samsung takes
twice as long—but gets top
honours in service with more
helpful support personnel.

“Ibought a Maxtor HDD a
month ago as they claim

good after-sales support. But, I do
hope I am never in need of it!”
Tejas Walke puts words to the
hopes of every computer owner.

The Hard Disk Drive is the
most critical and irreplaceable
component of your computer.
Every other component can be
safely replaced, but the data lost
to a hard disk crash can be crip-
pling. This makes the high failure
rate of HDDs doubly disturbing. 

On an average, one in eight
HDDs requires major repair or

Hard Disk Drives

Satisfaction Index Reliability Index Overall

Satisfaction Index Reliability Index Overall

The Top Three
Canon 8.55
Sony 8.31
Olympus 8.22

Repurchase Index (%)
Nikon 88
Canon 80
Olympus 79

The Top Three
Samsung 8.28
Others 8.27
Seagate 8.21

Repurchase Index (%)
Samsung 77
Seagate 74
Others 57

Canon

Samsung
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resolve product reliability issues
quickly if they want to seriously
compete with Sony and Philips.
India also has a large percentage
of users who assemble their own
home theatre systems, and this
group seems fairly satisfied with
their achievements! They also
plan on staying loyal to their
unbranded or local compilations.

Sony users we polled, seemed
to have received exemplary serv-
ice; no one had any issues that
were yet to be resolved during the
warranty period.

This was perhaps never a doubt.
Sony with its Wega line has

already established a benchmark
for the industry to catch up with.
Philips is possibly the only other
real competitor thanks to the new
products that are customised for
the Indian viewer and his pocket. 

Sony, though, is in a league by
itself, with a strong after-sales
network, and way ahead of the
rest in terms of reliability and
satisfaction. In fact, a very large
number of existing users would
prefer to buy another Sony home
theatre product and not migrate.

Parimal Patel from Gujarat
has a Philips home theatre system
but is not sure if she will buy
from the company again. “I have
been using it for almost three
months. Though I am satisfied
with the product and there have
been no problems till date, I am
not sure whether I would buy
from them again.” 

Samsung and Akai need to

Home Theatres
Sony has set
a benchmark
for the
industry
with its
Wega line of
products

Canon, HP
and Epson
are the
undisputed
top three in
this segment

segment. Canon has once again
played the ‘catch up’ game to
perfection, chasing down HP and
in fact, going ahead in some cases. 

While Canon printers were
found to be more reliable, HP
users were more satisfied with
their printers. In the end, HP’s
track record and longer presence
in the Indian market was not
enough to keep them ahead. 

However, HP’s Repurchase
Index was much better than
Canon’s, despite the higher cost of
peripherals and service. 

“I have been using both HP
and Canon printers for almost a
year. Though the performance of
both is satisfactory, HP’s service is
better. I will not opt for an inkjet
printer in the future because my
work demands that I have a laser
printer, which I do not mind
buying from either company,” says
Jasrir Luthra from New Delhi,
aptly summing up the category.

Almost every home computer
today connects to an inkjet

printer. Over the last few years,
inkjet printers have been posi-
tioned (by all manufacturers) as
the solution to home printing, be
it for documents or photographs.
The result of this has been a
massive rise in sales and a subse-
quent fall in prices of inkjet print-
ers. The battle for market share
and desk space from then on was
going to be based on availability,
prices of peripherals, and quality
of service offered by the 
manufacturer.

Canon, HP and Epson are the
undisputed top three in this

Inkjet Printers

The Top Three
Sony 8.42
Philips 8.15
Others 8.13

Repurchase Index (%) 
Sony 82
Others 75
Philips 73

The Top Three
Canon 7.93
HP 7.92
Epson 7.62

Repurchase Value
HP 75
Canon 67
Epson 65

Sony

Canon

Satisfaction Index Reliability Index Overall

Satisfaction Index Reliability Index Overall
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seen favourable response from
users. Jeet Sharma, a network
administrator from New Delhi
and a Dell user, says, “I started
using the Dell laptop just six
months back and it seems reli-
able. I am satisfied with its
performance so far.”

A whopping 92 per cent of
Dell users said they would buy
another laptop from Dell,
whereas this number was 77 and
76 per cent respectively for HP
and IBM. That itself speaks
volumes about the service and
reliability of these products.

For long an aspiration product
limited to top execs, laptops

are now—rightfully, we may add—
everyone’s choice for a computer.
With prices falling steadily, it is
just a matter of time before they
cost only as much as a desktop. 

India, though, poses unique
challenges for manufacturers,
and as is the case with any other
product, a formula for success in
another country may not neces-
sarily work here.

HP builds on its reputation
earned in other segments and
emerges the clear winner.
Although more users of Dell
laptops said they would stick to
their brand, HP had no competi-
tion on the reliability and satis-
faction fronts. Emerging the
winner on almost all counts, HP
replaces Toshiba at the top. 

Toshiba, in fact, takes a major
fall this year, since users seem
displeased with the service, and
are the most dissatisfied lot
amongst laptop users.

Dell and IBM seem to have
put their act together and have

Laptops
HP builds 
on its 
reputation
and emerges
the clear
winner

When it
comes to
fixing 
problems,
Samsung
and HP have
similar
turnaround
times

reliable results, and HP clearly
dominates with a huge lead. HP
printers are also more reliable
than those from Samsung,
coming up with half of
Samsung’s reported failure rate
on all counts. Strangely, this is
combined with a higher
perceived reliability score from
Samsung owners.

When it comes to fixing prob-
lems, Samsung and HP have simi-
lar turnaround times. As in the
HDD category, Samsung’s slightly
higher unresolved problem rate
is eclipsed by its better trained
support personnel, giving them
the lead in service. However, this
time the difference is not enough
to displace HP from the throne.

Laser printers have a long way
to go for the retail individual

and small business market, both
in terms of quality as well as
usage. This category turned in the
highest rate of first-week prob-
lems across the survey, matching
those of the desktop PC. The
number of respondents owning
laser printers is less than a fifth
of the number that own inkjets.

HP and Samsung are the only
manufacturers who show up in
sufficient numbers to produce

Laser Printers

The Top Three
HP 8.28
Dell 8.07
Acer 8.03

Repurchase Value
Dell 92
Acer 78
HP 77

The Top Three
HP 7.87
Samsung                         7.80
Others 7.02

Repurchase Index (%)
HP 85
SAMSUNG 70
OTHERS 50

HP

HP

Satisfaction Index Reliability Index Overall

Satisfaction Index Reliability Index Overall
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ment. I will buy from a company
that offers a profitable package for
me,” says Krishna Rath, a program-
mer from Trivandrum.

Nokia maintains most of its
followers, though. “I have been
using a Nokia for two months, and
I can confidently say that the prod-
ucts and the company are
extremely reliable,” says Girish
Rupchandani, a student from
Mumbai.  

With over three quarters of
polled respondents for Nokia
saying they would buy Nokia
again, competition will have to
play hard to garner market share!

Since the advent of mobile
telephony in India, cell phones

have been equated with Nokia.
Often referred to as the ideal
phone for India, they arguably
have the most user-friendly inter-
face and rugged build quality to
suit Indian needs. 

Sony Ericsson, a close second,
is perhaps still lacking in this
respect, but has taken a huge step
forward in reliability, almost
matching Nokia’s rating. On the
satisfaction front, Nokia was a
clear winner, and it is no surprise
that it continues to be Numero Uno
in India.

The fact that Sony Ericsson has
come so close to Nokia in such a
short time is testament to its
commitment to the Indian market
and the resources it has pumped
into this market. 

“I have been using a Sony Eric-
sson model for six months now. I
had a Nokia earlier, but moved to
Sony Ericsson as there were more
features with a lower price tag, and
also because I wanted to experi-

Mobile Phones
The fact that
Sony 
Ericsson has
come so
close to
Nokia in
such a short
time is 
testament 
to its
commitment
to the Indian
market

Sony lords
over the
competition
and has the
most reliable
products

them as they slip from the top
spot they enjoyed last year.

Beating Philips in MP3 players
is one thing, but keeping Apple
and their iPod at bay will be quite
another. While ratings for Sony
were very impressive—especially
in the Reliability Index—it will
need to spruce up service if they
are to truly ward off the iPod
threat. With Apple on the verge
of taking off in the Indian
market, next year’s results might
well paint a different picture 
altogether. Service and reliabilty
can help Sony and Philips retain
their customer base. 

Hybrid devices like cell
phones with extended capabili-
ties are the new threat to MP3
players. Says Ajay Mahajan from
Jammu & Kashmir, “I am using a
Compaq MP3 player for two years
without problems. It is definitely
reliable. But recently, I also got a
Sony Ericsson P910, which has an
inbuilt MP3 player.”

Sony, Creative, Philips and Pana-
sonic are among the most

popular MP3 players. With the
iPod just starting to catch up, this
comes as no surprise. As with
home theatres, Sony lords over
the competition and has the most
reliable products. Creative, on the
other hand, does not enjoy such
a favourable response.  

This category also sees Philips
as a close second behind Sony,
and with the most satisfactory
service, improving its loyalty base.
This, however, is a poor result for

MP3 Players

The Top Three
Nokia 8.26
Sony Ericsson 8.24
Samsung 8.13

Repurchase Index (%)
Nokia 78
Sony Ericsson 67
Samsung 65

The Top Three
Sony 8.19
Philips 7.96
Panasonic 7.78

Repurchase Index (%)
Philips 92
Creative 90
Sony 77

Nokia

Sony

Satisfaction Index Reliability Index Overall

Satisfaction Index Reliability Index Overall
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repair, Samsung saw a whopping
14 per cent of their drives go back
for servicing. They also scored the
poorest in every other reliability
parameter, coming in at the
bottom of the qualifying brands.

Asus and Sony excelled at serv-
ice, with the lowest rate of unre-
solved problems, and they also
had the quickest turnaround
times, indicating a solid support
network. Samsung, on the other
hand, with the largest rate of
unresolved problems and a two-
and-a-half-week turnaround time,
was the poorest at service.

The laser of your PC, the light of
your data, Optical Disk Drives

are often also the noise of your
cabinet, the ‘drive not ready’ of
your Explorer. ODD standards are
going through a transition the
world over, and in India, last year
was clearly when CD-Writers
replaced the read-only drives of
yesteryear. Unfortunately, vari-
able CD-Writer quality, plus the
delicate sensitivity of the media,
ensure that reading CDs is often a
hit-and-miss affair.

Kartik Vithalani, who uses
Samsung products, says, “I have
been using the DVD-R for six
months and the CD-RW for two
years. No problems so far.”

Sony tops in reliability,
followed closely by Liteon.
Samsung drives have the highest
number of responses this year,
accounting for over 40 per cent of
the overall. They were also the
worst of the lot. 

While four per cent of Sony
and five per cent of Liteon drives
required replacement or major

Optical Disk Drives
Sony tops in
reliability as
well as 
service,
followed
closely by
Liteon

Brand
loyalty is not
very high,
with a multi-
tude of
affordable
speaker
vendors
vying for
your money

seven years. Though there have
been no problems, I feel Samsung
has better sound quality than
Intex. In the future, I will not buy
from either company and go for
Creative as I have heard it offers
quality sound.”

Being the relatively simple
devices that they are, it is hardly
a surprise to see that PC speakers
have the lowest chances of early
failure with an industry average
of just one per cent, and the
lowest rate of failure with fewer
than two per cent needing servic-
ing in two years. 

Creative and Mercury have
the lowest failure rates at two per
cent. Intex and Altec Lansing
share the highest rates of failure
at over 11 per cent, but curiously,
complement this by doing very
well on service, posting the high-
est scores in this category.

While they may not be as
important as your monitor

for ‘real’ computer tasks, they are
quite the indispensable add-on
these days. Despite the enormous
range of variation in sound qual-
ity, affordable speakers are now
good enough to serve adequately
for occasional MP3 playback.  

Brand loyalty is not very high
though, with a multitude of
affordable speaker vendors vying
for your money. 

Anurag Nagpal from Haryana
says, “I have been using Intex for

PC Speakers

The Top Three
Sony 8.06
Liteon 8.01
Asus 8.01

Repurchase Index (%)
LG 74
Liteon 73
Sony 73

The Top Three
Creative 8.24
Intex 8.11
Philips 8.08

Repurchase Index (%)
Creative 87
Intex 71
Altec Lansing 71

Sony

Creative

Satisfaction Index Reliability Index Overall

Satisfaction Index Reliability Index Overall
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improves its products with
advanced technology, I might buy
from them again.” 

On the other hand, Nitin
Baria from Jammu & Kashmir
says, “Even after a year, my HP
scanner has no problems and is
dependable.”

The difference here is that
Swapnil uses an MFD while Nitin
has a standalone scanner. HPs
loss, it would seem, is Canon’s
gain!

There was a time when a scan-
ner had to be from Umax. But

the widespread networks—sales
and service—of manufacturers
such as Canon and HP seem to
have had a swaying effect on
buyers. While users of HP scan-
ners had fewer problems and saw
their problems being resolved
sooner, users of Canon scanners
were more satisfied with the
quality of service. A third of HP
users said they would buy
another HP scanner; this number
was about 66 per cent in the case
of Canon.

Increasingly, scanners are
being built into multifunction
devices, and this seems to be the
root of any displeasure. Says
Swapnil Hoderkar from Pune, “I
am not pleased with the HP scan-
ner that I bought six months ago.
I expected its performance to be
much better—it is slow and the
quality of the work at the end is
not impressive. However, if HP

Scanners
A third of HP
users said
they would
buy another
HP scanner

Overall, the
reliability of
UPSes is,
surprisingly,
only a little
better than
that of 
desktop PCs

install-and-forget manner, but it
demands more attention. 

Rajwinder Singh, a disap-
pointed owner of a Shark UPS,
says, “I have had it with me for
three years but had to replace it
twice in that period. Though the
company’s service is good, I do not
find it reliable.” 

Every eighth APC device, for
example, needs to be sent for
significant repair in a two-year
span, but they fail the least often
and have the shortest response
time of 10 days, a week less than
the industry average.

For a critical power condition-
ing function to be unavailable for
a period of 10 days to a month is
quite a risk for your computer.
With such low service levels and a
wide choice, it is not surprising
that over 30 per cent of owners
want to sample other brands. But,
given the abysmal industry-wide
performance, it may be a futile
search.

Most of you do not use an Unin-
terruptible Power Supply

(UPS) at all. Either our State Elec-
tricity Boards are doing great at
inspiring such confidence, or UPS
providers are not doing enough to
explain why a UPS is essential.

This is the most fragmented
market of all the categories here.
Only two brands, APC and
Microtek, garnered enough votes
to generate useful numbers. 

Overall, the reliability of UPSes
is, surprisingly, only a little better
than that of desktop PCs. You
might expect a relatively simple
device such as this to work in an

UPS 

The Top Three
Canon 8.02
HP 7.95
Others 7.93

Repurchase Index (%) 
HP 74
Others 73
BenQ 71

The Top Three
APC 8.17
Others 7.398
Microtek 7.93

Repurchase Index (%)
APC 77
Microtek 70
Others 65

Canon

APC

Satisfaction Index Reliability Index Overall

Satisfaction Index Reliability Index Overall
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Forget blackboards, chalk and textbooks... CD-ROMs are now de rigeur at Agamaa Virtual Classes

Preethi Chamikutty

he last time Snehal Gaik-
wad was interested in the
past was when she

watched a historical at the local
cinema or on satellite television.
Her latest screen, however, is
something she will never
forget—the white board at her
coaching class. 

This 15-year-old Standard X
student of Mumbai’s St Columbia
High School actually is excited at

learning at her local coaching
class. What made  this happen?

Mumbai’s Agamaa Coaching
Classes, better known as Agamaa
Virtual Classes, uses interactive
CD-ROMs as a teaching tool, a
move that has made students as
excited as the teachers who teach
the various subjects. 

Snehal says, “I like history
lectures the best because we see
movie clips about various events.
This helps me understand the
event better and is easier to revise
during exams.”

Welcome to a whole new teach-
ing paradigm!

Agamaa Virtual Classes is an
offspring of Chetana Publica-
tions, a Mumbai-based publish-
ing house that specialises in
textbooks, and teaching guides.
At the classes, however, students
learn not by rote, but by associ-
ating images and sounds to the
words they read in their text-
books and teaching guides.
Chetana’s already-existing data-
base of computer books and
related tools allows Agamaa to

T
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made available to be taken home.
However, this way, students could
not interact with teachers.
Agamaa devised virtual classes to
bridge this gap.

The Medium 
In an education system rife with
teachers, students and parents
who believe in learning by rote,
Agamaa has created a new niche.
Fifty of its more than 1,600
students spread across various
branches in Maharashtra have
now shifted over to the the CD-
ROM way of learning.

Says Rambhia, “Audio-visual
communication is a powerful
tool to influence the attitude,
behaviour, approach, personality
and thinking of an individual.
Experts believe that this
medium, if used to impart educa-
tion, could prove quite effective

in helping students perform
better in examinations.”

It’s Got The Look!
Every Agamaa classroom has a
uniform look. Projectors, a Pro
Dolby sound system, collar micro-
phones and other necessary tools
comprise a classroom. Currently,
courses are conducted for classes
IX and X.

We The Students
Purav Gindra of Mumbai’s St
Sebastian Goan High School was
introduced to Agamaa by his
cousin, a former student. Gindra,
a Standard X student, is part of
the vacation-cum-regular batch of
Agamaa, has opted for all the
subjects they offer. “The audio-
visual interface is a great idea,” he
says. “We see images and movie
clips of our learning material, and
this leaves a lasting impression on
our minds. It is easier to recall
during exams.”

Snehal agrees. “The CD-ROMs
help me learn better. It is easier to
revise during exams,” she says.

All this, though, comes at a
cost. The fee for the class IX
course is Rs 12,000, while the
class X course costs Rs 18,000 for
all subjects.

Business Prospects
Rambhia feels this new way of
learning makes for good busi-
ness sense. “At present, we only
have classes IX and X, but from
next year we plan to expand it to
Standard VIII and XI as well,” 
he says.

For infrastructure, Agamaa
invested close to Rs 10 lakh at each
of its centres and the software
development cost approximately
Rs two crore.

The Competition Hots Up
Even if Agamaa made it first,
Navneet, another giant in the
private education sector, has
introduced Top Scorer Digest
Plus—a self-learning preparatory
tool in CD-ROM format.

Retaining children’s atten-
tion span has always been a chal-
lenge. No matter how good the
teacher is, he or she can never
enact a historic event, or show
the movement of a spirogyra on
a blackboard!

The teacher’s role may never
go out of fashion, but teaching
tools could soon witness a 
sea-change. 

preethi_chamikutty@thinkdigit.com

64 DIGIT FEBRUARY 2005

Digital Tools l Jumpstart

make use of film clips, anima-
tion, sound effects and 3D graph-
ics to explain and narrate course
material. There are, of course,
textbooks and teachers, but
instead of just talk, there are
interactive sessions supported by
audio-visual representations of
textbook content.

First Off The Block
Says Rakesh Rambhia, director,
Chetana Publications: “Initially,
we only had CDs containing
courseware, which were made
available to students who wanted
to avoid going to coaching classes.
However, after interacting with
students and getting feedback
from parents and students alike,
we decided to start this venture.”

Agamaa then took its CDs to
schools and demonstrated the
courseware. Initially, CDs were

K-Yan was developed by financial
corporation Infrastructure Leasing and

Financial Services’ (IL&FS)
Education and Technology
Services (ETS) at its ‘Compact
Media Centre’. Built in
collaboration with IIT
Mumbai, K-Yan is a low-cost
new-media product for
community learning. 

K-Yan combines a
multimedia PC, a large format TV, a
DVD player, a CD writer, an LCD projector,
Internet surfing, video conferencing, and an
AV studio system, in a single, compact unit
that can be operated from a single remote
control-cum-mouse unit for changing from
TV to DVD, or operating the PC. It can also
be loaded with teaching aids that help
enhance classroom teaching, facilitate the
learning process and help students
understand better. 

Some schools that currently deploy K-Yan
include Garden City College, Bangalore;

Tagore International EOK, New
Delhi; Oakridge International
School, Hyderabad; St
Xavier’s College, Kolkata;
Cathedral Junior School,
Mumbai; and 
J N Petit School, Mumbai.

K-Yan provides 
A Pentium 4 processor

DVD/VCD/ACD/MP3 facility 
A CD-Writer 
An audio amplifier and inbuilt speakers 
Large data storage facility (120 GB) and 
512 MB of RAM 
Internet connectivity 
TV cable connectivity 
An 1,800-lumen LCD projection system 
which can project images up to 25” x 12” 
Plug-and-play capability 

K-Yan—The Community Learning Tool

(Left) Learning Hindi the
cool way—at Agamaa
(Top) One of the tools
being used to impart
training—a projector
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Sanket Naik and Jayesh Limaye

E
volution on Earth is a lethargic
process. Events in the PC market
follow a similar  timeline, with
innovations moving the industry
at a leisurely pace. It is thus quite

a sight to witness the barren lands of the
PC—wrecked by bandwidth limitations and
littered with GHz myths—sprouting next-
generation technologies that promise to
turn the desert into thriving wetlands. Sleek
and efficient dual-core processors replacing
fire-breathing, single-core GHz monsters is
a good thing. Bottlenecks are, similarly,
being eradicated by the replacing of parallel
connectors with serial ones—witness the
PCI-Express bus and SATA hard disks.
Graphics cards now sport CPU-like proces-
sors which will soon be better utilised by
operating systems across the board,
bringing performance and usability to an
ageing GUI.

The PC industry is shifting gears, and
not a moment too soon. This change in pace
brings along new jargon to sift through.
New chipsets, new processor roadmaps, new
memory technologies and the like take on
greater significance. Change brings along
confusion; our first task here will be to shed
light on the scene.

Our goal here is not to choose the best
processor and the best motherboard. Rather,
it is to pick the best combination. We will
help you arrive at a system-wide solution—a
solution that will last you through a few
years and that will not strain your pocket:
the conclusion to this test will thus choose
a combination processor/motherboard that
strikes the perfect balance between per-
formance, features and price.

With that in mind, let us first take a
look at where things stand in the rival
camps of industry movers Intel and AMD.

Last year, Intel introduced its 915 and
925 chipsets alongside the new LGA 775
socket processors, which were meant to be
paired with these chipsets. The highlight of
these chipsets was PCI-Express, offering sig-
nificantly higher bandwidth than the cur-
rent PCI bus (For a complete low-down on
PCI-Express, read our In Sight story on page 32).

nVidia and ATi were the first to launch prod-
ucts for the new bus, and the rest of the
industry will follow soon.

AMD, after the introduction of their
Athlon 64 processors, are riding the waves
of success. Not only are their CPUs currently
at the top of the speed chart, but they have
managed to rein in the heating issues that
plagued them. 

While Intel’s product portfolio is
focused and simple to understand, AMD’s is
a complete mess. The Athlon 64 processors
are currently available in two different
socket versions: Socket 939 and Socket 754.
The Athlon XP range of processors recently
got a replacement in the form of Sempron.

While that was on the processor side,
the number of chipsets available for an AMD
processor is numerous, and deciding upon
one is not an easy task. This will be handled
later on in this article when we look at
motherboards from different manufac-
turers sporting various chipsets.

We often receive letters asking what
kind of machine will be decent enough to
play most of today’s games, will offer a fair
amount of upgradeability, and most impor-
tantly, will be easy enough on the wallet.
Since processors and motherboards are the
two most crucial components that decide
the overall performance of a system, while
dictating the headroom for future expan-
sion, we decided to do a CPU and mother-
board comparison test. This article will help
you decide the right platform to upgrade to,
or settle for, when buying a new PC.

Due to the aforementioned changes in
technology, choices are many, and at this
juncture choosing the right solution mat-
ters: one wrong turn and your upgrade
options could hit a dead-end. So, as we com-
pare the different processors and mother-
boards, we will also discuss the pros and
cons of the respective chipsets and
processor families.

This article is broadly classified into
two parts: processors and motherboards.
First, we take a look at the available
processors, and then benchmark them to
arrive at a winner. Similar treatment will
then be applied to motherboards. We will
then pick the best combination of processor

The complete guide to choosing the best platform that is easy on the
wallet, and will last you for years

PERFECT
FUTUREFUTURE

PERFECT
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and motherboard, offering you a
complete solution.

A LOOK AT PROCESSORS
Before we get to the action, let us
refresh our knowledge on the
types of processors available.

Intel Processors
As of today, Intel has two lines of
processors, namely the Pentium
4 series for performance seekers,
and Celeron D for the value-end
of the market. The original Pen-
tium 4 processors were based on
the 130nm manufacturing
process, featured 512 KB of L2
cache and ran on a 533 MHz FSB.
But today’s Pentium 4 is a dif-
ferent beast; it features 1 MB of
L2 cache, runs on an 800 MHz
FSB and is manufactured using
the 90nm process. A still newer
version expected soon will run
on a 1066 MHz bus.

There are also special-edition
Pentium 4 processors called
‘Extreme Edition’, and denoted by
‘EE’. The EE processors have 2 MB

of L3 cache and are manufactured
using the older 130nm process.
The new line of Pentium 4 proces-
sors based on the LGA 775 package
is denoted by a new nomenclature.
Instead of using the core speed as
the name, Intel calls this series the
5XX series, where the ‘XX’ ranges
from 20 to 60. Processors that have
the ‘Execute disable bit’ capability
have the letter ‘J’ following the 5XX
number, an example being 560J.  

The older Pentium 4 proces-
sors required a Socket 478 moth-
erboard, e.g. 845, 865, 875,
chipset-based boards, whereas
the newer ones will be produced
for the LGA 775 package. The LGA

(Land Grid Array) type of socket
is found on motherboards sup-
porting Intel’s new chipsets, i.e.,
the 915 and 925. 

On the Celeron front, too,
there are two versions; the older
ones that run on a 400 MHz bus
have 128 KB of L2 cache, and are
manufactured using the 130nm
process. The newer 90nm-manu-
factured Celeron processors are
called Celeron D, and are denoted
by 3XX series where the ‘XX’
ranges from 15 to 40. The new
Celeron D runs on a 533 MHz bus
and features 256 KB of L2 cache.
Some models of the Celeron D are
available for the LGA 775 sockets;
the rest use the older Socket 478.

AMD Processors
AMD has the Athlon 64 and Sem-
pron ranges of processors.
Depending on the processor inter-
face, or the socket, the Athlon 64
can be divided into two distinct
categories—one that uses Socket
754 and the other that plugs into a
Socket 939. 754-pin processors

This year, we revived our ‘Processor Test’ process with newer and
better benchmarks and testing procedures. All the new

benchmarks are highly processor-dependent, and the peripheral
sub-system has a low level of involvement, which results in scores
that reflect the true potential of the processor’s computational
power. 

For Intel’s LGA 775 processors, we used Intel’s D952XCV
motherboard with 1 GB of DDR-II 533 MHZ memory, whereas for the
Socket 478 processors, we used Gigabyte’s 8TRS350MT
motherboard with 1 GB of DDR 400 MHz Corsair memory.

AMD’s Socket 939 processors were plugged onto an Asus A8V-
Deluxe, while Socket 754 processors went with MSI’s K8N Neo 2.
Socket ‘A’ processors were tied with the ASUS A7N8X-Deluxe. 

Windows XP with SP1 was freshly loaded on a Maxtor Diamond
Max 120 GB SATA drive. On the graphics front, we used Gigabyte’s
AGP card based on the nVidia GeForce 5700 chipset and MSI’s PCIe
card based on nVidia’s GeForce 5750 chipset.

ScienceMark 2.0
ScienceMark 2.0, as the name suggests, is a benchmark based on
scientific calculations. This benchmark constitutes multiple
benchmarks that test various aspects of a processor. We used the
following benchmarking modules: 
MolDyn (Molecular Dynamics): Molecular Dynamics simulates the
thermodynamic behaviour of materials using their forces, velocities,
and positions, where force is the most important parameter. 
Primordia (atoms): This code calculates the Quantum Mechanical
Hartree-Fock orbitals for each electron in any element of the periodic
table. The number crunching involved in the calculation is complex
and stresses the FPU (Floating-Point Unit) of a processor. The final
score is given as the time taken to complete the calculations. 
Cipher Test: The ‘Cipher Test’ tests four different forms of encryption
algorithms, AES 128/256 bit and RSA 512/1024 bit. The calculations
involved are mathematically inclined, resulting in the stressing of the
ALU (Arithmetic and Logic Unit) of the processor.  

WinRAR 3.3
WinRAR 3.3 offers an inbuilt benchmark, operating on random data,
which is processed in the memory. Since the data is operated on in
the memory, the results are free from any influence that a disk
system may impart.

CINEBENCH 2003
CINEBENCH 2003 is the free benchmarking tool for Windows and
Mac OS based on the 3D software CINEMA 4D R8. CINEBENCH 2003
delivers accurate results by testing a processor’s raw processing
speed which affects system performance such as OpenGL,
multithreading and multiprocessing. Also, this benchmark gives a
clear view of Intel’s HT technology in operations, as it supports HT. 

SiSoft Sandra 2005
This is the same good old benchmarking tool with newer features
and tests added to it. Nothing seems to have changed except for the
new user interface and the extra benchmarking tool for USB drives,
cache memory and other parts. We logged scores particularly
related to the CPU, memory and disk drive. 

Doom 3   
Doom 3 is a graphically intensive game capable of making any
machine crawl. This OpenGL game paints a good picture of what a
decent machine should consist of to run games of the future. 

Half-Life 2
This DirectX 9.0 game scales very well with processor speed.
Moreover, any hardware which runs this game well will be
comfortable with upcoming game titles.

Ziff-Davis Multimedia Content Creation
This benchmark suite runs applications related to processor-
intensive multimedia applications such as Adobe Photoshop, Adobe
Premier and WaveLab.

How We Tested Processors

The older FC-PGA 478
interface

The new LGA 775 
interface
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have a single-channel, 64-bit
memory controller, whereas the
Socket 939 has a 128-bit, dual-
channel controller. The Hyper-
Transport link—a serial bus linking
components on an AMD mother-
board—on a 754-pin processor is
capped at 1600 MHz, which is oth-
erwise 2000 MHz for the 939-pin
processor. The total processor-to-
system bandwidth on a 754-pin is
limited to 9.6 GB/s, whereas it is
14.4 GB/s for 939s. In short, the 939-
pin processors are geared for
better performance than the 754s.

The L2 cache size on the
Athlon 64 processor varies
between 512 KB and 1 MB. Similar
to Intel’s ‘EE’ processors, AMD has
the Athlon 64 FX range, available
only on a 939-pin package.

Sempron processors are
meant to replace the older Athlon
XP range of processors. They are
available in two versions—one for
the 754 Socket and the other for
the soon-to-retire Socket ‘A’. Why
two versions?

Initially, AMD wanted to retire
the Athlon XP range, but since the
Socket ‘A’ platform provides the
most value, they thought it wise to
postpone its death. Hence the
release of Sempron for Socket ‘A’
motherboards. Moreover, to bring
some stability to their platforms,
AMD identifies the Socket 754 as
the ideal platform for the near
future, and hence the release of
the 754 package Sempron.

AMD processors of yesteryear
were infamous for their heating
problems, but this is no longer the
case. The
Athlon 64
hardly gets past
50 degrees Cel-
sius; in et, sug-
gesting a
CPU-memory
link inferior to
t h e
Gigabyte board. 

Half-Life 2
Half-Life 2
scales well
with processor
performance.
Since MSI’s

915P Neo 2 did well on the
PCMark CPU score, it came as no
surprise when the board offered
thhhe board offert system hangs
and crashes are experienced.

Who’s The King? 
Let’s get into the real compar-

ison of the processors and see who
comes out tops. This comparison
included six processors from Intel,
ranging from clock speeds of 2.53
GHz to 3.6 GHz.

AMD provided us with 10
processors, including the top-of-
the-line FX-55, along with the
entire Sempron range. We also
included the Athlon XP 3200+. It
should be noted that high-end
processors such as the P4 3.4 GHz
EE, Athlon FX-55, Athlon FX-53,
and the Athlon XP 3200+ are
either too costly or are phased
out, and hence are not part of this
comparison. We included them to
bring better clarity to the results
of the mid-range processors.
Let us take each benchmark and
dissect it to see which processor
fares well and why.

Content Creation 2004
This is a system benchmark,

and so, apart from raw processing
power, it also relies on other crit-
ical parameters such as I/O band-
width and memory bandwidth.
The Athlon64 3000+ was right on
top, scoring 31.4, despite the 1.2
GHz advantage the Pentium 4 3.2
GHz Intel processor has. 

The Athlon64 3000+ processor
has an on-die, dual-memory con-
troller, and hence, memory band-
width is not an issue and stands at
8 GB/s. Intel’s 3.6 GHz also sup-
ports dual-channel, but its
memory controller is part of the
Northbridge and provides a band-
width of 6.4 GB/s.

When you look at the results,
the difference in performance,
though not significant at first

A 754-pin Sempron 3100+ and a Socket
‘A’ Sempron 2800+
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glance, becomes important
when you factor in the 1.2 GHz
advantage the P4 enjoys. The
reason for the Athlon 64 3000+
winning is the excellent band-
width and low latency offered by
the HyperTransport bus used by
AMD processors.

This analysis is further con-
firmed when you compare the
older Athlon XP 3200+ and Sem-
pron 3100+. The Sempron 3100+ is
a 754-pin processor running at 1.8
GHz and uses HyperTransport,
whereas the XP 3200+ is a Socket
‘A’ processor running at 2.2 GHz,
but the memory controller is part
of the Northbridge, a setup similar
to the one used by Intel. Thanks to
this, the Sempron 3100+ leads the
Athlon XP 3200+. Note how the
2.53 GHz Celeron D was thrashed
by the Sempron 2400+ running at
1.63 GHz, underlining the ageing
nature of the Celeron line-up.

ScienceMark 2.0
This benchmark suite consists of
numerous tests that involve data
calculations such as the mathe-
matically-intense molecular
dynamics of the MolDyn test.
Through this benchmark, a
processor’s number-crunching
ability comes to the fore. We will
now take you through the tests we
used within this suite.

Primordia
This test relies mainly on the CPU
and, to some extent, on the CPU-
memory link. The disk system
does not figure in the equation at
all. AMD’s Athlon 64 3000+ comes
out as the best number cruncher
in this lot of processors. 

Here too, the Athlon 64 3000+
betters the faster-clocked Pen-
tium4 3.2 GHz Prescott. The longer

pipelines on the Prescott core are
the reason for the performance
hit: if your job involves number-
crunching varied datasets, such as
in the scientific calculations made
in this benchmark, processors
with shorter pipelines score over
processors with high core speeds
with long pipelines. (We have not
factored the Athlon XP 3200+ here
because this processor will no
longer be available.)

One interesting thing to note
was the difference between the
Athlon XP 3200+ and the Sempron
3100+. While in the Content Cre-
ation test above, we noted that the
Sempron was way ahead of the XP
3200+, the tide reverses drastically
when it comes to number
crunching. This clarifies two
things: if your work involves a lot of
high-bandwidth work—using
image manipulation applications,
3D rendering, or sound editing—a
processor with better CPU-to-
memory bandwidth will do well.
But if your work pertains to pure
number crunching, processors
with shorter pipelines and higher
clock speeds are better suited to
your needs.

The Sempron 3100+ and 2800+,

despite their lower clock speeds,
were able to beat the Pentium 4 3
GHz and 2.8 GHz quite easily. Both
Intel processors are based on the
Prescott core and feature 
longer pipelines.

MolDyn
Here the results were pretty simi-
lar to the Primordia test, confirm-
ing AMD’s superb data-crunching
strength relative to Intel’s new
Prescott core. The higher-clocked
Sempron processors beat the
Sempron 3100+ and Athlon 2800+.
The Celeron D trailed the
Sempron 3000+ by a hefty 55-sec-
ond margin.

Cipher Test
This test is based on the AES block
cipher, formerly known as
Rijndael. In this test, the results
kept the status quo: the Athlon64
3000+ occupied the first position,
while the 3.2 GHz Prescott came
in at a respectable second. The
rest of the story was very similar,
with the Semprons giving their
Intel counterparts a hard time. 

At the low end of the range,
the Sempron 2400+ was still
beating the Celeron 2.53 GHz con-
vincingly. In this test, core clock
speed and work done per clock
matters—hence we observe a
scaling of performance.

WinRAR 3.3
The Athlon 64 family made their
mark here with the Athlon 64
3000+ taking a convincing lead
over Intel’s P4 3.2 GHz Prescott. It
was interesting to see the Sempron
3100+ beating most of the Pentium
4 series by a considerable margin.
This was the first time the Celeron
D processor actually beat a
Sempron—the Sempron 2500+.

The motherboards were segregated first on platform and then 
on chipsets.
For boards based on Socket 478, we used Intel’s Pentium 4 3.2

GHz processor and 1 GB of DDR 400 MHz memory. For the LGA 775
socket, we used a 3.4 GHz EE Processor and 1 GB of DDR 400 or
DDR II 533 memory, depending on the motherboard support. 

For Socket 939-based AMD motherboards, we used an FX-55
processor; for Socket 754-based boards, we used an Athlon 64
3000+ processor; and for socket ‘A’, we used an Athlon XP 3200+. 

For both these rigs, we used a Gigabyte GeForce 5700 card for
AGP-based boards and an MSI 5750-based card for PCIe boards. 

We used a SATA 120 GB Maxtor Diamond Max drive on both
test rigs. Windows XP with SP1 was our choice of operating system
for the test. All other required drivers and patches were loaded
before continuing with the tests. The operating system was freshly-

installed for all motherboards and the hard drive was
defragmented before testing.  

PC Mark 2004: The test mainly comprises applications that are
used in day-to-day functioning, and generates a score depending
on the performance of the system in each individual test. 
3D Mark 03: We used the 2003 version since most of the tests in
the new version would be skipped due to lack of hardware support
in the GeForce 5700-based cards. However, 3D Mark 2003 scales
fairly well and was therefore used for gauging the graphics sub-
system of the motherboards.
CineBench 2003: This tool is set to deliver accurate benchmarks
by testing the computer’s raw processing speed, and other areas
that affect system performance such as OpenGL, multithreading,
multiprocessing, and Intel’s new HT Technology.

How We Tested Motherboards
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CINEBENCH 2003
The results from this benchmark
are quite interesting: CINEBENCH
2003 makes perfect use of Intel’s
HyperThreading technology, and
hence we see Intel’s 3.2 GHz
processors taking the steam out of
AMD’s processors and coming out
on top. Except for the Celeron D,
nearly all Intel processors per-
formed extremely well here.

To clarify, HyperThreading
does not involve two physical
processors. It is accomplished by
having a virtual processor along
with the physical one. The results
of this test are important for the
future: both Intel and AMD are due
to release dual-core CPUs-proces-
sors with two physical cores on a

single die—in the latter half of this
year. If the current breed of HT-
enabled processors derive a good
performance benefit, it would 
be interesting to see the perform-
ance of dual-cores on this 
benchmark and similar multi-
threaded applications.

dBpowerAMP
The Athlon 64 3000+ was the
fastest at ripping songs from a CD,
getting the job done in just 77 sec-
onds. Surprisingly, the Sempron
2800+ took second position, dis-
placing the Athlon64 2800+ to
third position. Intel’s P4 3.2 GHz
was outgunned even by the
Sempron 3100+. The Celeron
processor was nearly 31 per cent
slower than the Athlon64 3000+.

DVD to DivX
In DivX encoding, the tides
favour Intel. Both the Pentium
4s—the 3.2 and 3 GHz—beat the
Athlon 64 3000+ by a consider-
able margin. The results clearly
indicate that DivX encoding
relies heavily on core clock
speeds, streaming instructions
(SSE, SSE2, SSE3), and how well

an application makes use of
these streaming instructions.
The DivX codec has been opti-
mised for Intel processors, and so
you see the boost when you use
Pentium 4 processors.

The lower-clocked Sempron
2400+ and 2500+ paid the penalty,
taking the last slots, falling behind
the slightly higher-clocked
Celeron D processor. 

DOOM 3
In the gaming test too, AMD’s
processors took the crown; inter-
estingly, it was the Athlon 64
2800+. The Athlon64 3000+ was
behind the 2800+ by 3 fps. Close
on its heels were its cost-effective
siblings, the Sempron 3000+ 

and 3100+. 
The Intel proces-

sors were completely
overshadowed by the
startling perform-
ance of the Athlon 64
range. In fact, the
new Sempron 3100+,
3000+ and 2800+,
which cost no more
than Rs 6,000, per-
formed better than
Intel’s expensive Pen-
tium 4 series. The
scores returned by
the Celeron D 2.53
GHz processor were

pathetic—just about half of what
the Athlon 64 2800+ returned.

Another point to remember is
that DOOM 3 is more graphically
intensive than Half-Life2—future-
games using this engine will rely
more on your graphics card than
on the CPU.

Half-Life 2
The results obtained from this
test are interesting because the
scores scale with rated processor
performance. Intel’s 3.2 GHz
Pentium 4 managed to steal the
limelight thanks to its higher
clock speed and larger cache.
However, the Athlon 64 3000+ was
a hair’s breadth away from the
leader, which is commendable,
taking into account the 1.2 GHz
speed advantage the P4 enjoys
over the 3000+.

The competition really heated
up for third place between the
Athlon 64 2800+ and the Pentium
4 3 GHz. Eventually, the AMD top-
pled the Intel processor by a small
margin. With the help of faster
clock speeds, the Pentium 4s—the
3 and 2.8 GHz—beat the lower-
clocked Semprons. From the
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scores, we can infer that Half-life
2 scales well with your processor—
the faster the CPU, the better the
performance the game delivers.

And The Winner Is…
The Athlon64 3000+ makes it to
the top thanks to its excellent per-
formance and attractive pricing.
Competing Intel processors lack
that extra juice to take on the
AMD Athlon64 3000+.

The Sempron range of proces-
sors provides the best value for
money; at least in certain tests
such as the DOOM 3 test, it gives
even the high-end Intel processors
a run for their money.

However, before you jump
out to buy one of these, there are
certain things to consider: the
Socket ‘A’ versions of this
processor, available as 2400+,
2500+, 2800+ and 3000+, are

manufactured only to prolong
the life of that platform. There-
fore, consider buying them only
if you are upgrading your older
Athlon XP-based machine. If you
are buying a new Sempron
machine, we would recommend
the new 3100+, based on the 754
socket, so you have the option of
upgrading to Athlon 64 later.

While that was Sempron, the
value processor from AMD, the
Celeron D processors from Intel
are a hopeless piece of silicon that
you should not bet you hard-
earned money on.

Choosing The Right
Processor
As with any other element of
your computer, define the typi-
cal usage that your processor
will see before you choose one. If
you are in academia, where your
work involves scientific calcula-
tions, an AMD Athlon 64 proces-
sor would be ideal simply
because of its raw number-
crunching performance.

Similarly, people whose work
involves 3D applications, image or
video manipulation, that is, mul-
timedia, should also go for an
AMD processor. The high band-
width between the CPU and
memory gives them a good boost
in these applications.

For media encoding or
decoding tasks such as ripping
movies to DivX, MP3 conversions,
and the like, the Pentium 4 line,
with its long pipelines, SSE 3
instructions and higher clock
speeds are ideal.

If you are a gamer, we recom-
mend the fastest AMD Athlon 64
processor available. Though the
Pentium 4 3.2 GHz beats the
Athlon 64 3000+ in the Half-Life 2
test, it does so simply because of
the 1.2 GHz speed advantage the
Pentium has over the Athlon 64
3000+. Moving to a slightly higher-

clocked Athlon 64 will paint a
completely different picture. 

MOTHERBOARDS
Two-and-half years ago, Intel, VIA
and SiS were the only companies
involved in the manufacturing of
chipsets—the group of logic cir-
cuits that controls the functioning
of a motherboard. Intel developed
chipsets for their own processors,
and their portfolio was perfectly
tailored to suit the needs of their
processors. On the other hand,
solutions from VIA and SiS
included chipsets for Intel as well
as AMD processors, like the KM400,
KT400A, SIS760 and others. nVidia
and ATi have since joined this elite
club of chipset manufacturers and
now, with five companies offering
chipsets, choosing the right moth-
erboard is a challenge.

Amidst the transition the PC
industry is going through, buying
a motherboard based on older
technology should be avoided at
all costs. This section will shed
light on how to tackle this transi-
tion. Here we help you choose the
right motherboard that not only
gives you the best performance but
also provides enough headroom
for upgrades. 

The motherboards have first
been divided on the basis of plat-
form, namely Intel and AMD, and
further classified according to
chipset. Let us first uncover some
facts about Intel chipsets.

Intel Motherboards
Motherboards based on Intel’s
platform have always been known
for their stability, performance
and reliability. This is to be attrib-
uted to the fact that Intel’s
chipsets are perfectly tailored to
their processors. While some years
ago, it was only Intel who manu-
factured chipsets for their own
processors, VIA, SiS, and now
nVidia have joined in to give con-

Processors Basic Specifications Price *

Scoreboard

65.23
61.99
60.95
58.19
58.90
60.21
63.30
57.73
56.72
55.29
50.91

6716
6624
5704
5566
4922
3404
2806
13900
10900
9900
4900

Speed 
2.01 GHz
2 GHz
1.8 GHz
2 GHz
2 GHz
1.75 GHz
1.67 GHz
3.2 GHz
3 GHz
2.8 GHz
2.53 GHz

AMD Athlon64 3000+
AMD Athlon64 2800+
AMD Sempron 3100+
AMD Sempron 3000+
AMD Sempron 2800+
AMD Sempron 2500+
AMD Sempron 2400+
Intel Pentium4 540
Intel Pentium 4 530
Intel Pentium4 520
Intel Celeron D 325

FSB
NA
NA
NA
333 MHz
333 MHz
333 MHz
333 MHz
800 MHz
800 MHz
800 MHz
533 MHz

L2 Cache 
512 KB
513 KB
256KB
256KB
256KB
256KB
256KB
1 MB
1 MB
1 MB
256KB

Score (100)

Price versus Performance

In this graph, we have plotted a processor’s performance against the
price at which it is offered. Price is along the X-axis, and processor per-
formance on the Y-axis. The green dots represent AMD processors, and
the blue dots indicate Intel processors.
As you can see from the graph, as the price increases, so does perform-
ance; however, the increase in performance is not linear. 
AMD’s Athlon64 3000+ has the highest performance and it is offered at
roughly Rs 7,000. Intel’s 3.2 GHz comes in at second place, but is steeply
priced at Rs 14,000. The difference in these prices is significant; however,
there is a mere five per cent difference in performance. In other words, at
50 per cent of the price, the Athlon 64 3000+ offers better performance
by a margin of five per cent over Intel’s 3.2 GHz. Similar inferences can be
drawn by comparing other pairs of processors.

For the entire scoreboard, please visit www.thinkdigit.com
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sumers a variety to choose from. 
In fact, VIA was the first to

realise the performance gain of
DDR RAM and brought it to the
Intel platform before Intel could
do so with their chipsets.

Intel, with their 810 and 815
chipsets for the Pentium 3
processor, made on-board
graphics popular, especially in
India where the majority of the
PCs sold have on-board graphics.
The 845 chipset further improved
graphics performance. VIA and
SiS did bring good competing
products, but lost ground to
Chipzilla’s marketing muscle.

Greater demand for on-board
graphics spurred Intel to intro-
duce the i865 and i875 chipsets,
the former targeted towards price-
sensitive users, the latter meant as
the performance chipset.

By this time, graphics card
leaders nVidia and ATi realised the
potential market Intel had tapped
into by including a graphics chip
on board their chipsets. This her-
alded the birth of the ATi RS350
PRO chipset with better onboard
graphics than Intel’s chipset.

Last year, Intel introduced the
i915 and 925X chipsets, which
were completely new platforms
designed from the ground up,
offering new features and revising
some specifications to handle
today’s media-savvy world.

What’s On Offer
If you want to buy an Intel-based
system, the market offers mother-
boards based on the i845, i865,
i875, i915, i925 and RS350 chipsets.
Asus, MSI, Gigabyte, Mercury, HIS,
Krypton are the brands you will
come across. Let’s understand the
pros and cons of each chipset.

i845
The 845 chipset is the oldest avail-
able chipset in the market. It is
generally used in motherboards
that do not cost more than Rs
4,000, and hence, we will treat it
as out of the scope of this article,
since we are primarily looking at
mid-range motherboards. 

Systems based on this chipset
are good for Internet browsing
and Word processing—nothing too
computationally intensive. 

i865 and i875
Both these chipsets are relatively
new and have enough juice to hold
their own against newer Intel
chipsets. However, since they lack
PCI-Express, they may become

obsolete too soon. The difference
between the two chipsets is that
the i865 is aimed at the value-con-
scious buyer looking for an
onboard graphics solution,
whereas the i875P chipset offers
better performance.

One point to remember is that
motherboards based on these
chipsets use the older Socket 478
processors. In fact, ATi’s RS350 is
also built around the Socket 478
processor, and hence the new LGA
processors won’t fit on these
motherboards.

i915 and i925
This brand-new chipset family
from Intel is loaded with fea-
tures—some new, some logical
and some revised to meet current
standards. But the highlight is
the introduction of the PCI-
Express bus for discrete graphics
cards and other peripherals.
Nearly all motherboards based on
these two chipsets will have an
x16 PCIe slot for a graphics card
and two or more x1 PCIe lanes in
addition.

These chipsets also support
the new DDR II standard, the
memory runs at 533MHz—133
MHz faster than the fastest DDR
memory. On the integrated
graphics front, the 915 chipset
boasts of DirectX 9.0 compliance,
and is capable of hooking up to
an HDTV or to widescreen LCD
monitors. 

Most importantly, improved
onboard graphics have been intro-
duced so that a platform based on
this chipset complies with
Microsoft’s upcoming Longhorn
OS’ minimum requirements.

On the storage side, the new
chipsets have legacy support for
four SATA drives and one ATA
drive. If the motherboard uses the
ICH6R Southbridge, it supports
Intel’s Matrix RAID technology
too. Eight USB2.0 ports and a ded-
icated Gigabit network bus is an
integral part of all motherboards,
unless the motherboard manu-
facturer decides to cut down on
cost.

The introduction of High-Def-
inition Audio (Azalia) will be
music to your ears! The new stan-
dard improves upon the older
AC’97 and takes it further: you
can connect 7.1 speakers directly
to your motherboard; there’s no
need for an additional 7.1-
channel soundcard. Most moth-
erboards also have ‘jack sensing’
enabled, which ensures that
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incorrect wiring of speakers is a
thing of the past.

Let The Tests Begin!
For the Intel platform, the moth-
erboards fell within the Rs 5,000 to
Rs 10,000 range. Asus, MSI, Giga-
byte and AOpen managed to send
us boards, most of them based on
the 915G chipset. We did receive
boards based on the RS350 and 865
chipsets, but we deferred to test
them since they are based on the
older socket 478 processors and
would be obsolete soon. Of the
seven boards based on 915G, MSI
sent us three, Gigabyte two, while
Asus managed to send one. Unfor-
tunately, the AOpen was ruled out
due to a malfunction.

Features
All these motherboards support
the latest Pentium 4 800 MHz LGA
775 processors, clocked up to 3.8
GHz. Care must be taken while
installing the processor, as the
pins are on the motherboard sock-
et. The heatsink/fan unit does not
have a plastic retention mecha-
nism like the one on older Socket
478 boards. So check the heatsink
for proper contact with the
processor after installation.

Gigabyte’s GA-8I915G-MF and
MSI 915G Neo 2 score high for their
clean and unhindered layout—no
capacitors near the processor area.
MSI provides a unique CPU instal-
lation clip so as to avoid damage to
the motherboard socket.

MSI’s 915G combo and Giga-
byte’s GA-8I915G Duo support the
DDR and DDR II standards. Both
these boards have four slots—two
each for DDR and DDR II—to
ensure dual-channel memory sup-
port. The Platinum series boards
from MSI only support the DDR II
standard, whereas the Asus P5GD1-
VM and Gigabyte GA-8I915G-MF
support DDR 400 MHz as well.

Since most 915 boards use the
ICH6 Southbridge, almost all
boards support SATA drives. How-
ever, MSI’s Platinum boards use
the ICH6R Southbridge, thus
adding RAID 0, 1, 0+1 and Intel’s
Matrix RAID capability to the
storage sub-system. If you plan to
use the system for I/O intensive
work, requiring faster data trans-
fers and reliability, you might
want to look at these boards; oth-
erwise the above are just extra fea-
tures that you won’t use. 

While SATA is increasing in
presence, support for older IDE
connectors is still in place. The

Southbridge still supports one IDE
drive, and hence, connecting your
old CD-ROM is not a problem—yet.
The ASUS P5GD1-VM and Gigabyte
GA-8I915G-MF have just one IDE
connector, whereas MSI’s Platinum
boards and Gigabyte’s GA-8I915G
Duo have three—one via the
Southbridge, and the other two,
RAID-capable, via a third-party con-
troller, namely the VIA VT-6410.

Since MSI’s 915P Neo 2 Plat-
inum is based on the ‘P’ version of
the 915 chipset, it lacks an
onboard video controller, while
the other boards have an inte-
grated GMA 900 video chip. Every
board in this mini round-up fea-
tures the x16 PCI-Express lane for
plugging a discrete video card, if
you need to play high-end games.
Except for the Asus P5GD1-VM
with just one x1 PCI-Express slot,
all the other boards featured a
minimum of two x1 lanes.

On the peripherals side, all
motherboards now come with
eight USB2.0 ports and Gigabit net-
work adapters for faster data
transfer. FireWire ports still evade
the motherboards in general, with
only the Platinum series mother-
boards from MSI featuring them.

As for the sound system, all
boards had onboard support for
Intel’s High Definition 7.1- channel
audio. Almost all boards feature
PCI slots for those older sound
cards and network cards.

What we can conclude from
this is that no motherboard comes
close to the MSI 915G and 915P Neo
2 Platinum in terms of features
offered. Gigabyte’s GA-8I915G Duo
and MSI’s 915G Combo combine
assorted features so as to keep the
cost down. Asus’ P5GD1-VM and
the Gigabyte’s GA-8I915G-MF have
all the essential features. 

Performance
Let’s take one benchmark at a time
to see how each motherboard fared.

Content Creation 2004
MSI’s 915G Neo 2 does a great job,
returning a score of 33. Close on

its heels is its sibling, the 915P
Neo 2. Third place is taken by
Asus’ P5GD1-VM. Gigabyte’s GA-
8I915G0MF scored 17 per cent less
than MSI’s top board. All this
shows that MSI’s 915G Neo 2 has
a well-oiled sub-system.

PCMark 2004
This test suite is also a system-level
benchmark, testing both the
processor and I/O performance.

The CPU Sub-system
MSI’s 915G Neo 2 was way ahead
of the other boards when it came
to the CPU sub-system, and the
CPU sub-system was the reason
for this board’s good performance
in the Content Creation test.

Overall, the results are pretty
similar with second place once
again going to the MSI 915P Neo
2, third place being secured by
Asus’ P5GD1-VM. Both the Giga-
byte boards are in the last spot.
A point to observe is that the per-
formance of the GA-8I915G-MF
board is nearly 12 per cent
poorer than MSI’s 915G Neo 2 in
the CPU sub-system test,
resulting in the low Content Cre-
ation score.

The I/O Sub-system
In the I/O sub-system, Gigabyte’s
GA-8I915G Duo gains over MSI’s
Platinum boards by a small mar-
gin. MSI’s 915G Combo, without
a doubt, has a poor I/O subsys-
tem, a fact reflected in its
Content Creation score. Asus’
P5GD1-VM also scores less on the
I/O. These are not the boards to
look at if your work involves
image or video manipulation.

Memory Test
Gigabyte’s GA-8I915G Duo again
scored over the MSI Platinum
motherboards—by a small
margin of 0.22 per cent. Asus’
P5GD1-VM and MSI 915G Combos
were right at the bottom of the
score sheet, suggesting a CPU-
memory link inferior to the 
Gigabyte board. 
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Half-Life 2
Half-Life 2 scales well with
processor performance. Since
MSI’s 915P Neo 2 did well on the
PCMark CPU score, it came as no
surprise when the board offered
the best performance for this
game. This is further confirmed
when you consider the Gigabyte
GA-8I915G-MF right at the bottom
of the graph—it fared rather
poorly in its CPU tests. Second
place was taken by MSI’s other
Platinum offering, while third
place went to Gigabyte’s GA-
8I915G Duo.

DOOM 3
Except for the MSI 915G Neo 2 that
scored 27 fps, all other boards
were stuck at 26.9. The results do
not imply that the MSI 915G Neo is
significantly better than the rest.
It does show that the game was
GPU-bound, and hence the scaling
did not occur as expected.

In Conclusion
MSI’s 915G Neo 2 and 915P Neo 2
Platinum boards were the best of
the lot. Both boards performed
equally well on all counts, and
have good sub-systems that don’t
bog down when stressed. More-
over, their feature lists are endless,
and a very generous package
makes them excellent buys.

When you bring price to the
equation, the GA-8I915G Duo
comes out on top. At Rs 6,000, the
Duo is priced at Rs 6,000, which is
Rs 4,000 less than the MSI Plat-
inum boards. Despite its relatively
poor performance, the GA-8I915G-
MF scores higher than the other
boards simply because of its price.
At Rs 5,300, the GA-8I915G-MF is
priced nearly 50 per cent less than
MSI’s Platinum boards.

This, however, cannot take
away the accolades that the MSI
platinum series boards deserve. If
you want the best motherboard
for the Intel platform and don’t
mind the extra price, go for one of
the MSI boards.

THE AMD PLATFORM
VIA, SiS and nVidia are the only
vendors that manufacture
chipsets for the AMD platform.
While PCI-Express has made it to
mainstream boards on Intel plat-
forms, it hasn’t quite made
inroads into the AMD platform
yet. A majority of the chipsets
supporting AMDs still use AGP
and PCI.

The AMD Athlon line is seg-

mented on the basis of its inter-
face socket: AMD has different
chipsets supporting the 754-pin
Athlon 64 and the 939-pin Athlon
XP. A point to remember is that a
system based on the 939-pin
Athlon processor is relatively
expensive compared to a 754-pin
system. Since we are here focusing
on a mid-range system, we will
concentrate only on the 754
chipsets, and not the ones sup-
porting 939-pin processors.

The majority of motherboards
available for the Socket 754 Athlon
64 processors are either based on
VIA’s K8T800 or nVidia’s nForce3
250 GB chipset. Both these
chipsets are almost at par with
respect to the features they offer.
Remember that the socket 754
processors have a single-channel
memory controller; dual-channel
is found only in 939-processors.
These two chipsets are generally
used in the higher spectrum of the
mid-range boards. 

Motherboards based on these
usually cost upwards of Rs 6,000.
The SiS 760GX chipset also sup-
ports 754-pin Athlons, and it pro-
vides integrated video, which the
former two chipsets lack.

Looking To The Future
As mentioned earlier, PCI-Express
has yet to make a prominent
appearance on the AMD circuit.
That day, though, is not far away.
nVidia and ATi have already
launched chipsets supporting
PCI-Express, and ATi has already
made it to the Indian market, ATi
launched their Radeon Xpress
200 chipset featuring PCI-Express
technology for the AMD platform.
Currently, only MSI has products
based on this chipset—the others
are expected to follow soon. Note
that this chipset only supports
939-pin Athlon processors, which
are expensive. 

Since they don’t come under
the purview of this article, we
shall discuss them in a 
forthcoming article.

nVidia has launched their
nForce4 chipset with SLI tech-
nology, but it will take a while for
that technology to show up.

The Comparison
So which is the best motherboard
to go with an AMD 754-pin
processor? To decide this, we test-
ed the five AMD, three Asus, one
MSI and one Gigabyte boards that
arrived in our lab. Of these five
boards, three were based on
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nVidia’s nForce 3 250 GB chipset,
and one each on VIA’s K8T800 and
the SiS 760GX. Let’s begin with
features first, and then turn our
attention to performance.

Features
All these boards support AMD
754-pin processors up to the
maximum speed available. On
the memory front, since the
memory controller is integrated
into the processor core, it deter-
mines the speed of the memory;
in this case, it is DDR 400 MHz. 

In other words, all these
boards support DDR 400 MHz
memory in single-channel mode
only. Here, the HyperTransport
bus is capped at 800 MHz, which
otherwise runs at 1000 MHz for
939-pin processors. Except for the
SiS chipset, all boards support 3
GB of memory; the Asus K8S-MX
can support a maximum of 2 GB.

All the boards have two IDE
connectors that can connect four
IDE devices. Asus’ K8V-SE Deluxe
has gone one step further,
offering one extra IDE connector
for RAID. MSI’s K8N Neo Platinum
and Asus’ K8V-SE have four SATA
ports, whereas the K8N-E Deluxe
can support up to six SATA drives
in RAID 0, 1, 0+1 and JBOD func-
tionalities. Gigabyte’s GA-K8NS
and the Asus K8S-MX support two
SATA drives, and are limited to
RAID 0 and 1 capabilities.

Except for the ASUS K8S-MX,
which has an integrated video
chip based on the SiS 760GX
chipset, no other board has an
onboard video controller.

The Asus K8N-E and K8V-SE,
and MSI’s K8N Neo Platinum
motherboards have FireWire
ports. Eight USB 2.0 ports are sup-
ported by almost all the mother-
boards; however, only four to six
are on the back panel, and the
rest are available via headers on
the board.

On the Intel side, we have
seen that the Gigabit network
adapter is present on all 915-
chipset-based motherboards;
however, on the AMD platform,
only the Deluxe or Platinum
series boards have them, while
the rest use the older 10/100 stan-
dard. If you transfer huge files
over the network, or if you are a
movie-editing house or an E-
learning developer, ensure that
Gigabit Ethernet is supported by
your motherboard. 

Six-channel audio is present
on almost all motherboards, and
these were no exception. We did
not compare the fidelity offered
by either these boards or by the
Intel boards that support High-
Definition Audio, and hence
cannot comment on the sound
quality.

Five PCI slots are common on
these boards, but the Asus K8S-
MX had only two since it is based
on a micro-ATX form factor. 

MSI’s K8N Neo Platinum
sported the best component
layout. In fact, the layout was
completely different from the
norm. The processor area was free
of all intruding capacitors, and
the storage ports were placed per-
fectly for hindrance-free opera-
tion. The component layout 
on the Asus K8V-SE Deluxe is 
also nice—a similar approach is
visible on Gigabyte’s GA-K8NS.
Due to its small form factor, the
layout on the Asus K8S-MX was a
little cramped.

The Deluxe and Platinum tags
ought to tell you that the package
is packed with features. And this
was true, as Asus’ K8N-E Deluxe,
MSI’s K8N Neo Platinum and Asus’
K8V-SE Deluxe were generous on
their packaging and features.

Performance
Having taken a look at the feature
set these motherboards offer, let’s

move on to the benchmarks and
see how the chipsets performed.

Multimedia Content
Creation 2004
MSI’s K8N Neo Platinum topped in
this system-level benchmark, indi-
cating that this board has what it
takes to be the best and does not
bog down when all sub-systems
are stressed. Gigabyte’s GA-K8NS is
off-target by a very small margin
from the leader, MSI. The remain-
ing Asus boards put up a relative-
ly decent showing, with the dif-

ference between the Asus K8V-SE
and the MSI K8N Neo not being
more than 10 per cent.

PCMark 2004 CPU 
Sub-system
In the CPU test, the ASUS K8N-E
Deluxe emerged on top, dis-
placing the MSI K8N Neo Plat-
inum to the second
position—albeit only by a small
margin of 0.5 per cent. The race
for third place was close: Giga-
byte’s GA-K8NS managed to edge
ahead of the Asus K8S-MX by an
extremely small margin.

In the last slot was the Asus
K8V-SE deluxe. The point to note
here is that the top three were
based on the nForce 3 250 GB,
and it seems that this nVidia
chipset has a good CPU sub-
system. Between the VIA and SiS
chipsets, it’s hard to give a clear
verdict since we had only one
board per chipset.

PCMark 2004 Memory
Sub-system
The results were pretty much the
same again: Asus’ K8N-E Deluxe
took the top slot, to be closely fol-
lowed by MSI’s K8N Neo
Platinum. The VIA chipset-pow-
ered Asus K8V-SE beat Gigabyte’s
GA-K8NS by a convincing margin,
whereas the SiS-based Asus K8S-
MX came in last.

For the memory sub-system, a
lot depends up on the actual
layout of the memory bus on the

Motherboard Score ( 100)Basic Specifications Price *

Scoreboard

77.97
76.42
77.56
77.65
78.67

68.98
78.77
76.61
74.71
76.19
73.31

8736
8320
4992
5800
8000

7904
6000
5300
9700
6500
9600

AMD Platform (Socket 754 Motherboards)
nForce3, 6 SATA W/T RAID, Gigabit, 7.1 Audio 
VIA K8T800, 4 SATA W/T RAID, Gigabit, 5.1 Audio
SiS 760GX, 2 SATA W/T RAID, 10/100, 5.1 Audio, Onboard Video
nForce3, 2 SATA W/T RAID, 10/100, 5.1 Audio
nForce3, 4 SATA W/T RAID, Gigabit, 7.1 Audio 
Intel Platform (i915 Motherboards)
DDR 400, Onboard Video, 4 SATA, X16 PCI-E Lane, 7.1 Audio
DDR and DDR-II 533/400, onboard video, 4 SATA, X16 PCI-E, 7.1 Audio 
DDR 400, Onboard Video, 4 SATA, X16 PCI-E Lane, 7.1 Audio
DDR-II 533/400, onboard video, 4 SATA W/T RAID, X16 PCI-E, 7.1 Audio
DDR and DDR-II 533/400, onboard video, 4 SATA, X16 PCI-E, 7.1 Audio 
DDR-II 533/400,  4 SATA W/T RAID, X16 PCI-E, 7.1 Audio

Asus K8N-E Deluxe
Asus K8V-SE Deluxe
Asus K8S-MX
Gigabyte GA-K8NS
MSI K8N Neo Platinum

Asus P5GD1-VM
Gigabyte GA-8I915G Duo
Gigabyte GA-8I915G-MF
MSI 915G Neo 2 Platinum
MSI 915G Combo
MSI 915P Neo 2 Platinum

For the entire scoreboard, please visit www.thinkdigit.com



77FEBRUARY 2005 DIGIT

Digital Tools l Test Centre

motherboard. Since the memory
controllers for some of the
Athlons are on the processors, the
difference that is seen is due to the
physical routing of the memory
bus rather than anything else.

Performance Of The 
I/O Sub-systems
Asus’ K8N-E Deluxe maintains its
lead by a significant margin.
Gigabyte’s GA-K8NS takes the sec-
ond position, while the ASUS K8S-
MX is right on its tail. The Asus
K8V-SE Deluxe loses out to these
boards. Interestingly, the better-
performing K8N Neo Platinum
from MSI slips to last spot, thus
that it is not the motherboard to
be considered if your work
involves lots of data processing. 

Overall, we can conclude that
the nForce 3 250 GB chipset is
superior to the VIA and SiS solu-
tions by a long shot.

3DMark 2003
In this benchmark, MSI’s K8N Neo
takes first place, displacing the
ASUS K8N-E Deluxe. However, the
difference is no more than 0.5 per
cent, which can effectively be
ignored. Gigabyte’s GA-K8NS takes
third position, and is closely fol-
lowed by Asus’ K8V-SE, while its
cost-effective sibling, the K8S-MX,
is put down where it belongs. This
test once again proves the superi-
ority of the nForce 3 chipset over
its close competitor from VIA.

DOOM 3
With DOOM 3, Asus’ K8N-E deluxe
comes first. Asus’ K8V-SE out-
shines Gigabyte’s GA-K8NS to take
the second slot. MSI’s K8N Neo is

on par with Gigabyte’s
board, whereas Asus’
SiS connection once
again fails to fire.
Overall, all mother-
boards put up a good
show here.

Conclusion
Going by pure per-
formance, the com-
petition between
the ASUS K8N-E

Deluxe and MSI’s K8N Neo is close.
However, the Asus surges ahead,
by a small margin. On the fea-
tures front, both boards are on
par, and that leaves us with
price to decide
who takes the
crown. The MSI
K8N Neo is
about Rs 800
c h e a p e r
than the
Asus K8N-E
Deluxe. However,
we think they both
deserve accolades and are
equally good solutions for
AMD’s socket 754 pin processor.

Summing It All Up
In our processor test, we wit-
nessed AMD’s Athlon64 processor
take the steam out of the Pentium
4 series of processors. If you want
the best performance, nothing
beats the Athlon 64 line. 

In the motherboard test, we
saw the successful inception of
PCI-Express on the Intel platform,
which was not the case with AMD-
the platform still relies on
the AGP and PCI standards.

While it might seem logical to
invest in an Intel solution for the
sake of PCI-Express, it is important
to note that devices for this new
bus will take time to be widely
available. Currently only graphics
cards are available for the PCI-
Express bus. Since AGP is preva-
lent in current systems, it will
take the better part of two years, if
not more, for the technology to
make a complete shift to PCI-
Express. Hence, even after two
years, the AMD system you buy

today will be

upgradeable-to certain
extent.
So what is the ideal mother-

board-processor combination? We
are of the opinion that the AMD
platform, once again, offers the
most value for money. The per-
formance of an AMD system is
way ahead of Intel’s competing
products, is on equal footing as
per features, and costs less.

We award the Athlon64 3000+
and ASUS K8N-E Deluxe or MSI
K8N Neo Platinum as the best
buy Gold solution. This combo in
conjunction with appropriate
components will work great for
gamers, for professional artists
using resource-intensive applica-
tions such as Photoshop, 3D Max,
Maya, etc, and will cost no more
than Rs 15,000.

If you are on a shoestring
budget and Rs 15,000 is too much
to spend, go for the AMD
Sempron 3100+ and ASUS K8S-
MX. This combo will cost around
Rs 11,000. Since the board has
integrated video and an AGP

slot, you can opt to save on cost,
and at the same time, have the
option of upgrading later. This
combination wins our best buy 
Silver award.

For the ‘Intel Inside’ devotees,
the Pentium 4 530 (3 GHz) com-
bined with Gigabyte’s 8I915G Duo
makes the ideal motherboard-
processor combo at Rs 17,000.
Overall, on a performance-and-fea-
tures scale, this combination lies
somewhat between our Gold and
Silver awardees, but costs more. 

sanket_naik@thinkdigit.com
jayesh_limaye@thinkdigit.com
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Compacting .fla Files?
Suppose you have to
post an 11.8 MB Flash

document (the .FLA) to a Web
server. Although you have a
high-speed connection, there
still has to be a better way.
And there is:

Open any Flash file in
Flash MX 2004, and choose File
> Save and Compact. This
feature can compact the 11.8
MB monster FLA file to about
2.3 MB. Especially useful for
those with slower connections.

Find And Replace
If you’ve ever been in
the situation where you

have to find every instance of
something in Flash and
replace it with another, you
know what a nightmare it
can be. If you have not
experienced this yet, trust us,
you don’t want to. There is a
simple way to find and
replace. Go to Edit > Find and
Replace, to open the Find and
Replace dialog box. From
here, you can locate and
replace text, fonts, symbols,
sounds, video clips, bitmaps,
and even colour. Yes, even
colour can be replaced.

Here’s an example: Draw
a circle and a box on the
‘Stage’, and convert them to
symbols called ‘circle’ and
‘box’. Leave them both there.

Go to Edit>Find and
Replace.

In the dialog box, choose
‘Current Scene’ from the
‘Search In’ menu.

Choose ‘Symbol’ from the
‘For’ menu.

Choose ‘Box’ from the
‘Name’ menu. This command
will locate all instances of the
box symbol.

Choose ‘circle’ from the
‘Replace With’ menu.

Click Replace All.

Erase Your Mistakes
You have filled up your
stage with what you

thought was creative.
Unfortunately, the layout is
all wrong, the custom
scrollbar is the worst ever,
and the text seems to 
have been written by a 
three-year-old. It’s clean 
up time!

To erase everything on
the Stage, double-click the
‘Eraser’ tool in the toolbar.
Problem solved! Note,
however, that this works
only one frame at a time. 

When the playhead is at
frame 10, you can erase
everything on the Stage at
frame 10, but nothing else. 

To erase other frames,
you have to move the
playhead to those frames
manually before you can go
ahead with erasing.

Lower File Sizes
When you are using a
lot of bitmap images 

in a Flash movie, file size
can add up fast. You can use
the ‘Publish’ settings to 
set the JPEG quality for 
the entire movie, but that
can lead to inconsistency.
One image may look great,
while another, grainy 
and smudgy.

To customise the
‘Publish’ settings for
individual bitmap images,
right-click on the image’s
name in the Library and

choose ‘Properties’. In the
‘Bitmap Properties’ dialog
box, deselect ‘Use document
default quality’ and change
the number in the ‘Quality’
field. A higher number yields
higher-quality images 
with a larger file size, and 
vice-versa. 

Once you hae set the
number, click ‘Test’. The
dialog box reports the
starting file size and the
new file size for the image.
Typically, setting the quality
to 50 can make a 700 KB
image publish at less 
than 20 KB. 

You can also use the
mouse to drag the image
around in the preview pane
of the dialog box to see how it
would look. If it’s grainy,
increase the number in the
‘Quality’ field. 

Flash Text And Search
Engines

When you create text
in Flash MX 2004, you

need to remember that
unlike HTML, Flash MX 2004
text will not be picked up by
search engine bots. So, you
need to add Meta Tags to the
HTML document that the
SWF file will reside in. 

Static Text And Device
Fonts

Static text is display text
that doesn’t change

onscreen, such as the
information displayed in an
interface, or for button labels,
forms, and navigation. 

When you add static text
to your movie, by default,
Flash MX 2004 will embed
the font outlines in the SWF
file for the font you are
using. Depending on the
font you choose, and how
much text you use, this can
add considerably to the
overall file size. 

If you want smaller file
sizes, use a device font. A
device font is a font that
won’t be embedded in the
SWF file. Instead, you choose
a device font for the end
users’ machines to display-
_serif, _sans, or _typewriter-
and the end users’ machines
will display that device font
for the Static text. 

This will help keep your
file size small.

Macromedia Flash
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Small Type And Alias Text
When working with
small type (10 points or

smaller), the text might
become difficult to read
because of the anti-aliasing
that is automatically applied
to vector shapes in Flash MX
2004. Anti-aliasing is a
blurring, or ‘smoothening’, of
the edges of vector shapes
and text. Often, anti-aliasing
adds to the quality of the
shape, but small text may
become unreadable.

In Flash MX 2004,
Macromedia has added a new
‘Alias Text’ button that allows
you to alias blocks of type,
thereby increasing readability.

The alias text feature can
be applied to Static,
Dynamic, and Input text
fields. However, if a visitor to
your Web site does not have
version 7 (or higher) of the
Flash plug-in, they will only
see aliased Static text. If you
are using any Dynamic or
Input text fields with the
Alias text feature, viewers
with older versions of the
Flash plug-in will still see
that text as anti-aliased.

Improve Bitmap Quality 
To improve the image
quality of bitmaps

before and after importing
them to Flash:

Don’t scale imported
bitmaps within Flash. This
greatly reduces image quality.
Instead, use an external image
editor such as Macromedia
Fireworks to scale the image to
the desired pixel dimensions
before import.

After importing an image
into Flash, break it apart and
convert it to a graphic symbol.
To do this, first, select the
image and go to Modify>Break
Apart. Now, with the image
still selected, go to
Insert>Convert to Symbol, and
select the ‘Graphic’ option for
the behaviour. 

In the HTML tab of the
Publish Settings (File>Publish
Settings>HTML) set the
‘Quality’ to ‘Best’. Disable the
‘Allow Smoothing’ option for
the bitmap. In the ‘Library’
window, right-click on the
bitmap and select ‘Properties’.
Uncheck ‘Allow Smoothing’ in
the ‘Properties’ dialog and
click ‘OK’.

Use lossless compression
for the bitmap. In the
‘Library’ window, right-click
on the bitmap and select
‘Properties’. Choose ‘Lossless’
from the ‘Compression’ pop-
up menu and click ‘OK’. This
will cause Flash to render the
image at the original
imported quality, but will
probably cause the .SWF file
size to increase considerably.

_root.goto!
Here’s the code for a
button placed inside a

movie clip, which will give
the instruction ‘Go to and
play’ a certain frame in the
root movie, and not the clip
the button resides in.
_root.gotoAndPlay(frame);
eg:
on (release) {
_root.gotoAndStop(10);
}

Disable The Hand Cursor
Create your button as
you normally would.

Give your button an
instance name like “digit” in
the ‘Properties’ panel.

In the timeline, click on
the first frame your button is
placed on and open the
Actions panel ([F9])

Enter this ActionScript:
digit.useHandCursor =

false;

Disable A Button 
Create a button
normally. Name the

button in the ‘Properties’
panel, say, “digit”. Left-click
on the button to select it, and
open the Actions panel ([F9]) 

Enter this ActionScript:
on (release) {
digit.enabled = false;
}
If you want to enable the

button later, change “false” to
“true”.

Here Comes The Easter
Bunny!

Here’s how you can see
an Easter Egg in Flash

MX 2004:
Go to “Help/About Flash

Professional...”, and click on
the tiny “TM” symbol near
the number 2004. Enjoy! 

Matching The Size Of 
The Object

To fit the
background/stage to the

selected object, place the
object on the top left hand
corner of the stage. Now, go
to Modify>Document
Properties>Match>Contents.
Remember, this will work
only if the object is placed on
the top left hand corner of
the stage. 

Customising commands
Flash 2004 Professional
has a History panel

(Window>Other
panels>History), which
documents the history of
your previous actions. To save
particular actions as a new

command, select the desired
action, right-click on the
action and choose ‘Save As
Command’. You can also
name the new command and
view it in the Commands
menu. These new commands
can be repeated, as and when
required. Commands can
directly be accessed from the
Command menu as well. 

Indent Text Without 
Using Blockquotes

Thus far, there have been
two methods used to

indent text-using the
<BLOCKQUOTE> tag or by
placing text in the second cell
of a two-column table. Using
cascading-style sheets, you now
have a better alternative: 

Cascading style sheets
allow you to specify the exact
indentation for your text. For
example, to indent all text
using the <P> tag, choose Text>
Custom Style>Edit Style Sheet.
In the dialog box that pops up,
choose ‘New’. Now, select
‘Redefine HTML Tag’, choose
‘P’ from the list and click ‘OK’. 

In the ‘Style Definition’
dialog box, choose ‘Box’ and
enter the desired indent span
(in pixels) in the left text field
of the ‘Margin’ section. Finally,
click ‘OK’ and then ‘Done’ to
return to your HTML
document. As you will see, any
text wrapped in the paragraph
tag (<p>) is set to an indent.
The definition of the new
Paragraph style will look like: 

<STYLE TYPE=”TEXT/CSS”> 
<!-- 
p { margin-left: 25px} 
--> 
</STYLE> 

Clean Up Word HTML
Documents 

Microsoft Word can save
documents in HTML

format. However, the HTML,
XML, and CSS (Cascading Style
Sheets) code that Word
generates is geared more to
format and display documents
in Word than in a Web
browser. Because of its
complexity, it’s a good idea to
clean up Word-generated
HTML code. 

Fortunately, Dreamweaver
can instantly remove the
unnecessary Word-generated

Dreamweaver MX
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Jayesh Limaye

Until about a few months ago,
backing up your data and

carrying it around was a breeze
thanks to the availability of sites
like X-drive and SwapDrive.
Unfortunately, they went the
commercial way leaving many a
user in the lurch. Enter GMail, with
its 1000 MB storage in every
mailbox. Apart from being a
mailbox, this also re-opened doors
for those interested in storing and
backing up their data online.

As changes abound in the
service, several new tools are also
being launched to work with the
service. GMail Drive is one such tool
that allows you to easily backup and
store data in your GMail account.

Downloading And
Installing GMail Drive
GMail Drive is a Shell

Namespace Extension that creates a
virtual file system around your
GMail account so that you can use
it as a storage medium. To
download it, go to www. viskoe.dk.
In the description on the
homepage, find the ‘projects’ link.
This will open a list of the projects
including ‘GMail Drive’. Download
the utility (approx. 120 KB), extract
the contents from the .zip file, and
run setup.exe to install the
program.

Setting Up GMail Drive
After installing the
program, a new drive,

‘GMail Drive’, will appear in

Windows Explorer. You can access
this with your GMail login and
password. You can also tick the
‘Auto Login’ box so that you are not
prompted for your password each
time. Once this is done, you can
access the drive like any other on
your computer. 

Ticking the ‘Auto Login’ box is
useful if you plan to perform
automated backups on your GMail
Drive. The drive can be operated like
any other, and you can also perform
all the functions you perform with
other drives, including copying,
pasting and deleting files, as well as
searching. You can also use ‘Send To’
in the context menu to send these
files to this drive.

How It Works
What actually takes place when you
copy and paste files to the GMail
Drive is, they are e-mailed to your
GMail account as attachments.
GMail Drive periodically checks your
account for new files and rebuilds
the directory structure. If you log on
to your GMail account after pasting
files in to your GMail Drive, you will
see some mails sent from your
GMail ID with the subject starting
with ‘GMAILFS’. These are the files
you copied to your GMail Drive
being sent as attachments.

Creating Filters In GMail
As you back up more and
more files, it can get tough

to find the right file in a long list of
e-mails. To make it easier, you could

apply filters to your account and
ensure that all backed-up files are
automatically moved to a particular
folder. To start with, you could
move them all to the ‘Archived Mail’
folder. To set up filters in your e-
mail account, you need to log in
and click on the ‘Create a filter’
option. On the ensuing page, there
will be various options and choices
of filtering your mails. Choose the
‘Have the words’ option and type
‘GMAILFS’ in the box next to it. 

On the next page, tick the ‘Skip
the Inbox (Archive it)’ checkbox and
finally on ‘Create a Filter’.

Enter your GMail ID and password to access
GMail Drive

Create a filter in GMail to avoid your Inbox
getting cluttered due to GMail Drive

GMail Drive can also be scheduled to
perform auto-backups using

software such as ‘SyncBack’. This is a
free backup utility. When using
SyncBack, you are prompted to create a
profile, click on ‘Yes’, select ‘Backup’
and enter a name for the profile. 

To schedule the backup of a
particular folder, provide the path in
the ‘Source’ dialog box and your GMail
Drive address in the ‘Destination’ dialog
box. Now just click on the ‘Expert’
button and click on the ‘Misc’ tab. On 

this page, you can schedule the backup
to run at a specified time or at regular
intervals based on your requirements.

Automating Backups

Use a backup utility such as SyncBack to
take automated backups to your GMail drive

It’s A Mailbox, It’s A Back-Up Drive, It’s GMail!

GMail gives you 1000 MB of storage space. Here’s how to make the most of it



82

Digital Tools l Tips & Tricks

HTML code. To do so, launch
Dreamweaver and choose
File>Import>Import Word
HTML. In the dialog box that
pops up, select the Word-
generated file and click ‘OK’. 

Now, you can customise
the clean-up process by
selecting options from a series
of checkboxes that
Dreamweaver displays in the
‘Clean Up Word HTML’ dialog
box. After you have selected
the parameters to cleanse,
click ‘OK’. 

Dreamweaver will clean
the document of excess code.
It also generates an ‘HTML
Corrections’ log of its clean-up
actions. The preferences you
entered are automatically
saved as the default ‘Clean Up
Word HTML’ settings.

Using The Tag Inspector
As you work in
Dreamweaver MX, you

will notice that a list of tags
appear at the bottom of the
window. These tags represent
the tree location of where your
cursor is in the document. For
instance, the ‘Tag’ inspector
might display: <body><p>. This
shows you where you are, and
what code is being generated
behind the scenes. 

You can select each tag by
clicking on it. By right-clicking
on the tag you can edit it in
the ‘Quick Tag Editor’, apply
styles to that specific tag
instance, or remove it
altogether. You can also
modify tag

attributes in the Tag Inspector
panel (Window>Tag Inspector)
as shown in the screenshot.

In the screenshot, you can
see from the tag that the
cursor is in a <tr> tag set
within a <table> tag set within
a <td> tag set nested within
another <tr> tag set within
another <table> tag set in the
document <body> tag set.
From there you can select any
of the parents of the tag set. 

By right-clicking the <tr>
tag, you can add 
a CSS style
to the

parent tag of the <td> tag
where the cursor is. If you have
a complex table and are
having trouble figuring out
what the structure of the table
is, this tool is indispensable.

Set Multiple Panels In
Dreamweaver MX2004

Many developers find it
easier to set up a

workspace with all the
panels in one specific
location. Some of us just
can’t get used to this.
Sometimes the ‘Floating
Panels’ can be in the way of
what you are trying to view. 

By setting your preferences
according to your needs and
learning a handy keyboard
shortcut, you can improve you
workflow tremendously.

You can toggle Panels on
and off by pressing [F4] or
Edit>View Panels to view
hidden panels, and Edit>Hide
Panels to hide currently
displayed panels.

You can also set ‘Panel
Viewing Preferences’. This is
where you determine how the
Panel and Property Inspector
will be displayed. 

Panels which are checked
off will always appear in
front of the ‘Document and
Site’ windows. If a panel is
not checked off, it may be
obscurred. In the lower half
of the dialog box, you can
choose which panels appear
in the ‘Launcher’ option.

Reload Additional
Extensions Without
Rebooting Dreamweaver

Myth: When you install a
new ‘Object Extension’,

you need to restart
Dreamweaver. 

Fact: You can reload object
extensions while Dreamweaver
is open. This simple trick can
save a lot of time, especially if
you develop your own
extensions. With the ‘Objects
Panel’ open, click on the arrow
in the upper right of the
panel. The contextual menu
will appear with a new option
called ‘Reload Extensions’.
Clicking on ‘Reload
Extensions’ will usually bring
up a timer icon. Once the
timer disappears, your new
object is ready for use.

Rounding Corners Using
Simple CSS

You can shave off those
sharp table edges with a

little bit of CSS. However, the
code is proprietary for Mozilla
and Netscape 6.x and higher-IE
will still display normal, sharp
tables. You can use
Dreamweaver’s ‘CSS Editor’ for
everything but the snippet of
code that does the rounding. 

Create a new style using
the ‘Redefine HTML Tag’
option, and select ‘Table’ from
the list of tags. Proceed as
usual to the ‘CSS Style
Definition’ dialog. 

Here, you can choose a
background colour, a border
size, and a colour for the table.
When satisfied, click ‘OK’.
Here’s the line of code you
need to enter manually at the
end of the table style rule you
just defined: -moz-border-
radius: 12px;

Don’t forget to add that
starting dash, or the code
won’t work! In design view,
you won’t see anything
unusual. It’s not until you look
at the page in a supporting
browser that you’ll see the
rounded corners. 

Convert Layers 
Into Tables

The positioning of
elements on a page is

easier using layers than tables.
But it is better to use tables to
allow older browsers to view
these pages correctly. You
don’t need to start working

DIGIT FEBRUARY 2005
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with tables from scratch. You
can create your page normally,
by using layers and then
convert them to tables later. 

Create your page and click
on Modify>Layout Mode>
Convert Layers to Table. Select
the appropriate layout options
and click ‘OK’. 

You could also click on
File>Convert>3.0 Browser
Compatible to achieve the
same result.

Switch To External 
Image Editor?

If your images are nested
deep within your site,

finding and editing them can
be quite frustrating. 

Instead, open the image in
Dreamweaver. Click on
Edit>Preferences>External
Editors. Select the file
extension you need to edit and
add the editor for it by clicking
on the ‘+’ button. The next
time you edit an image of that
file extension, it is
automatically opened within
the specified editor and is
updated within Dreamweaver
once all the changes are made.

Assigning Heading Styles
To Subheads

The ‘Document Map’ is a
useful tool for navigating

within large documents. To
create the Map, Word needs to
recognise which the headings
in your document are; the
Document Map is, therefore,
more helpful if you use subject
headings to organise your 
long document. 

If you assign a heading
style to your subheads, Word
can recognise that text as
headings and create a logical
Document Map. For instance,
you might assign the ‘Heading
1’ style to your document’s
headline or chapter titles, the
‘Heading 2’ to first-level sub-
heads, ‘Heading 3’ to second-
level subheads and so on. 

To assign a style, click
anywhere inside your heading
and choose Format>Styles and
Formatting. Word will display
the ‘Styles and Formatting’
task pane. Now, just click one
of the heading styles in the
‘Pick Formatting To Apply’
window. Once you’ve applied
styles to the subheads in your

document, Word can generate
a useful Document Map.

Using The Document Map
The document map
makes documents act

like Web sites formatted with
frames. The left side of your
screen turns into a navigation
tool you can use to quickly
jump to something in the
right side of the screen. 

To display the Document
Map, choose View>Document
Map. Word will open a new
window on the left side of
the screen. 

This window displays your
document’s headings (or other
text that Word interprets to be
headings, if you haven’t
assigned styles). Click any of
those headings, and Word
takes you to that location in
your document. To expand or
contract subheads, click the
plus or minus boxes in the
document map.

Customising Bullets
If you are tired of the
same, boring bullets in

your bulleted lists, it’s simple
to customise the bullets you
use in Word. After creating
your list of items, select
Format>Bullets and
Numbering. Click the ‘Bullet’
tab in the dialog. The dialog
box contains several bullets to
choose from. Click the bullet
you want to use, then click OK
to lock in your change. If none
of these selections appeal to
you, you can change the
character that makes up any
bullet set. 

Select any of the bullet
choices, then click
‘Customise’. In the ‘Customise
Bulleted List’ dialog, you can
pick a character from any
font on your system. Click the
‘Bullet’ button, select a new
character to use as a bullet
using the ‘Character’ button,
then click ‘OK’ to make 
the change. 

The default font
from where the
characters is either
Symbol or
Wingdings. 

To pick
characters from
another font set,
click the ‘Font’
button. After
selecting the source,
click ‘Character’
again, make your
selection, and just
click ‘OK’.

Making Pictures In Word
Behave Properly

When you insert a
picture into Word, you

get a picture that flows in
line with the text. Word
treats in-line pictures the
same way it treats big
characters. 

If you type in front of an
in-line picture, it will get
pushed out on the same line,
as if it were text. If you centre
the line that includes an in-
line picture, the image will
appear centred on that line.

If you don’t want your
picture to act like a character,
and want text to flow around
the image, the simplest way to
tell Word to flow text around a
picture is to make it float. 

When a picture floats,
Word removes it from the text
on the page and places it in an
imaginary plane, commonly
called the ‘drawing layer’,
above or below the text.

To make a picture float,
right-click it and choose
‘Format Picture’. On the
‘Layout’ tab, select either
‘Square’ or ‘Tight’ under
‘Wrapping Style’ and click
‘OK’. Word will stick the
picture in the drawing layer
and wrap text around it. 

Now when you move the
picture in the drawing layer,
Word will reflow the text,
making way for the picture.
You may also want to
experiment with the
‘horizontal alignment’ and
see what works best for you.

Turning Off Automatic
Hyperlinking

When there’s a URL or e-
mail address in your

document, Word turns it into
a hyperlink. To turn off the
automatic hyperlinking,
choose ‘AutoCorrect Options’
(or ‘AutoCorrect’) from the
‘Tools’ menu, then click on
the ‘AutoFormat As You Type’
tab. Under ‘Replace As You
Type’, clear the ‘Internet and
network paths with
hyperlink’ checkbox.

If you didn’t turn off
AutoCorrect before you started
typing, and now you have a
document full of hyperlinks
that you don’t want, you can
turn them all off. Choose
Select All from the Edit menu
or press [Ctrl]+[A], and press

Use the ‘Document Map’ to navigate within
large documents

Microsoft Word
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Jayesh Limaye

When an application finds
that the amount of physical
RAM on a computer is not

enough for it to run, it uses hard
disk space to compensate for the
deficit in the amount of RAM
needed by it. Windows XP allocates
some amount of space for this by
creating a page file named
pagefile.sys, which is a hidden and
system file on the system drive (the
drive where Windows is installed).
The page file is set by default to a
minimum of 1.5 times and a
maximum of twice the amount of
physical RAM. This way, even on a
machine with 128 MB of physical
RAM, an application may utilise 4
GB of memory using the page file.
Since the page file 
is present on the hard disk, it is, 
of course, much slower than
physical RAM.

Optimising Sysytem
Performance
Virtual memory has to cater

to programs as well as the system
cache. Hence, system performance
can be improved by setting the
virtual memory to allocate more
memory for programs and less to

system cache if you are using your
machine as a workstation, and vice-
versa if you are using your machine
as a server. 

Usually, the page file size is set
to give you the best performance,
but you may improve performance
by altering some of its settings. Set
the page file to reside on a drive
other than the one where Windows
is installed, and to a drive where
files are least accessed. 

Before doing this, though, it is
advisable to defragment that drive.
Also, if possible, this drive should be
on another hard drive, preferably on
a different controller. Keep in mind
that this drive should not be on
fault-tolerant systems like a RAID-7
configuration or on a mirrored
drive, as this will reduce
performance (also, the page file
does not require fault tolerance).
You may set both the minimum and
the maximum size of the page file
to twice the amount of RAM that
you have installed. Keeping the page
file size fixed will greatly improve
system performance because the
page file size will not have to be
dynamically adjusted and hence it
will not get fragmented. We shall
see how this is implemented in
detail in the following steps:

Placing The Page File
Efficiently 

Defragmenting The Drive
As data is written to and read from
a drive, it gets scattered over the
drive over a period of time. A drive
in this state is said to be
fragmented and becomes slower to
access. The ‘Disk Defragmenter’ is a
utility which defragments or
compacts all the scattered data to
the beginning of the drive so that it
becomes faster to access. After you
choose the drive on which you wish
to place your page file, you need 
to defragment it. 

Click Start>All
Programs>Accessories>System
Tools>Disk Defragmenter to launch
the utility. In the list shown, click on
the selected drive. Click on ‘Action’
and then ‘Defragment’. 

This will start the
defragmentation process.

Accessing Virtual Memory
Settings
Open the Control Panel by

clicking Start>Control Panel. Double
click on the ‘System’ icon if your
control panel has the classic view. If
it has the category view, click on
‘Performance and Maintenance’ and

then on the
‘System’ icon.
Now click on
the ‘Advanced’
tab. Click on
‘Settings’ 
in the
‘Performance’
section. 

Next,
choose the
‘Advanced’ tab.
Select the drive
where the page
file is currently

present, select ‘No Paging File’ and
click on ‘Set’. 

Now select the drive where you
wish to place your page file, and

select ‘Custom
size’. Enter a
number that is
twice the size
of your
installed RAM
in the initial as
well as maxi-
mum size dia-
log boxes and
click on ‘Set’.
Now click OK
thrice and
restart the

computer for the settings to 
take effect. 

Final Words 
Since no two computers
behave the same, you need to

experiment
with the virtual
memory
settings to try
and find what
works best 
for you. Your PC
will be the
fastest in the
neighbour-
hood in no time. 

jayesh_limaye@
thinkdigit.com

Managing The Swap File In Windows XP
Boost system performance by choosing the optimal settings for the swap file

As against a page file, virtual memory
is the sum of physical RAM and the

size of the page file. Hence, while you can
disable the swap file, you can never
completely disable virtual memory.

Virtual Memory

‘Advanced’ settings in the
‘Performance’ menu

In ‘Virtual Memory’, set
the page file size

The ‘Advanced’ tab in
‘System Properties’

Use the Disk Defragmenter to compact scat-
tered data to the beginning of the hard disk
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[Ctrl]+[6] to remove all the
existing hyperlinks

Creating Your Own
Toolbars

To create your own
toolbar, choose

‘Toolbars’ from the ‘View’
menu, and select ‘Customise’.
Click on the ‘Toolbars’ tab,
then on the ‘New’ button.
Give the toolbar a name. 

Here, you also need to
select whether this toolbar
will be available to all
documents (the ‘Normal’
template), or only to the
current document. Now, a
small toolbar palette will
appear on the screen. Click
on the ‘Commands’ tab,
select a category, then drag
the commands you want onto
your new toolbar.

Comparing Documents
Word 2003 makes
comparing two

documents easier with its
‘Compare Side by Side’
feature. Open the two
document versions you want
to compare and select
Window> Compare Side by
Side. Word makes each
document fit in one half of
the screen. When you scroll
through one document, the
other scrolls with it, making
it possible to browse through
the two documents
simultaneously.

Tracking With Versions
To keep track of a
document as you work

on it, next time you save a
document, don’t just use
File>Save. Instead, select
File>Versions. In the
‘Versions’ dialog box, click
the ‘Save Now’ button. In the
dialog box that appears next,
enter any comments that
help identify the document
in progress. Click ‘OK’, type in
the document name, and
click ‘Save’. 

Now, the next time you
reach an important
milestone, say, just before
sending the document out for
review, click File>Versions,
enter your comments and
click ‘OK’. 

A new version will be
stored inside the document
file and listed in the
‘Versions’ dialog box. 

To review an earlier saved
version, open the document
file, click File> Versions,
select the version you want in
the ‘Versions’ window, and
click ‘Open’.

‘Permanentise’ A
Frequently-used File

Office displays the most
recently accessed files

under the ‘File’ menu for
quick access. But did you
know that you can assign
files to be permanently
accessed directly from the
menu? Select
Tools>Customise, and click
the ‘Commands’ tab in the
Customise dialog box. Scroll
through the ‘Categories’ list,
select the ‘Built-in Menus’
item, then scroll down to the
bottom of the ‘Commands’
window and select the ‘Work’
item. Drag the ‘Work’ item
into the toolbar area. A new
‘Work’ menu item will
appear. Click ‘OK’ in the
dialog box. Now add a file to
your new ‘Work’ menu. 

First go to File>Open to
open the file you want. Once
it is open, choose Work>Add
To Work Menu. The open
file’s name now appears in
the drop-down list when you
click ‘Work’. 

The next time you need to
work on or access this
particular file, just open the
Work menu and click on the
file name.

Password Protection
Using Templates

Protect documents by
password-protecting the

Word and Excel templates you
use to create them. That way,
every new document or
spreadsheet you open that’s
based on these templates 
will also be protected by 
the password. 

To create a password-
protected template in Word
or Excel, open a new
document, click File>Save As,
and choose ‘Document
Template’ (just Template in
Excel) in the ‘Save As Type’
dialog box near the bottom
(‘Files of Type’ in Word 97 
or 2000). 

Type a name for your new
template, and click ‘OK’. To
set a password in the 97 and
2000 editions of Word and
Excel, click Tools>Options>
Save; in XP and 2003 versions,
click Tools>Options>Security
(see figure 4). Enter a password
to open the file (and if you
like, enter another password
to modify it); then click ‘OK’. 

The next time you want
to make a new password-
protected document or
spreadsheet, click File>Open
and choose your protected
template. The new document
will inherit the template’s
password. If you want to
change the password of the
document in Word 97 or
2000, click Tools>Options>

Save and change the entry in
the password boxes. In Word
XP or 2003, click Tools>
Options>Security to access
your password settings.

Hiding And Unhiding
Rows And Columns

To hide a row(s), select a
cell(s) and press [Ctrl] +

[9]. To unhide a row(s), select
the cells containing the range
of the hidden row(s) and press
[Ctrl] + [Shift] + [(].

To hide a column(s), select
a cell(s) and press [Ctrl] + [0].
To unhide a column(s), select
the cells containing the range
of the hidden column(s) and
press [Ctrl] + [Shift] + [)].

To unhide rows and
columns in a sheet, click
‘Select All’ at the top-left
intersection of the rows and
columns. Then press [Ctrl] +
[Shift] + [(] and then [Ctrl] +
[Shift] + [)].

Adding A Menu Item To
The Excel Menu Bar

Right-click one of the
toolbars, and then select

‘Customise’ from the shortcut
menu. In the ‘Commands’
tab, select ‘File’ from the
‘Category’. From the
‘Commands’, drag the ‘Page
Setup’ icon (or any other icon
you want) onto the menu bar. 

To remove the icon at any
time, repeat the above steps
and drag the icon back.

Increasing The Recently
Accessed Files List

For this simple addition,
go to Tools>Options, and

select the ‘General’ tab. In the
‘Recently Used File List’ box,
change the number to the
maximum, 9, and click ‘OK’.

Grouping Sheets 
Grouping sheets has the
following advantages:

It allows setting the print
options for a number of
sheets at once.

Allows changing an item
from the View tab in the
Options dialog box.

Allows applying formats to
many sheets.

Allows unhiding of rows
and/or columns
simultaneously.

Allows typing/inserting

Microsoft Excel
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text or formulas for the same
address in grouped sheets.

To group all sheets in the
workbook, select the first
sheet in the workbook, hold
[Shift], and click the last
sheet tab in the workbook.
Alternatively, from a sheet
tab shortcut menu, select
‘Select All Sheets’.

To group continuous
sheets, hold [Shift] and click a
different sheet tab.

To group non-continuous
sheets, hold [Ctrl], click a
different sheet tab and add it
to the group.

To ungroup sheets, hold
[Shift] and click the active
sheet tab.

Reducing The Size Of A
Workbook

For sending a Workbook
by e-mail, you might

want to reduce its size first.
Press [Ctrl] + [End] to find the
last cell in the used area
within the sheet. Find the
last cell containing data in
the sheet. Delete all rows
between the cells containing
data to the row of the last
cell in the used area. Delete
all columns to the right of
the column of the last cell
containing data, up to the
column of the last cell in the
area used. 

To quickly delete the
rows, select the first row to
delete, press [Ctrl] + [Shift] +
[Down Arrow]. To quickly
delete the columns, select
the first column to delete,
and press [Ctrl] + [Shift] +
[Right Arrow], press [Shift] +
[F10], and from the menu,
press ‘Delete’. Repeat these
steps for each sheet in the
workbook. Now save your file.

Replacing Zeroes With
Dashes

Press [Ctrl] + [1] to open
the ‘Format Cells’ dialog

box. Select the ‘Number’ tab,
and from ‘Category’, select
‘Custom’. In the ‘Type’ box,
enter the following Custom
Formatting syntax exactly as
printed here:
#,##0 ;[Red](#,##0);- ;

Selecting Cells That
Contain Only Text

By selecting cells that
only contain text, you

can distinguish between cells

containing different types of
data, which allows you to
delete, fill or lock cells by
type. Press F5, or go to
Edit>Go To. In the ‘Go To’
dialog box, click ‘Special’, and
in the ‘Go To Special’ dialog
box, select ‘Constants’ and
click ‘OK’.

Counting The Number Of
Words In A Cell

Enter the following text
in cell A1: “Digit is a

great magazine”.
Now, in cell A2, enter the
following function:
=IF(LEN(A1)=0,0,LEN(TRIM(A1))
-LEN(SUBSTITUTE(TRIM(A1),”
“,””))+1)
The result will be 5.

Rounding Numbers To
Thousands

Press [Ctrl] + [1] to open
the ‘Format Cells’ dialog

box. Select the ‘Number’ tab,
and from ‘Category’, select

‘Custom’. In the ‘Type’ box,
enter the following ‘Custom
Formatting’ syntax exactly as
printed here: 
#,##0, ;[Red](#,##0,);- ;

Now, If your cell contains
the number 2345678 it will
be displayed as ‘2,346’.

Copying Styles From One
Workbook To Another

To use your saved styles
in a different workbook,

you can use the ‘Merge’
option. First, open the new
workbook. From the ‘Format’
menu, select ‘Style’. Click
‘Merge’. Now in the ‘Merge
Styles’ dialog box, select the
workbook where the styles to
be merge are saved and click
‘OK’. Finally, in the ‘Style’
dialog box, click ‘OK’.

Conditional Formatting
It’s easy to overlook
important data in a very

large spreadsheet. You can
use the ‘Conditional
Formatting’ feature to
make critical data jump
off the screen. 

Let’s say you’re
tracking household
expenses, and want to
keep an eye out for
anything that cost more
than Rs 10,000. Select
the column in your
spreadsheet with the
currency amount, and
select Format>
Conditional Formatting.

In the resulting dialog box,
make sure the ‘Condition 1’
drop-down list control is set
to ‘Cell Value Is’. Then, set the
second drop-down list box to
‘greater than or equal to’.
Finally, enter the number
10000 in the box on the right. 

Click the ‘Format’ button
to open a dialog box where
you can set the Font, Border
and Patterns. Click ‘OK’ twice.

Repeating Column
Headings In Printouts

Excel users frequently
need to set up multi-

page printouts that repeat
the same column headings
on each page. If the headings
you want to print are also the
column headings in the first
few rows of your spreadsheet,
it’s easy to get them to show
up on each printed page.

First, make sure that at
least one row in your
spreadsheet contains the
headings you want to see on
the printout. Then go to File>
Page Setup>Sheet, and click
the ‘Collapse Dialog’ icon on
the right side of the box
marked ‘Rows to repeat at
top’. Back in your spread-
sheet, you’ll see that your
pointer has become a right-
pointing arrow. 

Click and drag that arrow
over the rows containing the
text that you want to appear
as headings on the printout.
After you make your
selection, click the ‘Expand
Dialog’ icon located on the
right of the collapsed dialog
box. Click ‘Print Preview’ to
make sure that your headings
look right. If everything
appears to be in order, print!

Prevent A Chart From
Being Printed

There are often times
when you do not want

a chart to be printed. Select
the chart, and right-click on
it. From the menu, select
‘Format Chart Area’. Select
the ‘Properties’ tab, and
clear the checkbox beside
‘Print Object’. Click OK 
to finish.

The Current Date In A Cell
To automatically
insert the current date

into a cell, select the cell
and press [Ctrl] + [;].  

Use a custom formula to round off 
numbers to thousands
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Digital photography has evolved
enough to be present at our
beck and call. With digital

cameras (whether as standalone
devices or as part of another device)
are practically with everyone. While
this has given birth to some enthusi-
asts, most of those who are migrating
to digicams are amateur or hobby
photographers who are dumping the
film camera.

So naturally, this brings with 
it plenty of questions such as “What
is a megapixel?,” “What is 
White Balance?”, “What type of card
works with my camera?” or even
“Which camera should I buy?”
Answers to these and many more
questions on digital cameras are
answered in painstaking detail at
www.dpreview.com.

Started in 1998 in the early days
of digital photography and still run
by London-based photo-enthusiast
and Web designer Phil Askey, the site
has come a long way and has consis-
tently been recognised for the qual-
ity of its reviews. 

Welcome Home
One look at the site and you know
where everything is. It's like coming
home! The site is a veritable ency-
clopaedia on digital cameras. Simply
find your way to the right links and you
can read up on almost all the cameras
to have ever hit the shelves. The site
also offers a timeline from 1995. 

Although a hard claim to digest,
they have about 90 per cent of the
cameras to have ever left the manu-
facturing line listed on the site,
complete with specs and even prices!

The timeline, in fact, is one of the most
interesting sections on the site and
lets you compare the changes in specs
and prices over the last 10 years—and
you realise that while prices have stag-
nated, features and capabilities have
improved dramatically. 

The site is not the only one
around to offer side-by-side compar-
isons of cameras, but is perhaps the
best of the lot. Unfortunately, you
can only compare two cameras at a
time. So if you were considering a
third camera as a potential buy, elim-
ination of candidates is the way to go!

Newsworthy
With new digital cameras becoming
available almost daily, it can be quite
a task to search for the best avail-
able. DPR opens with the news page
and offers up-to-the-minute news
that is continuously updated.
Reviews of cameras “in-production”
are also a regular feature, and can be
handy to keep you abreast of devel-
opments when considering a buy.  

A typical review on the site
includes an introduction to a camera,
its design aspects, specifications,
features, tests and comparisons.
Photo galleries created using older
cameras are also available, and can
be used as a benchmark when
making a buying decision. Images
accompanying the reviews are not
just good—they’re great! The sample
photos and test images are accurate
and act as a good guide to the
camera in question. 

DPReview.com
For buying digital cameras, understanding digital photography or just keeping up with the
trends... DPReview.com is the place to go to

The site is also home to many
active forums where users can seek
information and tips from other
users. Forums can also be specific to
camera models and not just pertain-
ing to a manufacturer or technology.

Learning The Ropes
An important facet of digital photog-
raphy is that the technology changes
fast. While 3 megapixel was “in” last
year, 5 megapixel seems to be the
norm this year. What does that mean
to you? How does it affect you? Will
you need to reconfigure your printer?
Will you need different media for
printing to ensure optimum quality?
Will the consumption of ink be more?
Will file sizes increase?

Keeping up with this can be tough
if you don't know where to look for
the information. DPReview.com also
offers the “Learn” and “Glossary”
sections, but are unfortunately the
weakest “links” on the site. Basic
technology information apart, there
isn't much to help the novice under-
stand digital cameras or photography
in general. So, only if you know your
basics and want a second opinion 
on what camera to buy, this is the
right place.  

Under Exposure
It’s been almost 10 years that the site
has been in existence. For as long as
we can remember, it has been looking
and feeling the same. Yes, it maintains
its familiarity, but this is slightly
contradictory to what it caters to—
constant change. The one thing that
does remain consistently good,
though, is that the site remains free.

aditya_kuber@thinkdigit.comThe never-ending drop down menu! 

The DPR homepage has all the necessary links 

The opening page of a camera review



Compaq V2036AP

Compaq’s V2036AP is a neat-looking 14-inch
widescreen laptop. This notebook sports a

black-and-brushed metal finish and weighs just
2.36 kg. Powered by a Pentium M 1.7 GHz Dothan
processor with 256 MB of DDR memory, it can
handle most office and multimedia applications

with ease. The build quality is great,
and the layout of the ports on either
side makes them easily accessible.
Goodies include a combo drive,
802.11b wireless LAN, a 6-in-1 card
reader, a FireWire port and JBL Pro

speakers. The battery life at
150 minutes was average,

and less than similar
models we have tested.

Thankfully, though, it’s a
quiet operator and the battery

doesn’t heat up too much!

Company Hewlett Packard India Ltd 
Price Rs 69,990
Phone 1600 11 4141
E-mail saranya.rustagi@hp.com 
Web site www.hp.com

Rating
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Forget Your Passwords

Someone had to cash in on the growing paranoia about security, and
Microsoft is leading the pack—stepping in with the Fingerprint

Reader. This USB device eliminates the need to type in passwords, and
ships with a software disk and manual with minimal information. 

Setup is simple, with a graphical representation of both hands
shown on screen. Simply click on the finger to register that finger's
print. You can register all your fingers if you like!

Akin to an auto form completer, this thing allows you to register any
password field. Just put your registered finger on the scanner while the
password entry window is selected, and input your username and
password. Useful for logging into Messengers, e-mail accounts and more!

Another neat feature is having shortcuts to Web sites on its one-
touch menu. Just put your registered finger on the scanner, and a small
menu pops up from the system tray with links to your
registered Web sites. It works like a charm, but is
expensively priced at Rs 4,514.

Company Microsoft Corporation India Pvt Ltd
Price Rs 4,514
Phone 011-26294600
E-mail connect@microsoft.com 
Web site www.microsoft.com

Rating:

1 2 3 4 5

Logitech MX-1000 Cordless Mouse

The MX series of mice from Logitech are
revered by the gaming community as the best

piece of hardware a gamer can get his hands on.
Until recently, the MX series boasted of an 800
dpi optical sensor that was precise to the last
millimetre and resulted in accurate tracking of

the mouse pointer on the screen. Now,
with the introduction of the MX-1000,

Logitech is on the verge of triggering
a revolution. Instead of an LED light
source though, the MX-1000 uses a
laser for accuracy—as opposed to
ordinary light, a laser beam is more
coherent and results in minimum
scattering when it hits a surface.
The MX-1000 has eight buttons that
can be programmed to one’s liking

using the simple-to-use ‘Set Point’
application. It uses RF for com-
munication and can be con-

trolled from as far as ten feet
away. Most interestingly, Logitech

has included a rechargeable Li-ion battery, akin
to those in cell-phones. But eventually, at Rs
5,500, the MX-1000 is a piece of luxury.

Company Logitech Electronics India Pvt. Ltd
Price Rs 5,500
Phone 022-26571160
E-mail sales@esourceglobal.com 
Web site www.logitech.com 
Rating

1 2 3 4 5

Microsoft Fingerprint Reader

Business As Usual

It is not often that Nokia releases a phone that resembles an
existing model, at least in terms of design if not on the

whole. At first glance, the Nokia 6670 can easily be mistaken
for a 7610. Nokia has sculpted the 6670 along the lines of
the stylish 7610, though it restrained itself on the keypad
design to advocate this model’s business goals.    

Based on the Series-60 platform, the 6670 has all the
traits of the business series, including tri-band operation,
Bluetooth, a 65K colour screen, a 1-megapixel camera, 8
MB of internal memory—enough to store your business
contacts—and a 64 MB MMC card. This time round,
Nokia has provided the NetFront Web browser as the
built-in option. NetFront supports all major Web
standards and is more accurate in the layout of pages,
thanks to which pages look similar to what they look
like on a desktop. However, considering the small screen size,
its usefulness is questionable.

As far as its core competence—the phone—goes, the device is like any
other Nokia phone—good signal reception and voice quality. However, on
the usability front, the tacky keys do not help much. Being a business
phone, this should be of paramount importance since it is the only mode
of data input. We think the 6670 is a stopgap measure from Nokia to kill
time before it releases the much-awaited 6630.

Company Nokia India Ltd
Price Rs 25,639
Phone 011-26779000
Web site www.nokia.co.in 

Rating

Nokia 6670

1 2 3 4 51 2 3 4 5
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Love’s Labour Lost

This is probably love at first sight. You will fall for this beauty, which
incorporates a still camera, a video camera, a voice recorder, a Web

camera, a movie viewer and MP3 support, the moment you lay your eyes
on the packaging—with the glitzy model holding up the device in all its
shining glory! Your love will grow stronger when you hold it for the first
time. But alas, love is blind. No sooner than you’ve held the device and
had a first close-up look, will you want to look away! Starting with the
design, which is pretty compact for a device that packs in so much, the
Orite will flatter to deceive. It has a small screen that has
to be flipped open, and is roughly as big (or small) as that
of a Nokia 3310! 

The device should come with 16 MB of on-board
memory, but the unit we received had only 4MB on-board
and no flash cards, tying it down to the PC for good. 

To load MP3s onto it, you need to manually go to the
device in ‘My Computer’ and create a directory called
‘MP3’. Hereafter, it’s drag-and-drop. Photos taken with
the “3.2 mp” camera were grainy despite us using the
flash, and even worse with the 8x digital zoom!  Video
at 640 x 480, though, was all right. 

The package includes a carry case, a USB charger,
cable, driver disk and Ulead PhotoStudio, and is priced at
around Rs 9,000. Expensive considering the feature set...

Company Mediatech India
Price Rs 8,750
Phone 022-26361111
E-mail sales@mediatechindia.com
Web site orite.com.tw

Rating

Mini Marvel

One of the sleekest PDA phones in the market, the new
Xda II Mini from O2 runs Microsoft Windows Mobile

2003 PocketPC Phone Second Edition and is a tri-band
GSM/GPRS device. It is sleek and is encased in a silver body
with ribbed black sides and curved corners. 

The layout makes it easy to handle, with the camera
button, volume slider and voice recorder keys on the left,
the MMC/SDIO slot on top, the power button next to the
stylus silo, the IR port on the right and the headphone
jack next to the USB port at the bottom. 

The front facia is neatly laid out as well, with minimal
controls. A square-shaped bank of keys under the screen is
comprised of an enter/action key in the centre surrounded
by a four-way navigation key. This is flanked by symmetri-
cally designed ‘Send’ and ‘End’ keys on top and two applica-
tion buttons assigned to ‘Contacts’ and ‘Calendar’ at the
bottom. The camera, voice recorder, contacts and calendar
buttons can be re-assigned to other applications, depending
on your preferences. The lens and a self-portrait mirror are
at the back. 

With an Intel PXA 272 processor providing 416 MHz of
horsepower, and 64MB of flash ROM and 64MB of RAM
under the hood, the Mini boasts a 2.8-inch TFT LCD touch
screen that can display 64K colours at a resolution of 240 x
320. Connectivity options include Bluetooth and infrared,

with support for additional memory
through the MMC/SDIO slot. A
256 MB SD card is bundled.

Voice clarity on the O2
Xda II Mini is excellent, even
with the speakerphone. The
screen is clear and vibrant,
but you may face issues in
direct sunlight. A neat feature is
the ability to change the orienta-
tion of the screen from portrait to
landscape with just a tap of the
stylus—handy for spreadsheets 
and documents. 

The 1,200 mAh Lithium Polymer bat-
tery should see you through about three
days with standard phone and PDA use.
Overall, good features and the sleek form factor are the
highlights of the package. Poor image quality from the
camera and the high price tag are the potential deterrents.

Company Creative e-biz.com
Price Rs 34,888
Phone 011-51619800
E-mail creative@goldkist.net
Web site www.myxda.com

Rating

FEBRUARY 2005 DIGIT

Krome Intellekt iQ700

It’s a phone! It’s smart! It’s a smartphone!
The Intellekt iQ700 is one of the smallest

devices running Windows Mobile 2003 Second
Edition. Encased in a metallic silver-grey
metal-and-plastic body, the device is a
tad larger and heavier than a
standard candy-bar phone. 

Looking inside, it is powered by
a TI OMAP 730 200 MHz processor
and has 64MB of ROM and 32MB
of RAM, topped off with a 2.2-
inch 176 x 220 pixel TFT screen.

So what can you do with
it? E-mail, MMS, Speed Dial
and Voice Tags are
supported, and you get all
the productivity software
built into Windows Mobile
2003. You can play back
WAV, WMA, AMR, AAC and MP3.
Voice clarity is decent, but the phone
does have a problem in areas with low signal
strength. The speakerphone is good enough
for a small conference room.

As for the operational controls, the five-
way rocket switch on the front panel looks
quite innovative in terms of design, but also
proves to be the phone’s nemesis. 

Company Krome Mobile
Price Rs 27,000
Phone 011-51539890
E-mail nidhiv@e-charge.com.au
Web site www.krome.com.au

Rating

1 2 3 4 5

1 Poor: Has serious drawbacks and needs improvement before it can be used for its target application. 2 Mediocre: Does not live up to expectations, needs improvement 
in many areas. 3 Average: Reasonably competent, but there is nothing spectacular about the product. 4 Good: A good buy, better than most products in its category. 
5 Excellent: A brilliant combination of price, performance and features—far beyond expectations.

Please write to products@thinkdigit.com. The DIgit Test Centre will be delighted to
respond to your queries.

Looking for more information on any of the products featured in New & Notable?

1 2 3 4 5

1 2 3 4 5

O2 Xda II Mini

Orite MV-3115
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AMD Motherboards 
ASUS K8N-E Deluxe

Excellent performance and
great features

Lacks PCI-Express
Contact ASUSTeK Computer Inc
Phone 022-56290785
E-mail info_india@asus.com.tw 
Price Rs 8,736

MSI K8N Neo Platinum (Gold)
Excellent performance and
good features
Lacks PCI-Express
Contact Cyberstar
Phone 0-9323809599
E-mail navin@cyberstarindia.com

Price Rs 8,000

Printers
Canon Pixma iP4000

Good features, excellent 
performance 
None
Contact Canon India 
Phone 011-26806572
E-mail rajeev.singh@canon.co.in  
Price Rs 11,000

HP Deskjet 1100D
Rugged, can take heavy 
loads
Relatively slow
Contact Hewlett Packard India 
Phone 1600-444-999 
E-mail seema.dawar@hp.com 
Price Rs 13,499

Projectors
Acer PD11

High 1600 lumens bright-
ness support 
Big 330-Inch diagonal
image size capability
Picture in Picture mode
Contact Acer India Pvt Ltd 
Phone 080 25219520
E-mail rajesh_aiyar@acer.co.in
Price www.acer.co.in

Sony VPL-ES2
Very easy to set up
Very low running cost of
lamp
Good performance
Contact Sony India Ltd
Phone 022-28313333
E-mail chiragk@sid.in.sony. 

com.sg
Price Rs 79,990

Monitors (17-inch)
BenQ V773

Good screen geometry 
Not a flat-screen monitor 
Contact BenQ India
Phone 022-25705230
E-mail SalesEnquiryIn@

BenQ.com
Price Rs 5,900

Philips 107E5
Acceptable performance for
its cost
Not a flat-screen monitor
Contact Philips India 
Phone 022-56912325
E-mail PCP.India.Info@philips.com 
Price Rs 8,500

Portable Hard Drives
Freecom FDH-2 Pro 80 GB 

Extremely compact and
bundled carry case
Low cost
Contact J S Equipments
Phone 022-23810713
E-mail jse@vsnl.com
Price Rs 19,500

Transcend StoreJet TS0GJ25
60GB

Sturdy build quality
Slow access time
Contact Mediaman Infotech
Phone 022-23828100
E-mail sales@mediaman

group.com 
Price Rs 10,000

Portable Hard Drives
WD-Media Centre 250GB

Very low cost per MB 
Memory card reader slots

Contact Western Digital 

Phone 022-25851085 
E-mail ajay.kapure@wdc.com
Price Rs 17,000

Maxtor OneTouch 250GB 
Hotkey for launching
backup application
Heavy
Contact eSys Distribution
Phone 022-56910348
E-mail yogi@maxtor.com
Price Rs 15,500

Colour Laser Printers
Lexmark C510

Blazingly fast at 24 pages
per minute
Colours come out dark
Contact Lexmark International 

(India) Pvt. Ltd
Phone 022-26057755/45/44 
E-mail sandeepk@lexmark.com
Price Rs 34,499
Web site www.lexmark.com

Samsung CLP500
Good overall speeds
Printing quality not to 
the mark
Contact Samsung Electronics
Phone 011-515-11234 
E-mail farrukh_quazi@

samsungindia.com  
Price Rs 38,999

Intel Motherboards
Gigabyte GA-8I915G Duo

Excellent Performance at an
affordable price 

None
Contact Digi Giga System Ltd.
Phone 022-26526696 
E-mail sales@digigiga.co.in
Price Rs 6,000

Gigabyte GA-8I915G-MF 
Very affordable
Average performer 
Contact Digi Giga System Ltd  
Phone 022-26526696
E-mail sales@digigiga.co.in
Price Rs 5,300

The best products tested so far in different 
hardware and software categoriesThe A-List

February 2005
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CRT Monitors (19-inch)
Philips 109P4

Aperture grille for more 
accurate geometry
Bad implementation of 
the on-screen display for 
changing a setting
Contact Philips India
Phone 022-56912325 
E-mail PCP.India.Info@

philips.com
Price Rs 16,000

Philips 109E5
Maximum resolution of 1920 x
1440
Inexpensive
None
Contact Philips India
Phone 022-56912325 
E-mail PCP.India.Info@philips.com  
Price Rs 17,500

CMV-CT-722A
Inexpensive
Good pixel response time of 
16 ms
Contact Cee Vision Technologies
Phone 022-26733353 
E-mail chemoplastmumbai@

vsnl.net
Price Rs 25,600

Cell Phones 
Sony-Ericsson K700i 

Extensive feature set,
includes camera, MP3, FM
radio etc.
Fast processor
Contact Sony Ericsson
Phone 0124-2560808 
E-mail dhiraj.soni@
sonyericsson.com
Price Rs 18,000

Nokia 6600
Brilliant display screen,
Bluetooth
No FM radio, slow processor
Contact Nokia India
Phone 011-26779000 
E-mail Nokia.ebag@nokia.com  
Price Rs 15,500

Laptops 
MSI MegaBook M510C

Terrific performance, typical
feature set
Slightly tacky keyboard 
Contact Maxtone Electronics
Phone 022-23016468/23075393
E-mail NA
Price Rs 65,000

Wipro CPQ 15 
Perfect balance of perform-
ance, features and price
Mediocre inbuilt speakers
Contact Wipro Limited
Phone 1600-333312 
E-mail littlegenius@wipro.com  
Price Rs 56,990

LCD Monitors (15-inch)
CMV CT-522A

High contrast ratio—500:1
Mediocre inbuilt speakers
Contact Cee Vision Technologies
Phone 022-26733353
E-mail chemoplastmumbai@vsnl.net
Price Rs 17,500

LCD Monitors (17-inch)
Samsung SyncMaster 173P

Great design, superb contrast 
Expensive
Contact Samsung India 
Phone 011-51511234
E-mail marketing@

samsungindia.com
Price Rs 32,000

Laser Multifunction Devices
Samsung SCX-4216F

Fast, feature-rich and priced
sensibly 
Slightly expensive  
Contact Samsung India
Phone 011-51511234
E-mail vikram.negi@

samsungindia.com
Price Rs 34,999

HP LJ-3380
Prints 20 pages per minute,
fastest in its class
None
Contact Hewlett Packard India 
Phone 1600-444-9999
E-mail seema.dawar@hp.com 
Price Rs 46,999

Heavy-duty Multifunction
Devices
Samsung SCX-5315F

Offers good features and good
performance
Expensive 
Contact Samsung India Electronics
Phone 011-51511234
E-mail vikram.negi@
samsungindia.com
Price Rs 64,995

Xerox SCX-M15i
Good performance at a
reasonable price
Bundled software not 
appealing
Contact Xerox Modicorp 
Phone 012-42561930
E-mail kuldeep.malhotra@

ind.xerox.com 
Price Rs 56,599

LG LM50 
Stylish looks and good per-
formance  
Lower battery life 
Contact LG Electronics India
Phone 0120-2560921
E-mail rajeevsaxena@lgezbuy.com
Price Rs 1,29,999

Compaq X1237AP 
Future-proof features, 
executive looks
Battery life marginally lower
than average
Contact Hewlett Packard India 
Phone 1600-444-9999
E-mail seema.dawar@hp.com 
Price Rs 1,44,990
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Ram Mohan Rao

1. Rich Text messages don’t
show up properly
Reason: When you compose a message
in the Rich Text Format—and the default
setting on some versions of Outlook is
‘Rich Text’, what the recepient sees is not
the mail you composed but a blank mail
with an attachment called ‘winmail.dat.’ 
This happens with most receiving 
e-mail clients.

Solution: To fix this, go to Tools>Options
and click the ‘Mail Format’ tab. Change the
‘Compose in this message format’ setting
to ‘HTML’ or to ‘Plain Text,’ whichever 
you prefer.

2. Inbox opens too slowly
Reason: When you have a lot of mails in
your Inbox, Outlook opens rather slowly.

Solution: Use Outlook’s AutoArchive
option to archive old mails. There are
probably several mails in your inbox right
now that don’t need your attention, but
are there just for reference. You can tell
Outlook to archive old messages
automatically. What Outlook does is to put
these mails in another folder, which it
calls archive.pst by default. Go to
Tools>Options and open the ‘Other’ tab.
Here, click ‘AutoArchive’ and you will see
all the options available to you. You can

choose how often you want AutoArchive to
run, whether or not to delete old items
permanently and so on.

3. Mail rules don’t get retained
when you re-install Outlook
Reason: When you migrate to or re-
install Outlook, you can save all your
mails by keeping the .pst files in a safe
location. After re-installation, you can
instruct Outlook to use that .pst file and
all your mails and settings will be safe
and secure. However, mail rules don’t get
saved in the .pst file. So when you think
you have got it right, you suddenly find
that all your mail rules have vanished!

Solution: Export your rules before you re-
install. To do this, go to Tools>Rules and

Alerts, and here, find and click the
‘Options’ button. Here you will find the
‘Export Rules’ button. Click it and then
export your rules to any safe location on
your hard disk. Repeat the process after
re-installation and this time, select
‘Import Rules’ and point it to where you
saved the rules before.

4. Outlook XP doesn’t open .exe
attachments
Reason: At times, you may need to
download the kinds of attachments that
Outlook XP blocks by default. There is no
feature in Outlook XP itself that allows you
to enable downloading these attachments.

Solution: To enable Outlook XP to
download certain attachment types, you
need to do the following: First, open the
registry editor. Expand the branches to
HKEY_CURRENT_USER\Software\
Microsoft\Office\10.0\Outlook\Security.
Now, create a new string value by
selecting ‘New’ and then ‘String Value’
from the Edit menu. Name the new value
‘Level1Remove’. Double-click the new
‘Level1Remove’ to edit it and enter the
filename extensions you would like to
stop Outlook from blocking. Extensions
should be typed in lower case, without
the dots and separated by semicolons.
For example, type in exe;mdb;vbs to
allow .exe, .mdb and .vbs attachments
respectively. Click OK and close the
registry editor. You may have to restart
Outlook for this change to take effect. 

5. Contacts don’t seem to work
even though they are there
Reason: When you re-install or migrate
to Outlook, all your contacts are saved—
but when you try composing a mail to any
one contact or in any other way try to use
a contact from the list, Outlook seems to
ignore the contacts. It appears as though
the contact list isn’t working, even though
you can see that the list is there.

Solution: It’s simple. Right-click on the
contacts folder, then choose ‘Properties’.
Click the ‘Outlook Address Book’ tab.
Here, tickmark the ‘Show this folder as
an e-mail address book’ checkbox. You’re
ready to go!

ram_mohan@thinkdigit.com

Microsoft Outlook

Change the default messaging format to HTML;
your default is probably Rich Text Format 

Set the ‘AutoArchive’ option to ‘Archive Unused
Messages Every Few Days’

Export your rules before you migrate your
Outlook and re-import them after you are done

Outlook has its share of annoyances. Here’s how you tackle the most common ones

DIGIT FEBRUARY 200592
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Upgrade Your Skill Set

Ram Mohan Rao

f you are an employer, you
need soft skills. If you are
an employee, you need

soft skills too. In fact, whoever
you are, at whatever level in your
organisation, it’s your soft skills
that consistently matter—an area
of development you are most
likely to ignore.

At http://snipurl.com/digit_
skills1 is a ‘Soft Skills Quiz’ that
tests your soft skills quotient. The
page lists the 25 “Most frequently
cited soft skills”. Some of these
include oral / spoken communi-
cation skills, honesty, team work
or collaboration skills, self-moti-
vation/initiative, leadership skills,
‘Working under pressure’, creativ-
ity, and time management skills. 

I

According to job portal
monster.com, employers consis-
tently look for soft skills. You may
not have several of these traits
and skills, but you can easily and
actively pursue developing these
skills online. Of course, it’s prob-
ably not possible to take a course
on, say, ‘honesty’ but there are
several areas where you and
members of your organisation
can actively improve. 

From certmag.com, here’s an
‘Unofficial list of soft skills for
techies’—

Team work
Communication skills
Presentation skills
Selling
Running meetings
Leadership
Problem solving
Customer service

Let’s look at some Web sites
that can help you and your
employees develop these essential
soft skills.

Brownbag Training
www.brownbagtraining.com
Brown Bag Training is an e-learn-
ing site that delivers classes online.
Classes are presented live by an
instructor. There are a variety of
soft skill classes to choose from
and a variety of “Class Packs” are
available. A 20-pack costs $1,049
(Rs 49,000). But you could choose
a single class for $59 (Rs 2,700).
They offer a satisfaction promise—
if you are not satisfied with the
class or classes you receive, you get
all your money back. 

Using the Brown Bag develop-
ment process, they will custom-
develop a class or series of classes

So you are high-flier at your workplace? Never mind your achievements; get set to acquire a whole
new range of soft skills with these Web sites
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Get Ahead Direct 
www. getahead-direct.com
GetAhead offers CD-ROMs and
eBooks as training material. While
an eBook is for $8.95 (Rs 403), a
multimedia CD-ROM costs $39.95
(Rs 1,798). There are ten titles avail-
able in all for $199 (Rs 8,955) for all
the CD-ROMs.

Each GetAhead training course
(eBook or CD-Rom) is a compre-
hensive and self-contained course
that will give you a ‘lifelong career
skill’. Each course is designed by
experts to include interactive exer-
cises, case studies and questions.

The 10 titles available are Busi-

ness Negotiations, Time Manage-
ment, Business Presentations,
Winning at Interviews, Business
Meetings, Organising Projects,
Planning Projects, Controlling
Projects, Business Analysis and
Data Analysis. Some of these may
be classified as soft skills, some
not quite.

GetAhead also has an impres-
sive customer list, which includes
the likes of Sun Microsystems,
Sony, IBM, AT&T, Kodak and
Compaq among others.

NAM Virtual University
www.namvu.com
The catalogue at NAM Virtual
University includes soft skills
training as well as training in
other departments such as Infor-

mation Technology. The soft skills
part of the catalogue includes
courses relating to customer serv-
ice, personal development and
professional development. 

For instance under ‘Personal
Development’, there are courses
in ‘Managing Stress’, ‘Recognising
and Managing Anger’, ‘Recognis-
ing and Avoiding Burnout’, ‘Time
Management’ and more. Each
course is  priced at $9.95 (Rs 448). 

Courses typically take an hour
to complete. All courses are deliv-
ered over the Internet. To use this,
you need to register and enrol for
a course and it will be delivered
to you when you want it. 

The flipside to such an
arrangement is that the lessons
are pre-recorded and there is no
live instructor.

CRM Learning
www.crmlearning.com
CRM Learning allows you to take
an online preview of some of its
courses before deciding if they
will be right for you. The method
of delivery is either VHS or DVD. 

As with the other sites
mentioned so far, the soft skills
offered there are communication
skills, customer service, ethics,
leadership, and so on. 
CRM Learning offers a ‘Purchase’

option and it’s a good thing it let’s
you preview! Typically, the
purchase of the titles costs $795
(Rs 37,500) whereas ‘rental’ costs
$275 (Rs 13,000). 

This means that you can order
the tapes or disks and present
them to your entire team at your
convenience. However, the
‘rental’ option may not be avail-
able to Indian customers due to
shipping issues.

Titles in the soft-skills depart-
ment include ‘The power of listen-
ing’, ‘Communicating non-
defensively’, ‘Attitude is Every-
thing’, ‘Really Angry Customers’
and others. 

ram_mohan@thinkdigit.com

for your team or tailor their exist-
ing classes to address a specific
market, skill or customer base.

A typical class is completed in
about 45 minutes and all students
receive an electronic certificate of
completion. Visit http://
snipurl.com/digit_skills2 for more
details about the classes offered.
Some examples are “Customer
Service 101”, “Eight tips for writ-
ing quality e-mail”, “Dealing with
difficult customers” and so on.

You Achieve
www.youachieve.com
At YouAchieve.com, you will find
a variety of learning resources—
workshops, clinics, articles,
‘knowledge nuggets’, intensive
programs and ‘PowerBytes’ (small
tidbits of key information you can
access for free). All content is
delivered via the Internet.

Three types of full-access
subscriptions ranging from a
month, three months to one year
are available. Each gives you access
to the entire course catalogue for
the chosen duration. A one-month
subscription is only $46 (Rs 2,070).

The ‘Intensive Programmes’
include material on leadership
skills, personal career develop-
ment and personal management
skills amongst others. The work-
shops offered include interaction
skills, oral communication,
corporate leadership, personal
development and other essential
skills. The clinics are short (20-
minute) ‘courses’.

Silicon Beach Training 
http://snipurl.com/digit_skills3
This site has a compilation of
many free e-learning resources
that are available. Here, you will
find links to books that you can
purchase, links to forums, arti-
cles, tips and tricks and much
more. The topics are arranged
alphabetically from ‘assertiveness
skills’ to ‘communication skills’
to ‘time management’.

Digital Tools l Enhance

The Switchover
Site
Brown Bag Training
YouAchieve.com

Silicon Beach Training

Get Ahead Direct
NAM Virtual University

CRM Learning

Delivery Method
Online
Online

HTML Pages

CD-ROMs; eBooks
Online

VHS or DVD

Pros
Clean Interface, Live Instructor
Huge number of courses available; articles and
‘nuggets’ in addition to courses; affordable
Free; large number of links

Very affordable eBook option
Reasonably Affordable

High-quality products

Cons
None
None

No formal training option for non-UK customers;
you only get to use the free links
Limited number of titles
Somewhat limited selection of soft skills
courses
Expensive

CRM Learning is expensive, but offers high-quality training



96 DIGIT JANUARY 2005

Digital Tools l Smart SoHo

comfort of their homes. And web-
based ventures that survived the
dot-com crash are providing such
opportunities to people in India
and abroad.

Programmer For Hire
A 29-year-old programmer with
five years of experience in IT is
resigning from a top firm to do
freelance assignments, working
from home. “I have been offered a
freelance assignment from a US-
based firm to develop Web-based
applications using Flash and Flash
Communication Server,” says
Sanjeev Menon. The project,
spread over a few months, will
earn him  as much as $1, 300 
(Rs 56,500) per month.

Sites such as www.renta-
coder.com help programmers like
Sanjeev touch base with compa-
nies and individuals seeking free-
lancers. These sites charge 15 per
cent of the programmer’s pay for
every project sourced through
their service. “The clients rate you
based on your performance, which
is then displayed on the site,” says

Sanjeev. With a rating of about
600, out of 93,000 programmers
listed on the site, Sanjeev is aiming
to head the top of the pile soon. A
better ranking obviously means
more lucrative offers. Who needs
placement services in such a
convenient setup? 

If you are a programmer, tired
of a structured corporate career,
head to getafreelancer.com, renta-
coder.com, scriptlance.com and
elance.com—to code and earn,
without leaving home! 

The Write Stuff
Freelance journalism has been
around for a while but thanks to
the Web, sourcing projects has
never been easier. As an offshoot
of the outsourcing boom, journal-
ists in India can now freelance for
foreign publications on a wide
variety of subjects. 

Chennai-based Power Quill
(www.powerquill.com) is one such
company that employs a network
of freelancers and is the brainchild
of former business journalists K
Nitya Kalyani and Arun Natarajan.

Meera Vankipuram

“Earn Rs 4,000-10,000 every month
by online surfing. Full/Part-Time
from Home/Cyber café. Franchisees
required all over India. Contact: ...”
“Work 1-2 hours per day on
home/office Internet. Earn extra
income without leaving your 
present occupation. Training
provided. Contact: ...”

ooks familiar? It’s
splashed all over the clas-
sifieds in newspapers, in

notices stuck on local trains and
buses and in dozens of handouts
distributed  at busy street corners.
While the reliability of a signifi-
cant portion of these notices is
suspect, working from home is an
option being explored not just by
homemakers but also by full-
fledged professionals tired of the
corporate rat race.

The proliferation of the Inter-
net and cell phones has given
several users the choice of explor-
ing alternate careers within the

Home Is Where

L

Telecommuting is not just a trend that will fade away... It is fast becoming a way of life more
and more professionals are choosing 

Imaging Jayan Narayanan 

The Money Is
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freelancers. Chillibreeze provides
people such as Nishi Roopa, a
doctor who wanted to switch to a
career in writing, opportunities to
work from home. Suma is an
instructional designer who free-
lances in order to spend more time
with her five-year old. Arka and
Aniban are freelance scriptwriters,
working with Chillibreeze.  

The requirements of interna-
tional clients like Business Intelli-
gence or even market research
reports are met by freelancers in
relevant fields. Those interested in
writing business-related white
papers can contribute (on a royalty
basis) to www.outsource2india
.com, another Stylus venture. 

Anusha Subramanian, a free-
lance journalist in Mumbai works
from home. She freelances for
print publications and also edits.

Anusha has been a freelance
writer for over three
months now. She
coordinates with ‘The
Word’, a company
based in Mumbai. “All
you need is a good
cable Internet connec-
tion at home and you
are your own boss!”
she claims. 

Anusha is also a
member of several
online business
networks including
the popular Ryze.com,
where she meets
prospective clients. As
for the payments,
“Cheques are deliv-
ered home just like
other publications,”
she states.

Set up by journalists Supriya
Madangarli and Jigna Kothari, The
Word offers editing, marketing
and content creation services to
companies and publications in
India and overseas. 

Says Supriya: “We make use of
the huge network of freelancers in
India and contact them when a
specific service is required.” 

The duo bags projects through
the Web and has enrolled in busi-
ness networks and also rely on
referrals. “Typically, magazines
pay around Rs 2 per word, news-
papers Re 1 or Rs 1.50 per word. For
other services, we charge accord-
ing to the project.” 

Click To Translate 
Linguaphiles with a flair for trans-
lation can turn to the Web to
polish their linguistic and trans-

lation skills and make moolah
while they are at it. Prerna, a free-
lance translator who has worked
on French-to-English projects,
initially scoured the web for serv-
ices that advertised freelance
assignments. “Google is your best
bet. Simply type ‘freelance trans-
lation’ and follow the links. Most
sites are reliable and pay well,”
says Prerna.

Sites like ProZ.com—a direc-
tory of freelance translators and
translation agencies, Yahoo!
Groups and Elance Online have
discussion groups on best prac-
tices followed, payment and
project details. “People normally
bid for projects. The bids are
placed by both agencies and indi-
viduals,” says Prerna. These sites
also offer ratings. The higher
your rating, the better your
chances of obtaining a good
project. Online forums also help
network with other translators,
across the globe.

The ultimate repository for
freelance projects in any field, be
it programming, editing, writ-
ing, graphic design, marketing,
content development or e-learn-
ing  is probably Elance Online
(http://snipurl.com/digit_elance).

Elance lets companies ‘find the
right professional’ for the right
job. This ‘global marketplace’ has a
ranking system and also lets you
bid for projects that are up for sale
and consult sourcing experts.
Other aspects such as payments
are also handled through the
website itself.

Uncharted Territory
The Internet is flooded with gate-
ways that you can tap to earn
money without leaving home. A
reliable Internet connection,
comfortable workspace, requisite
software and inputs are all you
need to get started. 

Exercise caution, though. You
must have the strength of mind
and the resources to deal with
delayed or erratic payments, long
periods without sufficient work
and even lack of  opportunities to
match your skill sets.

It pays to upgrade your skill sets
from time-to-time, enrol in forums
or business networks, and interact
with people online and offline, to
stay marketable. 

If you are willing to risk the
pitfalls and are confident of your
talent and endurance, take the
plunge—the Web is your oyster. 

meera_vankipuram@thinkdigit.com

Power Quill has worked on
assignments for publications in
the USA, India, south-east Asia and
the Middle East. Co-founder Arun
states, “We mostly employ people
who work from home. We tap our
pool of editorial staff depending
on our clients’ requirements. At
times, we even fill in for temporary
shortage of editorial staff. I think a
lot of women who have school-
going kids and the time to spare
benefit from this kind of a setup.
All you need is a good broadband
connection at home—most of our
communication happens over
instant messengers.”  

A bulk of Power Quill projects
includes writing articles and news
reports for domestic and foreign
publications, creating corporate
communications material for
small and medium businesses
(SMBs) and Public Relations firms

and Web-based content. 
“Once our work is appreci-

ated, we receive more responses
through word-of-mouth referrals.
But Google is our best sales guy!
We browse the Web for potential
projects and rely on it for adver-
tising our services,” adds Arun.
Apart from the Internet, Power
Quill also makes use of VoIP, e-
mail and Skype. “We believe that
technology can drastically bring
down the cost of publishing,”
Arun affirms. 

Another company that has
capitalised on the outsourcing
boom is Bangalore-based Stylus
System. Stylus develops Web appli-
cations and manages BPO projects
for clients in India and abroad. 

It recently inaugurated a divi-
sion called Chillibreeze (www.chill-
ibreeze.com), which employs

We mostly
employ
people who
work from
home...most
of our
communica-
tion happens
over Instant
Messengers.”
Arun Natarajan
Co-founder,
Power Quill,
Chennai

Journalists Supriya and Jigna, founders of a company that
employs freelancers
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Digit’s brand
head Prashant
Narekuli got fed
up with Exec Ed
Sachin Kalbag
showing off his
iPod at every
possible
opportunity.
Prashant was
determined to
show off what
he could do with
his age-old Aiwa
personal stereo
versus the iPod
Sachin was
flaunting

Items in hand: Aiwa Walkman, Philips 1200 W
stereo system. Needed 3.5-inch pin cable.

Bought USB cable for Rs 2,200. Had to call up the
Apple distributor and then go to pick up the cable.

Time taken 95 minutes

Connected the iPod to my PC. Loaded the iTunes
software from the accompanying CD. After a few
hitches, it worked.

Time taken 28 minutes

Transferred over 3,000 songs from my PC to the
iPod in just over a half-hour.Of course, this was
from a legit playlist gifted by a friend in the US.

Time taken 31 minutes

Played my favourite 20-song playlist as the stereo
did the recording. Had to turn the cassette once.

Time taken 91 minutes

Listening to music the Old Way Listening to music the Tech Way

1
2
3

4
Created a playlist from the 3,000 songs on the iPod
and played them. Revelled in the digital, new-age
way of listening to music!5

Icould not decide what was most important—cost,
quality, or quantity. Sachin spent more than Rs

15,000 on his equipment. While you can show off
the iPod to friends and colleagues, the personal

stereo—or Walkman—gives you a simple, cheap and
time-tested solution. Ultimately, I favoured
simplicity over the flashier iPod—it costs much less,
and is almost hassle-free.

OLD
WAY

TECH
WAY

Total Time Taken: 133 minutes
Total Cost: Rs 1,055 for 20 songs

Total Time Taken: 154 minutes 
Total Cost: Rs 15,000 plus for 3,000 songs

And 
The

Winner
Is...

Prashant Narekuli (prashant_narekuli@thinkdigit.com) and Sachin Kalbag (sachin_kalbag@thinkdigit.com)

Connected the Audio Out of my PC to the Aux In
of my Philips stereo system using the 3.5-inch pin
cable. Popped in a blank 90-minute cassette that
cost Rs 25.

Time taken 2 minutes

Creating A Portable Song Compilation 

Items in hand: 15 GB iPod, FireWire cable. Needed
a USB cable.

I bought the 3.5-inch pin cable from a local hard-
ware store for Rs 30. 

Time taken 30 minutes

Played the recorded cassette on my old Aiwa
Walkman that I had bought for just Rs 1,000.
Enjoyed the age-old ways of analogue music!
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DVD Regions Conundrum

I have a Samsung DVD ROM attached to my
P III that worked just fine. One day, I saw

that it could not read the DVD disk,
however, it read CDs till now. From the
‘DVD Region’ in the ‘Properties’ of the
DVD-ROM drive, I found that  the current
region shows Region 1, but India belongs
to Region 5. When I try to change the
region from 1 to 5, I receive an error
message: “Unable to update region
setting. Please make sure the drive
contains Region 5 media and you have
administration privileges.” How do I make
my DVD drive read a DVD?

Sadananda Singha

DVDs have nine region codes:
Region 0 is region-free and such

DVDs will play on all drives. Regions 7
is reserved and not set. Region 8 is for use on
international planes, ships etc. These
settings can be changed four times at most,
after which they get locked to the last region
used. It looks like you have changed the
region more than four times, in which case
you are out of luck. Remember, you do not
have to change the region simply because you
are in India. To play a DVD made in the 
US, for example, your player needs to be 
in Region 1.

You can bypass the region lock that each
DVD player comes with using various soft-
ware. However, this is illegal and will render
your warranty void.

Get FAT!

My OS is Win98. I
installed Win2000

Pro and it asked to
upgrade with NTFS
which I did. Now, I
cannot format my C:
drive on which my OS
resides. When I try to
format it, the D: drive
gets formatted. My C:
drive file system is
NTFS and other drives,
including the D: drive
are FAT32. How can I
change my C: drive
from NTFS to FAT32?

Download a tool called PartitionMagic
(http://www.powerquest.com/partition-

magic/) that lets you convert from NTFS to
FAT32 without losing your data. If possible,
backup your data as a precaution.

Hey RAM!

The specs of my PC are as follows: Athlon XP
2400+, 256MB PC133 DDR RAM (Hynix) and

a Krypton C18G-400 motherboard with onboard
nVidia Geforce 4. Recently, my friend acciden-
tally dropped my RAM module. But there were
no cracks or scratches. From then on, while
launching some applications or games, it shows
an error—“(appname).exe has encountered an a
problem and needs to close.” When I viewed the
technical contents of this report, it displayed,

“The following files will be included:
D:\DOCUME~1\SIVASU~1\LOCALS~1\
Temp\WER6.tmp.dir00\gta-vc.exe. mdmp.
D:\DOCUME~1\SIVASU~1\LOCALS~1
\Temp\WER6.tmp.dir00\appcompat. txt”

For each application, only the number
after “WER” and the application name
itself changes. It happens mostly when
launching GTA:Vice City, Colin McRae Rally
2, Adobe Live Motion and PDF-to-HTML
converter. Is it due to my Hynix RAM? Do I
need to get it replaced (it is within the
warranty period)? Are there any tools to
detect damaged RAM modules?

M Siva Subramanian

To test whether your RAM is damaged,
remove all RAM modules from their slots

and insert only one of them into a slot. Now
run any the following utility: http://www.
memtest86.com/ 
Or get the Microsoft utility at: http://
oca.microsoft.com/en/windiag.asp

If you get an error, run the test again with
your RAM chip in a different slot. If you do
not get an error this time, then your RAM slot
is not faulty. Repeat the test for all the RAM
chips you have.

It may turn out that both your RAM slots
are faulty. To make sure that it is your RAM
chip at fault, test it on another machine
where the slots are working fine.

If you do not get any memory errors, then
your RAM chip is fine and you should try rein-
stalling your games and software and updat-
ing them with the latest patches.

Internal HDD, External Connection

I have a P III 1.0 GHz, a Vesta 810e Intel chipset
board with 256 MB of SDRAM and an 80 GB

Seagate HDD running Win98 and WinXP as the
OSes, a CD-ROM and an LG CD-RW. I also have a 40
GB Seagate HDD not connected to the system. The
40 GB HDD is divided into three partitions running
Win98. The 80 GB HDD is divided into six parti-
tions—four as FAT and two as NTFS. How can I
connect my HDD to my system without opening the
cabinet? Do I need any special drivers?

Ravi Shah 

Your Questions, Our Answers

Managing drives in Partition Magic 8.0
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It is possible to convert an internal HDD
to an external HDD. You need to buy a

case which retails for Rs 1,500-2,000. Just put
your drive in the case and connect it to your
PC with a USB cable. These cases do not
support SATA drives—only regular IDE ATA
disk drives.

PROcessor CON!

I recently bought a PC with an AMD proces-
sor 2800+, ASUS motherboard, an 80 GB

HDD, 256 MB of DDR RAM, a combo drive etc.  I
have installed Windows XP.  The PC configuration
in the device manager displayed “AMD Processor
1500+”. When I asked the vendor about this, he
replied about some switches on the mother-
board. On changing those, it would show the
correct configuration. I am not so familiar
with AMD processors. I want to know what
the number 1500+ actually means, and is
my vendor right?

Earlier I worked on a P IV PC with a
VIA chipset motherboard. I had a bad
experience with that PC. I came to know
that the VIA chipset doesn’t support high-
end games. So I didn’t opt for any moth-
erboard having VIA chipsets. But my
vendor says that there are no chipsets
available other than VIA for AMD proces-
sors. When I opened my CPU, I saw that he
had given us an ASUS motherboard with a
VIA chipset. Now my PC hangs every time
I install a game, even a small one like
Delta Force. Is it the motherboard, or
something else responsible? Aren’t there other
motherboards available for AMD computers? Is
a graphics card required to install games?

Sambit Mohapatra

To check whether your vendor has given
you the correct processor, go to your BIOS.

Your processor’s core speed will be listed
there. Alternatively, download any of the
following utilities: Sisoft Sandra from
http://www.sisoftware.net/ or Everest from
http://www.lavalys.com/. Click on the
Computer>Summary tab and your system
specs will get listed. This will tell you whether
you have been taken for a ride. 

The term “1500+” is AMD’s way of indicat-
ing  the processor’s performance—this proces-

sor will give the same performance as an Intel
processor running at a core speed of 1500
MHz. This is not the actual core speed at which
the processor runs. If your processor is an
Athlon XP 1500+, then your actual CPU core
speed is 1,333 MHz.

There are four chipset manufacturers for
AMD boards—ATi, nVidia nForce, SiS and VIA.

There are manufacturers who make moth-
erboards based on these chipsets—ASUS,
Gigabyte, MSI and others.

You need a graphics card to play almost all
high-end games these days. For specifics, refer
to Digit (January) for the graphics card
shootout. Since you haven’t mentioned your
motherboard or the chipset specification, we
cannot give you a detailed answer. But you
can check your motherboard and graphics

card (if you have it) using the SiSoft util-
ity. Also, try installing DirectX9c and
update your graphics driver. Try
running games now. It might work.

The Infamous BSOD

I have a P IV 2.4 GHz PC with 512 MB of
DDR RAM, an Intel 865GBF

Motherboard, nVidia GeForce FX 5200
AGP, an 80 GB Seagate Barracuda 7,200
RPM, a Samsung combo drive and a
Realtek Rtl 8139 ethernet card. When I
logon to or logout from Windows XP, the
blue screen of death appears often—in fact
80 per cent of the time with either one of
these messages:

1. IRQL_NOT_LESS_OR_EQUAL Technical
Information: Stop (0x00000000,0x00000002,
0x000000000, 0x804 D9716)
2. PAGEFAULT_IN_NONPAGED_AREA
Technical Information: Stop 0x00000050
(0xFFFFFF60,0x00000000,0x804F4C32,0x00000000)

The technical information varies each time.
The errors occur mainly when I switch from one
user account to another (I have disabled faster
user switching). I have no problems when I logon
immediately after system boot. I have installed
the latest BIOS drivers. There are no anti-virus or
background software installed. I have Windows
XP Professional, Windows 98 SE and SuSe Linux
with XOSL in a separate partition. Is there a fault
in my RAM? 

Amar Gupte

This error happens mainly due to 
the hardware or software incompatibil-

ity. To avoid this, update the drivers of 
all your devices and upgrade to SP2 in
Windows XP.

If that still does not solve the problem,
immediately after you get the error, reboot
your PC and see the CPU temperature in the
BIOS. In case, it is too high, then your system
is overheating and you must get a better heat
sink and fan. If the temperature is normal,
then go to Start>All Programs>Accessories>
System Tools> System Information. Click on
IRQ on the left side. View the status of your
IRQs in the right hand pane. If there is any
IRQ whose status is not OK, uninstall thatViewing System Summary in Everest
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Upgrade Without Losing Data And Settings
Faster processor, bigger memory and better

computer… something we all want. We hunt
for the best deal and finally decide to go ahead
with that upgrade when we are struck by a
thought that could well be upgrade-altering!

“How will I back-up and restore all the
settings from my present OS version to the
new installation or from this PC to another?”
So many settings, so much data—e-mails,
Internet favourites, downloads...how? The
mere thought can give you goosebumps!

Fear not, for there are ways and means to
archive critical data and retrieve it as easily.
We tell you here how to migrate files and
settings between Windows XP PCs. Let’s
consider a scenario in which you wish to re-
install Windows XP.

Method 1: Using The ‘Files And
Settings Transfer’ Wizard 
Windows XP comes loaded with the ‘Files and
Settings Transfer Wizard’ utility, which helps
transfer important files and settings from 
an old PC to a new one. The transferred 
files and settings include ‘Appearance’,
which contains  wallpapers, colours, sounds,
fonts and location of the taskbar;
‘Accessibility Settings,’ ‘Internet Settings’
which includes your favourites, proxy and
security settings, cookies, dial-up settings,
homepage, Outlook Express mail and
settings and My Documents.

Backing Up Files And Settings
Click Start>All Programs>Accessories>
System Tools>Files and Settings Transfer
Wizard. Click ‘Next’ in the first dialog box
that opens. Since you wish to first back up
your files and settings, select ‘Old Computer’
and click Next. Now, select the method of
transfer—which includes ‘Direct Cable,’
‘Home or Small Office Network,’ ‘Floppy Drive
or Removable Media’ and ‘Other.’ We shall
select the ‘Other’ method. Enter a location on
a drive where you don’t have your data and
click Next. You can opt to export ‘Settings
Only,’ ‘Files Only’ or both or customise your
selection. Clicking ‘Next’ one last time will
transfer your settings and files to the
selected location.

Restoring Files And Settings
After re-installing Windows XP, start the Files
and Settings Transfer Wizard as before, but
this time select ‘New Computer.’ Select the
last option—“I don't need a Wizard Disk,” as
you have created a backup of the old
Windows settings. On the next page, select
the option ‘Other’ and point to the location
where the backup is placed. Wait for some
time for the files and settings to be restored.
Finish this operation and log off for all
settings to take effect.

Method 2: Manually Transferring Files
And Settings
This is for adventurous techies! Make a check-
list of the files you want to back-up—My
Documents, Outlook, E-Mail Settings etc. We
look at each one step by step. To start with,
make a new folder on a drive where Windows
does not reside. All your settings and files
must be stored in this folder, henceforth to be
called the ‘Backup Folder.’ 

My Documents
Click Start>Run. Enter ‘%USERPROFILE%’
and click OK. Copy ‘My Documents’ in the
Explorer window to the Backup Folder.

To restore ‘My Documents’, click on Start,
run ‘%USERPROFILE%’ and copy ‘My
Documents’ from the Backup Folder to the
location opened in Windows Explorer. This
time, you will have to overwrite the folder.

Outlook
Outlook data comprises files with the .pst
extension for personal folders, .ost for offline
storage, .pab for the address book, .rwz for
rules and .nick, .nk2 for nicknames for
AutoComplete. Additional files include .dat for
Toolbar and Menu settings, .fav for Favorites,
and so on. 

To backup data from Outlook, create a
folder in the Backup Folder and close Outlook.
Click on Start>Run. Enter ‘%APPDATA%
\Microsoft\Outlook\’. Copy all files with the
above extensions to the folder created earlier.
Repeat the above steps for the path ‘%USER-
PROFILE\Local Settings\Application
Data\Microsoft\ Outlook\’. It’s better to
store the files from each of these folders
separately in the folder created in the
Backup Folder.

Outlook Express
To back-up the Address book, click ‘File’,
then ‘Export’ and then ‘Address Book’.
Choose ‘Text File’ and select ‘Export.’
Choose a filename to save the file in the e-
mail Backup Folder. Select the fields you
would like to export. To restore the address
book, import the text file you saved into
Outlook Express.

To back-up your E-mail settings, click
‘Tools’ followed by ‘Accounts’. Now choose the
account from the list and click on ‘Export’ to
save it to the e-mail Backup Folder. The e-mail
settings can be restored to the new computer
in a similar manner.

To backup your e-mails, you must find the
e-mail store folder. Click on Tools>Options
and then the ‘Maintenance’ tab. Click on the
‘Store Folder’ button, and note the location
where your e-mail is stored. 

Close Outlook Express, navigate to this
folder in Windows Explorer and copy all the
files in it to the E-mail Backup Folder. To
restore your e-mails, click File>Import>
Messages. Select Microsoft Outlook Express 6
(OE6) and click Next. Select ‘Import mail from
an OE6 store directory’ and enter the e-mail
backup folder path in the dialog box. Now
select the folder you wish to import to and
click OK.

Favorites And Cookies
You need to create a folder for storing
Favorites and Cookies in the Backup Folder.
Open IE, click File>Import and Export and
click ‘Next’. Now select ‘Export Favorites’
and select the backup folder you created.
The Favorites will be saved as a .htm file.
Favorites can be imported in a similar way,
and so can Cookies.

Following some good practices makes life
easier. Organising folders in a convenient

way will help reduce the hassles of backing
up your data. Here are some methods.
Relocate the ‘My Documents’ folder to a
drive on which Windows is not installed.
Open Windows Explorer, right-click on ‘My
Documents’ and click on ‘Properties’. In the
dialog box next to ‘Target,’ enter a path to
a folder on the drive of your choice. 

From now on, this new folder is your ‘My
Documents’ folder. Use sub-folders within
this store all your data, be it e-mails or
documents. 

Similarly, the Outlook Express mail store
folder can be relocated. In Outlook Express, click on Tools>Options>Maintenance. Click on
the ‘Store Folder’ button and select ‘Change’. Now point to a folder of your choice and click
OK. All future mails will be saved to this folder.

Good Practices

Changing the My Documents location



104 DIGIT FEBRUARY 2005

device from the device manager. Your
computer should work fine now.

If all the IRQs have status ‘OK’, then
download the Windows memory-testing
program from http://snipurl.com/c3mh.
Run it, and if it gives any errors, then
assuming you have a single chip, remove
your RAM chip and put it into another
slot. If it works fine then your RAM slot
is faulty and you will have to repair or
replace your motherboard. If, however,
your errors persist, then your RAM chip
is definitely faulty.

If you have multiple RAM chips then
insert only one of them and test it in
your RAM slots, then put in the other
and test as before. Identify the faulty slots
and fix the problem accordingly.

Over Drive!

I have a Celeron 600 MHz, a Procomp moth-
erboard and 128 MB of RAM. I have two

Seagate hard disks—20 GB and 40 GB. I also have
a Sony CD-ROM and an LG CD-RW. The two IDE
cables are all occupied. How do I attach a DVD-
ROM to my PC?

Tanmoy Das

Install an IDE controller card to be able to
add additional drives. An alternative is to

remove your CD-ROM and attach the DVD-
ROM in its place, as a DVD ROM drive will
allow you to read CDs as well.

Dirty PC !

I have a P IV 1.6 GHz CPU with an Intel
845WN motherboard, 128 + 256 MB

SD RAM, 40 + 120 GB HDDs, a 24X CD-RW,
a 16X DVD-ROM and a 15-inch  LG monitor.
I have three OSes—Win98, Win2000 and
WinXP, loaded in the 40 GB HDD in three
different partitions. The problem is that
my WinXP restarts abruptly without warn-
ing and this generally happens when I
switch on my PC after several hours. After
this, when the PC restarts, the CHKDSK
operation is performed that results in
some errors and when finally XP restarts,
a warning indicates that the system has
recovered from a serious error.

My DVD-ROM works perfectly but when I use
it for some time, the BIOS stops detecting it.
When I restart my PC three to four times, the
BIOS detects it perfectly. This problem occurs
at regular intervals and persists or does not
occur at all.

Sanjeev Chharia 

Ensure that the motherboard is clean
and dust free. You may want to contact 

a local technician to service it. Make sure 
all wires and cables are plugged in properly
and that your RAM, video cards and all 
other peripherals are plugged in tightly 
into their sockets. As for your DVD problem,
check your connection cables. They must
probably be loose! 

E-mail us your 
computing problems,
and we may answer
them here! Since we get
more mails per day than
we can handle, it may
take some time for your
query to be answered.
Rest assured, we are 
listening!

sos@jasubhai.com

WiFi Without Access Point

I want to set up WiFi at work with a single desktop
and my WiFi-enabled laptop. Can I use a wireless PCI
card and communicate directly with my laptop with
the RF waves from both terminals? Does technology
support such configuration? Or is an AP a must? Can I
use only an AP connected to the desktop that will
communicate with the laptop? Which brand is
preferred for the hardware (AP, wireless PCI card)?

mrdedhia@yahoo.com

You do not need an
access point to setup 

a wireless network
between your laptop
and your desktop. You
need to set up an Ad
Hoc access point.

First, install the
wireless card on your
desktop. If you are
using Windows XP,
your card will be auto-
matically detected and
the drivers will install. If other networks are available,
Windows will automatically open the window for wire-
less network connection. If not, click on the ‘Wireless
Connections’ icon to open the window. If applicable,

clear all connections in preferred access points to
make sure that you connect only to your laptop.

On the top right of your window, click the
‘Advanced’ tab and select ‘Computer to Computer (Ad
Hoc) networks only.’ Un-tick the ‘Automatically
connect to non-preferred networks’ box. Go back to the

wireless networking tab under the preferred
Networks window, click ‘Add’ and spec-

ify a name (SSID)—any name. The
connection type would already

be specified as ‘Ad Hoc’. Now
you will see the name of

your network in the
preferred networks

window marked
with a red ‘X’,
signifying that
that computer
is not within
range.

Since your
laptop is WiFi-
enabled, go to
the wireless
networks tab

and you will
see the name you gave in the above step in the
“Available Networks” window. That’s all you need to do
to share data between the two.

Question 

of the

Month

Illustration Shyam Shriram
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Amonth ago our editor SK, decommis-
sioned his five-year-old glorified type-
writer—his older Pentium pro system—

with the idea of getting a new 64-bit super fast
desktop PC. While he is not a geek you often
come across in the Test Centre (TC) or Skoar!, his
six-month stay amongst them has made him
tech savvy enough to long for a 64-bit system. So
the TC drew up the best configuration and I
gave my inputs for the best market deals, all set
and done the final piece of paper was given to a
local assembler near SK’s house. He assembled
the beauty, and boy, oh boy the smile on SK’s
face was infectious when the monster of a
machine zoomed through most applications
like a Ferrari on an open road.

Everything was wow, cool and fast until that
fateful Sunday morning when a high pitch
started emanating from the box and soon,
everything went cold. The TC was summoned,
and they traced the fault to a fishy power sup-
ply (PS). But why wasn’t it a 400W supply with
dual fans? Just the question to put a sleuth like
me on the right track. 

This time around, though, the job was diffi-
cult since no one in the TC could come up with
quantitative proof as to which power supply
brand is more reliable or efficient. However,
from their testing experiences, they have reser-
vations about certain brands known to be bet-
ter than others. According to them, a 350W PS
is a must if you own one of those deluxe, plat-
inum boards overflowing with additional fea-
tures and demanding more power. 

But is putting a higher capacity PS the only
solution? Debating on the issue, we arrived at
the conclusion that a
better (read effi-
cient) 350W PS is as
good as say, a
poor 450W PS.

Efficiency in this case refers to the ability of
the PS to fulfil the demand from the machine
without significant internal loss. For example,
if a PS is rated at 350W, under typical load con-
ditions, the total power consumed was 250W
whereas the power supplied to the system was
175W. This amounts to 70 per cent efficiency
implying that the remaining 30 per cent was
internal loss and dissipated in the form of
heat. And all this under typical load condi-
tions. The consumption would vary depending
on the work done by the processor.

Why processors? Processors are the real
power hungry monsters in the machine. At low
loads, when the system demands less power, the
amount of energy lost will be high presenting a
precarious situation for a poorly designed high-
wattage PS since most of the power consumed
will be flushed out as heat rather than used by
the machine. Therefore, although a good PS is
expensive, in the longer run, it will prove to be
cost effective. 

So which one should you buy? Visit almost
any computer shop and a 300W PS costing Rs
500 will be the first one handed out to you.
Brands are dime-a-dozen in this category and
you would be forgiven for thinking that just
about everybody in the world has a manufac-
turing plant! Not all 300W PS, though, are bad.
In fact, Mercury, Microtek, Frontech, Perx and
HIS, to name a few, are the fastest moving ones
and from my investigation, they don’t fare too
badly either. However, when confronted with
the efficiency question, most shopkeepers will
be at a loss to answer you, well, efficiently! 

Regular 400W PS are a different ballgame
altogether. Everybody knows the ratings are
bogus and stickers are just that—stickers. Ask for
a 400W PS and be ready to spend up to Rs  1.5K
for a bogus PS. Push a little harder and reluc-
tantly, you might hear the name VIP. The 400W
PS from VIP is priced at Rs 1.9K and comes with
a three-year warranty and according to shop-
keepers is the best you can buy. Our TC swears by
Antec, a name not familiar to most in the mar-
ket. They are priced at a premium but are worth
the price. 

In the marketplace, VIP attracts attention
as being the best amongst the brands. Antec is
definitely better and has a wide product port-
folio to choose from but is priced higher. With
no proper test in place, recommending a buy
is difficult but I will bet my money on an
Antec or a VIP.

Power To The PC
Faulty power supply can spell doom for PCs. Agent 001 tracks down the better ones

Agent 001

When confronted
with the 
efficiency 
question, most 
shopkeepers will
be at a loss to
answer you, well, 
efficiently!
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Want more of Agent 001? Turn over to read his
AAnnsswweerrss  to your buying questions
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Pentium Or Athlon?

I am learning Maya and plan to buy a new PC to
pursue a career in designing. What processor

should I settle for? Should it be a Pentium or an
Athlon 64 FX? Also, please mention the appropriate
motherboard and the cost of the respective mother-
board-processor combo.

Jeet

Applications used for 3D modelling such
as Maya require colossal amount of pro-

cessing power and tons of memory. As of today,
AMD’s Athlon 64-bit processor is the numero
uno and there should be no doubt about which
processor to go for. The Athlon 64 family com-
prises the Athlon 64 and Athlon 64 FX proces-
sors, the latter being significantly costlier. In
case money is not a problem, consider the FX
series, the required RAM and motherboard, else
you can settle for the Athlon 64 processor. 

The Athlon 64 3200+ is ideally priced at Rs
12K and should prove to be a great performer
when coupled with the K8N Neo FSR mother-
board from MSI. This motherboard is priced at Rs
7.5K, and a higher option, the fully loaded
Platinum priced at Rs 9.5K, is also available. Keep
in mind that for getting the maximum out of
this PC, you need to equip it with at least 1 GB of
DDR 400 MHz RAM from Transcend or Kingston.  

Sound Decisions
My current PC configuration is P4 2.66GHz,
Gigabyte 8S650GXM motherboard, 256 MB

Ram, 80 GB HDD, S3 Savage 2000 64 MB card. I
want to upgrade and have already bought an Asus
P4C800 DLX motherboard, 1 GB DDR 400MHz RAM
and Antec PlusView 1000 AMG cabinet. Which is the
best CPU, graphic card, hard drive and sound card?
Money is not an issue.

Raj Anand

The Asus P4C800-DLX supports socket
478 P 4 Processors with 800 MHz FSB. For

maximum performance, you can opt for a P 4,
3.2 GHz processor with 1 MB cache. For the
graphics, a GeForce 6800 GT card from
Gainward is a good investment. Western digital
drives also perform admirably; however, are
harder to obtain and service might become an
issue. You can safely bet on the Maxtor or
Samsung SATA drives, though; they perform
and help for them is not too far! 

As for the sound card, I recommend you try
the on-board sound first. If you are not satisfied
with the quality, then you could go in for any
Creative Audigy card. 

CRTs Rule Still!
I want to buy a good 17” TFT monitor with fast
response time (8-12 ms), analogue and digital

inputs. My four-year-old CRT monitor has recently
conked off and I would also like to know if this is the
right time to upgrade to an LCD monitor considering
the prices. Is a fall in prices expected any time soon?  

M K Mech

TFT LCD monitors are expensive and
will set you back by at least 23K for a

decent 17-inch model. LCD monitors with low
response time of 8 to 12 ms are rare in India
and even if they are available, would be priced
high. For the moment, it is not advisable to go
in for an LCD monitor given the fact that they
are expensive for the marginal advantages
they offer. My reasoning is also based on expe-
rience…I play lot of games and have come to
the conclusion that even the worst CRT is a
better bet than a reasonable LCD since they 
let you play without distortions. LCDs are 
also finicky about the resolution you run
them at. 

On the positive side, LCDs consume less
power, but that should not be an issue since
home computers hardly run long enough to
show up in the electricity bill. 

First Hand Or Second Hand?
I am interested in buying 256 MB SD RAM—
new or used. I have a P3 64 MB SDRAM, 

1 GHz processor. What is the market price for 
both options?

Dipen

You should never compromise on a
component like memory modules.

Going in for used RAM has many pitfalls
although the deal might look good. Used RAM
does not carry warranty and if you are going
to buy used RAM, buy it from a trusted source
only. New 256 SD RAM would cost you some-
where around Rs 1,950. Before you buy,
though, make sure you point out to the deal-
er that you are using a Pentium 3 and not a 
P4 processor. 

Building A Gaming Rig
I like playing games and would like to assemble
a reasonably good gaming rig. Can you to chart

a configuration that will play new games including
Doom3, Half-Life2 and Commandos 3.

Anshul Thakur

I generally avoid such questions since
many variable parameters govern the

answer; least of all, the price restriction.
However, since I have received a lot of similar
queries, I am listing down a configuration that
will cost around Rs 35K. 

Product Price Range (Rs)
Processor AMD Athlon 64 3000+
Motherboard MSI K8N Neo FSR
RAM Transcend 512 or 256 MB at least 
Graphic Card ATi 9600XT or GeForce 5700

Ultra-based cards 
HDD Maxtor or Samsung 120 GB 
Monitor Samsung 793S
Case Your choice
Power supply VIP 400 watts
Keyboard Logitech New Touch
Mouse Logitech Optical
Optical drive Lite-on Combo drive

Configuration For Gaming

The Athlon 64
3200+ is ideally
priced at Rs 12K
and should prove
to be a great 
performer when
coupled with the
K8N Neo FSR
motherboard
from MSI

Want some tech prod-
uct, but don’t know how
to go about buying it?
Send a mail to
agent001@thinkdigit.com,
and get your queries
answered

Ask Away

Ask Agent 001
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Ram Mohan Rao

icrosoft is the undisputed leader in office
suites, and MS Office is the de facto stan-
dard when it comes to choosing an office

software package. For those who came in late,
alternatives exist. And they are cheaper too! One
such alternative is StarOffice—Sun Microsystems’
offering for the office environment, priced much
lower than MS Office. 

As the chief technology or information
officer of your company, you might wonder
about using something like StarOffice instead of
MS Office, given the ‘unknown’ aura sur-
rounding it. So we decided to learn more about
it, and investigated if any corporate setup was
implementing it. 

We came across Apnaloan.com.
Apnaloan.com is a leading mediator for

financial products in

the form of loans, insurance and credit cards,
to name a few. Amongst the four first-genera-
tion entrepreneurs who founded apnaloan.com
is Parag Patankar, chief information officer and
director, Insurance. An IIM Ahmedabad
alumnus and an engineer from IIT Kanpur, he
spent two years at the Project Finance Division
of ICICI Ltd before moving to Corporate Banking
in ICICI Bank where he spent three-and-a-half
years in various capacities. We decided to find
out from him what it’s like to use StarOffice and
MS Office in tandem.

It’s All About The Money...
Apnaloan.com started in 2000 with the tradi-
tional MS-based Office Productivity environ-
ment. It was not until 2003 that they started
looking at alternatives, mainly from a cost per-
spective. The licensing cost for MS Office is
around Rs 8,000 per license for the Small Busi-
ness Edition, while the Professional Edition
retails at around Rs 12,000. In con-
trast, StarOffice 7 retails

Can you imagine life without MS Office? Is there an alternative? StarOffice could just be the answer 
you are looking for

The Other Side

M
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Apnaloan.com now stores its information in
both formats. Moreover, since many of its cus-
tomers, vendors and business partners con-
tinue to work with MS Office, the challenge was
to internally work on a new environment,
but make it seamless with respect to external
communications. Naturally, this took some
time to stabilise.

Compatibility Issues
“When migrating from one environment to
another, compatibility issues are to be
expected,” says Patankar. While StarOffice
allows one to save files in MS formats, retrieval
of those files within the MS Office environment,
at times, results in changes in templates, text
and graphics. Also, when a file stored in MS
Office is opened in the StarOffice environment
through the ‘Import’ option, there were issues,
particularly with Excel Sheets containing Pivot
Tables, Macros and Graphs and with PowerPoint
files containing embedded worksheets or
graphics. Some of these issues are as yet unre-
solved, although there is a clearer under-
standing of the problems.

So how comfortable are users with StarOffice
now? “Users who have started using StarOffice
from day one have no issues. However, people
who have shifted from MS Office to StarOffice
sometimes feel that MS Office is easier for cer-
tain functions, though, they have now adapted
to StarOffice,” says Patankar.

He adds, “Apart from productivity software,
e-mail is a way of life in organisations and
people are comfortable with the MS Outlook e-
mail client since some features in it are not yet
available with third-party mail clients. One can
use Netscape or Mozilla with StarOffice but
there are limitations with these clients. For
instance, options such as ‘Calendar’ or ‘Sched-
uling’ are not available with Netscape and
those who are used to these have taken it 
for granted and find it difficult to adjust
without them.

“Such issues need to be resolved before alter-
natives to MS Office can become really popular.
I also expect organisations to start evaluating
Linux-based Office productivity applications as
they become more mature,” Patankar states.

So Should You, Or Shouldn’t You?
So would Patankar recommend StarOffice to
other, similar organisations? “They should cer-
tainly use it for people who primarily need to
work on documents. However, for heavy users of
presentations and/or spreadsheets, there is a
fair amount of re-training that will be required
and organisations should factor that cost into
the Total Cost of Ownership (TCO) computa-
tion,” says Patankar.

At the end of the day, though, Patankar feels
that there has certainly been some cost saving.
“There has been a saving in licensing costs that
outweighs the incremental cost in training or re-
training. Also, the benefits will further increase as
the knowledge base has grown sufficiently, and
the incremental training effort and cost would be
lower as compared to the initial cost.” 

ram_mohan@thinkdigit.com
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for $60 (approximately Rs 2,700) per license
when purchased in a 25-user pack for SMEs.

Before implementing it on a large scale,
Apnaloan.com evaluated both StarOffice and
Open Office—and decided to introduce StarOf-
fice in the organisation in late 2003. It’s been a
year already, and Aplaloan.com now uses a com-
bination of both. 

But the question is, why use MS Office at all
if you are migrating to StarOffice? Patankar
answers that even if Apnaloan.com uses StarOf-
fice, many of its customers, business partners
and associates continue to use MS Office. There
are still some compatibility issues with opening
and importing MS Office documents in StarOf-
fice and vice-versa. Hence, there is a need to
maintain MS Office for external communication.
Also, when the transition from MS Office to
StarOffice was done, Apnaloan.com already had
licenses for MS Office, and it made sense to con-
tinue to use the existing licenses and only add
StarOffice incrementally.

Resistance To Change
If one were to consider pure functionality, StarOf-
fice is similar to MS Office, give or take a few fea-
tures. However, when looking at deployment,
Apnaloan.com had to consider several issues.

First, a significant re-training effort was
required—even though the overall functionality
is similar, the user interfaces and the way menus
and functions are used is different in StarOffice.
More than the re-training, overcoming user
resistance to change was a stumbling block.
People were used to working with MS Office and
it was difficult to make them abandon the com-
fort level they enjoyed.

“Almost all training was done on-site. We
subsequently set up a small StarOffice migra-
tion-cum-support team in-house, whose mem-
bers developed more expertise through
self-study and by resolving user issues through
research. This was documented and used in sub-
sequent training. The focus was on identifying
the issues faced by users during the transition
and providing solutions to these problems,”
informs Patankar.

The Switchover

Understanding the differences between StarOffice software and
Microsoft Office will help you anticipate the key challenges

involved and determine the best migration option for existing
documents, templates and business applications. Depending on
the complexity and value of existing files or custom solutions, the

options range from archiving to converting to re-engineering source code.
The main steps of the process are:

MS Office documents and templates must be converted to the StarOffice 
software file format.
Existing scripting and custom solutions must be migrated.
Current business rules and processes may have to be adjusted to take full 
advantage of StarOffice 7 Office Suite features.
In addition, key architectural differences between these two application 
suites can affect the way they process and store information and data. 
However, because the suites also share many similarities, it is possible to 
make the switchover nearly transparent to most users.

Extracted from the whitepaper entitled ‘Migrating to StarOffice Software from Microsoft Office’,

available at www.sun.com/software/whitepapers/staroffice/SO7Migration_wp.pdf

There has been a
saving in licensing
costs that
outweighs the
incremental cost 
in training or 
re-training

Parag Patankar
CIO and director,
Insurance,
Apnaloan.com
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How To Manage
Your Inventory

In order to switch over from manual inventory
management to software-based management, the first
step is to list and catalogue all supplies. From there
onwards, you only need to catalogue and sort when new
supplies arrive. 

All the details you entered for each item are encoded into a
unique bar code, which the computer will print out using a bar
code printer. All you have to do is stick these bar codes on each
medicine box / bottle.

The cataloguing process is just a matter of entering data into a 
computer. In this example—the chemist’s store—the fields to
be entered may be:

Name of medicine
Category of medicine (e.g. Cough Syrup)
Amount currently in stock
Cost per strip / bottle
Date of manufacture
Expiry date
Location of storage

A

Every business needs to have a customised Inventory Management software in place.
A bold statement, but one backed by hard fact. As an example, we look at how a chemist can
benefit from it, in terms of both time saved and the hassle avoided
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All you need to do is finalise a sale and
the computer prints out an itemised bill
with the name of the medicine, amount
purchased, cost per strip / bottle, and the
total cost

A customer hands you a doctor’s prescription. All you need to
do is punch in the medicine name into your computer.

The computer informs you of the following:
Whether you have the medicine in stock
How much you currently have in stock
When the medicine expires
Where in storage is it located

Once you have gathered
all the medicines that the
customer was prescribed,
you just use a bar code
scanner to read the bar code and
finalise the sale. Totalling is done
automatically, and the software
automatically reduces the inventory
by the amount of goods sold

The inventory management software
helps you keep a track of what you have
sold and what you have bought. It will 
give you an overview of your sales
figures in a snap.

The software also helps you develop a balance
between supply and demand. It keeps a track of
what sells more and what doesn’t sell at all, in
order to ensure that you never have an excess
of one product or too little of another. It can
also warn you when a batch of goods is nearing
expiry, so you can order fresh supplies in time.

You can also keep tabs on your
suppliers, comparing cost versus
efficiency per supplier

Infographic Shyam Shriram, Text Robert Sovereign-Smith
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ensures this while eliminating calculation mis-
takes and reduces the probability of human
error as opposed to the manual accounting
system. Moreover, FA software reduces paper-
work even further, as reminder letters, invoices,
statements of accounts and other documents
can be e-mailed, thus saving time and postage.
Popular FA software has forsaken the outdated
MS DOS environment for a complete Windows-
based accounting system.   

FA Software For SMBs
FA software is more comprehensive and differs
from software that can be used only for specific
purposes such as taxation or payroll.
Accounting software needs vary, from those of
individuals to those of large, corporate enter-
prises. We talk here about FA software intended
for small and medium businesses (SMBs).

Make Way For VAT
It’s an eventful time for SMBs, with the finan-
cial year-end looming, coupled with the imple-
mentation of the long overdue Value Added Tax
(VAT) from April 1, 2005. A form of sales tax paid
on products and services at each stage of dis-
tribution, based on the value added at that
stage, VAT will figure in the ultimate cost to the
consumer. An indirect tax, the VAT regime aims
to increase tax compliance and will spare no
one. What implications will the introduction
of VAT have on accounting procedures? 

Prakash Surte, a lawyer and a tax con-
sultant, offers, “As with the enactment of any
taxation act, VAT may lead to a disgruntled gen-
eral public. Nevertheless, it is a good move as all
the earlier sales tax acts will be repealed and
VAT will take their place. Originally meant to be
a uniform rate, the VAT will vary as per com-
modity and state. Remember, VAT falls under
the purview of the State and not that of the
Central Government. Once VAT is implemented,
the maintenance of accounts will change to an
extent, since the sales tax-related provisions
and incidence of taxation will have to be cal-
culated differently.”

The majority of the FA software in the
Indian market is home-grown. Tally, EQA,
Accounts 21, Wings Accounting and S’Tax are
popular packages. Digit spoke to vendors of FA
software and to end users to get a snapshot of
what’s in and what’s not for SMBs. 

EQA
Expert Quick Accounting, or
EQA (www.compubrain.net), is
equipped to handle manufac-

turing, trading, excise, point of sales, sales tax
and warehouse management, and VAT, too.
EQA was made VAT-compliant last year, taking
into account the reports,  returns and forms
that would have to be filed state-wise. Vikas
Chitlangia, MD, Compubrain India Limited,
developers and marketers of EQA, says, “EQA is
customisable. The user can tweak it and set the
‘master’ as per his requirements. The propri-
etary database is in .eqa form and is compatible
with other software. The ‘report designer’ fea-
ture enables preparation of invoice and

Renuka Rane

ourtesy the ubiquitous business
accounting software, the thick, dusty
ledger is no longer a part of the modern

office. One need not be a geek to be able to
handle Financial Accounting (FA) software.
Numerous user-friendly versions sell like hot-
cakes while upgrades and enhancements act as
the proverbial icing.

As per the universal rule of the double entry
system of bookkeeping, each debit should have
an equal and corresponding credit. FA software

DIGIT FEBRUARY 2005
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The
Money
Managers
As VAT looms large, small and medium business need
to gear up for the new tax regime. Is your financial
accounting software up to speed?
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delivery challans, reminder services, monthly,
quarterly and annual reports. If changes occur
in the format of the returns, we provide free
upgrades to existing users for one year.”

According to Akshay Kurwa, Partner, Kurwa
Rubber and Valves, Mumbai, “The rigidity that
is otherwise observed in other FA packages is
absent in EQA, which is very easy to operate.
However, some features that I needed are yet to
be incorporated. Since, we receive good after-
sales support and regular upgrades, I am sure
this issue will also be resolved.” However,
Manish Purohit, operations manger, Creadent
Solutions, Rajasthan, has not been so fortunate.
“Although EQA is a useful product and is
packed with features, after-sales service needs
to be improved. I am still waiting for the fea-
tures the vendor promised.”

Tally 
Tally (www.tallysolutions.com)
is hugely popular due to its
speed, simplicity, power and

flexibility. Incidentally, Tally was the first FA
software to introduce the no-codes concept i.e.,
it accepts alphanumeric characters for
accounts and inventory masters. Satish T,
advisor, Tally Solutions, says, “The Tally Audit
feature allows the finance manager to check
the time, date and accuracy of entries. This way,
malpractices can be detected and errors recti-
fied. Tally is VAT-compliant. It is running suc-
cessfully in Europe, the middle east and
south-east Asia, where VAT is the norm. Imple-
menting the same in India is not an issue.”

Various add-on features and upgrades can
be downloaded from the Tally Web site. For the
financial year 2005-06, Tally plans to upload
VAT, e-TDS, TCS, service tax, payroll, mobile
device support, multi-lingual software, port-
folio management and e-banking. 

Tally ees 6.3 enables exchange of information
with non-Tally systems using XML, the industry
standard for data interchange. It enables the user
to share data across locations—with extended
enterprises (“ees” stands for Extended Enterprise
System) including customers, bankers, business
partners and other associates. The protocol sup-
port for Tally is customised to business-specific
needs and integration with SAP, Oracle and other
external software is possible.

Vinod Nair, Navi Mumbai based chartered
accountant has been using Tally for the last six
years. “I experimented with other FA software
before I settled for Tally. Tally supports good
browsing speeds. The hundreds of reports that
are generated daily can be easily exported to MS
Excel. Unlike other custom-made accounting soft-
ware that could be easily tampered with, Tally has
rigid security control. Of course, for human
errors such as mistakes made by accountants,
only the audit trail can reveal discrepancies.” 

EX Personal 
Accountant 
A product from the Tata stable,
EX PA (www.myexonline.com)

was created specifically for growing businesses.
EX PA is enhanced by the latest technology and
an extremely easy-to-use user interface. It is
equipped with readymade templates to suit
specific business lines. The ‘Smart Folder’ con-
cept allows tracking of items/customers/sup-
pliers and related information with a
drill-down facility. EX PA has over 70 reports
specifically designed to meet statutory and MIS
needs. It helps perform ad hoc queries on data
that make it ideal for auditing. Mr Natraj, mar-
keting manager, TCS (Bangalore), says, “EX Per-
sonal Accountant is a user-friendly FA package
and is compatible with SQL and Excel. Once the
VAT formats are ready, we will upgrade the 
current version.”

Wings Accounting
Wings Accounting (www.wings.
be) was the winner in Digit’s
review of FA software in the

country in July 2004. Wings Accounting offers
several tools to help businesses automate their
finance and accounting functions comprehen-
sively; it can work in any world language and is
also VAT-ready. It helps account for VAT payable,

Client information
Receivables and payables
TDSVAT (April 2005 onwards)
Salary payouts
Sales and purchases
Order management
Inventory management (for trading firms)
Customisability report and invoice generation
Budgeting production 
Incorporation of items subject to different tax

rates in one bill
Technical support and after sales service 

Ask For These in FA software

Tally is popular for its speed, simplicity and flexibility

In case changes
occur in the
format of the
returns, we
provide free
upgrades to
existing users for
one year.

Vikas Chitlangia, 
MD, Compubrain India
Limited (for EQA)

Accounting Software 
EQA
Wings
S’Tax
Account 21
Tally ees 6.3

Price (Rs)
3,000
5,000 onward
10,000
4,950 onward
4,500

Price List
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input credit and accounting. It generates all
information to help prepare and file returns for
VAT. Existing users can easily upgrade to Wings
Accounting that is VAT inclusive. Wings
Accounting will generate VAT returns directly
once the formats are finalised. Wings has spe-
cial features for NGOs and the apparel and
footwear industries. Multi-layered security,
report writer, forms and invoice designer, multi-
locational accounting, confidential accounting
etc. come with Wings Accounting.  

Sutinder Singh, director, PCH Marketing,
Hyderabad, says, “We have been using Wings
Accounting for the last 20 years, starting with
the DOS version. Reports can be printed in any
format. Wings is web-enabled and can handle
large quantities of data. When the Windows
version of Wings was introduced, we were
apprehensive and switched to Tally for six
months. We had to revert to Wings, which is an
excellent FA package for SMBs.” 

Account21
Anyone familiar with the basic
accounting system can work
comfortably with Account21

(www.topsyssolutions.com), a Windows-based
application. Balagopal Karat of Topsys Solu-
tions, developers and marketers for Account21,
says, “It handles billing and inventory control
and users can define the format. Certain
reports can be e-mailed directly. Account21 has
an open interface and data can be imported or
exported to and from Excel and CSV.” Users can
purchase Account21 versions as per the func-
tions of each product—invoicing coupled with
multi-currency and/or inventory (for trading
/manufacturing).

Vidhya Dhandapani, Accountant, Kropex
India Ltd, Bangalore, says, “Account21 is user-
friendly with diversification for inventory con-
trol. For instance, we deal in 6,000-odd items
subject to different rates of taxation. This
results in numerous calculations that are now
easy to handle thanks to Account 21.  It is also
VAT-ready, we will just enable that feature
once VAT is implemented.”

S’Tax
S’Tax (www.sinewave.co.in) is
an accounting software used
for filing Central Sales Tax

(CST) and Maharashtra Sales Tax (MST)
monthly, quarterly or annually, depending on
the assessee. Priced at Rs 10,000, it includes
the various forms required for sales tax pay-
ment and offers a standard facility to import
data from other software. S’Tax is a product of
Sinewave Computer Services Pvt Ltd. Anil
Moolani, Director, Sinewave, says, “In a
month’s time, S’Tax will be equipped with the
facility to calculate VAT. Present users 
of S’Tax can get upgrades that contain VAT 
modifications, either online or through the
CDs we dispatch.”

K K Gada, a CA in Mumbai, has been using
S’Tax for the last five years. Gada states, “S’Tax
efficiently calculates sales tax liability, files
returns in the prescribed format, prints challans
for tax payment, and so on. S’Tax has made client
management easier. Once the modalities of VAT
become clear, we will just have to incorporate VAT
in some aspects of the accounting procedures
(where the amount is to be set off). Other basic
accounting principles would remain unaffected.
We keep receiving upgrades from Sinewave for
S’Tax, Tax Base and even Service Tax. We will
simply have to get the upgrade for VAT.”

The Last Word
Download a fully-functional demo version of
the FA software from the vendor’s Web site, or
get it totally free on request. This allows you to
test the functionality before buying. Steer clear
of pirated versions that may contain viruses or
have inadequate documentation. Also, users of
pirated software are ineligible for technical
support and upgrades. While upgrades are not
an issue, after-sales service could be a sore point
in some cases. However, registered users can
obtain online technical help from the call
centre of the vendor. The verdict: SMB users of
FA software seem to be a contented lot, albeit
after some experimentation.

renuka_rane@thinkdigit.com

Wings Accounting provides total VAT compatibility 

Account 21 is easy to use and has a diversification for inventory control

Unlike other
custom-made
accounting
software that
could be easily
tampered with,
Tally has rigid
security control

Vinod Nair, 
Chartered Accountant,
Navi Mumbai
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place to suit today’s techno-
logical needs. This could, in
fact, even help save some
money in the bargain. Let’s
look at the various parts of
an office that could be truly
‘IT- enabled’.

The Cubicle
Cubicles today are typical—
they have a computer, a
telephone, sometimes a
printer, almost never a
scanner and a soft board.
Space for the person
working in the cubicle is
at a premium, and he or
she has to manage space
and  devices efficiently.
While a printer is a
necessity, a scanner
might not be required
as frequently. 

However,  arming
every cubicle with a
printer could  cost
the company much
more, apart from
cramping up the

cubicle. 
The solution here is simple.

Space could be freed up in a cubicle by
strategically placing a multifunctional device
(MFD) so that four or more workers in a partic-
ular bay could use it. This would also reduce
hardware costs in terms of peripherals and
maintenance.

Space in the cubicle could be further
enhanced by replacing the existing CRT mon-
itor with an LCD one. These certainly take up
less space, and although they cost more that
would be recovered from the power savings
they offer.

Today’s executives are tech-savvy and would
surely appreciate the extra space made avail-
able to them. They have enough devices they
would want to either sync with the computer or
simply have at hand at work. 

Some devices that are now commonplace
with today’s on-the-go executives include a
PDA, a cell phone, digital camera, pen drives
and more. The computer in his or her cubicle
should have at least two USB slots to accom-
modate two of the above devices at a time.

There are enough executives who would like
to sync their PDA with their computer and cell
phone, and add digital images in a presenta-
tion saved on the pen drive!

But is this a practical way of working?
Sandeep Mehrotra, sales manager, Adobe Sys-
tems India, says, “I think offices that incorpo-
rate technology in a big way will not only reap
benefits in terms of saving costs but also see a
great deal of increase in productivity. Tech-
nology will be an enabler in making the office
an enjoyable and comfortable environment.”

V Krishnan, general manager, consumer
sales, imaging and printing, HP India, agrees:
“A tech-intensive office will definitely involve a

Aditya Kuber

he agricultural age was based on ploughs
and the animals that pulled them; the
industrial age, on engines and the fuels

that fed them. The information age we are now
creating will be based on computers and the
networks that interconnect them.

Folks at Sun Microsystems can now say, “We
told you so”, and everyone would have to agree.
Their famous punch line “The network is the
computer” is slowly coming true with the work-
place undergoing a major upheaval since the
early days of the computer. But merely having
a computer and a printer connected on a net-
work are not enough to say that your office is
IT-enabled. 

With today’s technologies, the use of var-
ious devices in tandem can help you get the
most for your business. 

According to researchers at IBM, nearly 70
per cent of all work is collaborative in nature
and only 30 per cent is done individually. Why,
then, are most offices still made up of indi-
vidual desks?

Most offices would do well to optimise the
way employees work by refurbishing the work-

DIGIT FEBRUARY 2005
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You want to tech-enable your office, and don’t
want to waste money on unnecessary expenditure.
Here’s a primer to get you going on the right track
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of ensuring you never forget. At any given
point, at least one of the devices would be with
you. So even if your PDA is in your bag, the cell
phone would remind you of a meeting or a
birthday. This job could also be carried out by
the secretary and you need not worry about
missing another appointment.

In fact, if your PDA is e-mail compliant and
can support MS Word, Excel and PowerPoint
files, you need not worry about not having a
file during a meeting. 

You could ask your secretary to e-mail it to
you. You could then download it using either
Bluetooth or Infrared, and you’re good to go!

Tomorrow’s Office
While these setups are possibly enough in
today’s scenario, imagine having an office
where anyone could sit in any cubicle without
having to worry about any kind of setup.

Given that all cubicles are identical in size
and have the same hardware, employees could
simply choose the cubicle closest to their team
with every change and their data, e-mail and
extension would follow automatically. How?

Your identity card would be the most impor-
tant tool at work. With every cubicle being
identical, there would be a swipe facility out-
side the cubicle. Simply swiping your ID card
would mean that the computer in that cubicle
would open your e-mail account and personal
settings and the Internet phone in the cubicle
would simply assume your extension. 

This process repeats every time you change
your cubicle. With all your data on the network
and safely encrypted, the only thing you need
to carry around is your coffee mug! 

All this sounds good but isn’t it a little
fancy? “A number of functions in today’s situ-
ations can only be performed using intelligent
devices and hence, technology and gadgets can
only help augment the mental capability of an
individual and help perform his/her tasks far
more efficiently,” says Krishnan. 

aditya_kuber@thinkdigit.com

A tech intensive
office will
definitely involve a
fair amount of
initial investment...
But a well-linked
and well-designed
office will pay back
the investment 
in a short span 
of time
V Krishnan
General Manager -
Consumer Sales, Imaging
and Printing, HP India

fair amount of initial investment and hence,
the start-up operation will be more expensive
than the conventional non-tech office. But, a
well-designed and well-linked office will be
able to pay for its investment within a short
period,” he says.

The Conference Room
What can easily be called the great coliseum in
an organisation, the conference room is one of
the most important areas. Given today’s pres-
sures and tech-readiness most employees have,
the room should not need to be “prepared”
before each meeting.

Some of the most important aspects of a
conference room are the projector, projector
screen, a computer for playing presentations, a
phone with conferencing facility and a video-
conferencing facility. 

The layout of the conference room must be
conference-friendly and the computer should
ideally possess the following: a DVD combo
drive, USB ports, memory card slots and a lot of
RAM so that the presentations don’t drag
around. Remember, this is also the room where
you would possibly be making an impression
on the client. So let ’er rip!

A good projector is a long-term investment.
But having the right one to suit your needs and
your conference room is a major task. While
the range of projectors available is vast, you
need to make sure you get just the right one
for your office. (Refer the January 2005 issue of
Digit for more on projectors)

Videoconferencing is gaining in popularity,
and if you could “meet” with the client
without having to leave your office, what a way
to save time and money!

Says Yugal Sharma, country manager,
Polycom India, a video conferencing major:
“Video conferencing boosts productivity—there
are no two ways about it. Executives globally,
and even in India, have reported benefits
thanks to faster decision-making, improved
employee morale, improved access to the best
talent, reduced time to market, better cus-
tomer responsiveness, more efficient work
practices, fewer concerns about travel prob-
lems, and a greater focus on results overall.
And, of course, measurable costs like travel and
accommodation are reduced.”

The Boss’ Room
Contrary to what you might think, bosses do
have a lot of work, and therefore, require all
the space and gadgets they normally have in
their rooms! An ideal room for a boss would be
a hi-tech, efficient place where things happen
at the touch of a button. 

As boss, you probably carry a range of
gadgets, and with good reason. Your laptop,
cell phone, PDA, pen drive, and a whole lot of
data spread across these devices is your lifeline.

You also need to attend a lot of meetings
and keep track of a variety of other intra-office
activities and events including birthdays,
anniversaries, appraisals and more. How does
one person accomplish all this on time? Syn-
chronising data on various devices is one way

Digital Business l Smart Business
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Trends

When  Will

“We work mainly on Windows NT
and 2000 operating systems. We
plan to shift to Windows 2000

completely, but not as of now. We have around
100 people in the organisation and only about
25 per cent of them use computers. We use MS
Outlook and MS Office, and most of our work
is done on word processors. We use McAfee
Antivirus that is updated daily. If we are to
upgrade the OS, it would be based on our
requirements. We will look at the best
software for upgrading. If the business
demands it, it will be done, otherwise we
simply cannot splurge, as upgradation
involves additional expenditure for training,
hardware and others—all incidental.”

“We work on the Microsoft
platform. The OS comprise
Windows 95, 98 and XP. We use

Mcafee Antivirus that is periodically updated.
While it is not possible for all systems in the
office to be updated regularly, all are at par
within a month’s time. Our office work is
spread across 70 locations with nearly 300
machines on the network. Maintenance is
mostly done in-house and only maintenance
for hardware is outsourced. Our MS Office
usage is largely restricted to MS Word and MS
Excel. Only if there is an absolute need for
our business, will we upgrade the software.
At present, the work doesn’t demand it.
Besides, when we upgrade our software, we
will invariably have to upgrade 40 per cent of
our  existing hardware as it will not support
the new software. 

“We have introduced Citrix for remote
computing and management to save costs.
We may not upgrade every system in the
office, as some software that works best on
98 may not do so on XP. The decision to
upgrade will depend on various factors. More
importantly, will there be an increase in
productivity after upgradation? If the reports
promise an upswing in productivity then it
makes sense to upgrade. There must be logic
to support the change.”

Amay Choudhary
Corporate IT Manager

Virendra Vishnu
Manager, Corporate IT
Operations, AVL India
Software Pvt Ltd 
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Businesses, more often than not, take a long time to switch over to newer versions of
software. Five industry experts tell us why they don’t upgrade fast
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Gopal Patkar
Sales Manager, Business
Link Automation India Ltd

Hari Vishwanathan
IT Head, Bhatia Hospital

“Most of our work is done in the Microsoft environment.
We are currently using Windows 98 and Windows XP.
Norton AntiVirus helps keep the systems safe and it is

updated weekly. Our network comprises 13 users, so it’s not very
complex. We have outsourced maintenance to a team of service
engineers who also help us make upgrade decisions. They know our
systems thoroughly and can recommend what is required. Majority
of our in-house designers use tools such as Corel and Photoshop.
Currently, we have deployed Outlook Express on all systems. We may
opt for an upgrade, provided it helps improve the speed and
efficiency of our employees, more so, when we are handling
multiple projects and have to cater to our customers’ demands. In
our line of work, the customer is very important and it is imperative
to meet deadlines. We will upgrade only if there is a requirement
for the new software and it is cost effective. If the new software
helps us deliver better, will it make sense.”

Hemang Desai
Proprietor, IND Advertising

“We have offices across six metros, mainly used by our
technical experts who provide technical support for HP,
IBM, and so on. At our office, we have a network of

nearly 125 computers. While we work on Microsoft and Linux
platforms, we use the former more than the latter. We use Windows
2000 and 2003 Server on our systems. We use Norton Symantec that is
updated on a weekly basis. MS Outlook is used for e-mails. Whenever
any upgradation has to be done, the first thing we will take into
account is user convenience. As far as possible, we would like to avoid
down time. Other factors that are equally important include costs of
training, support and hardware. All this has to be carefully planned.
At the same time, we allocate a budget every year for training and
upgradation. We will upgrade only if it is followed by an increase in
productivity. An increase in productivity can be achieved only if there
is improvement in user efficiency and the end result of all this should
be increase in revenue.”

E-mail: preethi_chamikutty@thinkdigit.com

You Upgrade?
“We use the Windows NT and 2003 Server in the hospital.

There are 100-plus machines on the network and their
maintenance is done in-house. I am aware that the

support for NT has been withdrawn by Microsoft. Nevertheless, I am
confident that my in-house team is well-equipped to handle any
problems. As far as I know, the systems on NT are not exposed to any
security risks. They are mainly on the Intranet and hence, not as
vulnerable. We use Norton AntiVirus and upgrade it as and when
new definitions are available. We use only licensed copies of
software and there are no pirated versions. We don’t mind getting
newer versions of software provided there is a demand for it.
Training the staff on new versions is not an issue. We will focus on
improvement in efficiency and productivity following the
introduction of anything new.”
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Online Advertising v/s Offline Advertising
With online advertising emerging fast, we find out if it is better than offline

Shaadi.com is a matrimonial services provider, which
started operations in 1997. The company created has
succesfully created a new industry—online matchmak-

ing. Today, we have over two million members and record
over 200 million page views per month. We are present
online and invest considerably in online advertising. 

“Online advertising is important to us since we are an
online entity and the products and services that we offer
are all available online. At present, we advertise offline in
local trains, TV channels and other mediums. It is difficult
to say how much we spend on each medium but it does
amount to a few crores.

“In online advertising, we can clearly set our target audi-
ence as we know their interests, age and gender. This is not

possible in offline advertising as we do not know who exact-
ly we would be catering to. A mixture of online and offline
advertising is necessary, which is enabled by technology. 

“In online advertising, we can be sure that the user has a
need and there is the option of offering him exactly what he
wants. Online, we can customise what we offer to the shop-
per. Just a few basic questions to understand his needs and we
can offer him a deal accordingly. Moreover, the online
method is measurable. We can know where the customer
learnt about us. For online customers, more information is
just a click away. They can go to a specific option, click on it
and get additional data. Even when we offer something to the
customer online, we can ask him some details such as his
interests and spending limit and then offer a product.

“We cannot afford to ignore offline advertising totally
though, because the older age group of the population who
try and fix alliances still prefer to scan matrimonial ads in
newspapers—and this is quite a large number. Besides, there
are a few drawbacks with online advertising, the major one
being inadequate penetration of the Internet. Internet usage
in villages is much lesser than in metros, which makes it dif-
ficult to reach that segment.  Bandwidth problems in India
make matters worse. We use Flash and interactive media in
our online ads that are data-heavy and may not load proper-
ly if the bandwidth is not supportive.”

Creative has been in the Indian market for the past
16 years. Initially, we produced only sound cards
but today, we have a wide range of products from

sound cards to multimedia kits, CD-ROMs, speakers and
even MP3 players. Creative be credited for converting the
PC from a calculating device to an entertainment unit. 

“Strategically, we do not allocate any budget for online
or offline advertising. However, we advertise offline in a
major way as we have been getting good results from it.
We advertise in IT magazines and to a certain extent, in
lifestyle magazines. It wouldn’t be useful for us to
advertise in glamour magazines as their readers are not
our target audience.

“I think combining offline and online advertising

would provide the desired results as we would be able to
reach out to a wider group. In India, people still use dial-
up connections to access the Internet and more so for
checking e-mails. If online advertisements are data-heavy,
it may be a problem to view them.

“The advantages of offline advertising lie in the
placement of the ads. If an ad is placed in an IT magazine,
you can be sure that it will reach your desired audience. If
you advertise in a particular magazine regularly and there
is a set pattern or way of presenting your ads, you can be
sure that the customer would definitely notice the ad
whenever he flips through the magazine.

“The drawback in offline advertising is that if the
customer have missed your ad in the newspaper t oday,
he has probably missed it forever. Besides, if he were to
see an ad with some offer for a particular time period,
he would not be eligible for it at a later date. Hence, the
impact of the ad is lost.

“Also, once printed, the ad cannot be changed. If you
want a different ad to appear, it means an additional
expenditure. On the other hand, if you have a 30-day
contract with a portal, you have an option of changing ads
every 10 days at no extra cost.”

As told to Preethi Chamikutty (preethi_chamikutty@thinkdigit.com)

In online advertising, we can
clearly set our target audience

The advantages of offline advertising
lie in the placement of ads

Rajshekhar Bhatt
Sales and Marketing Manager
(India), Creative Technologies 

All the four P’s of market-
ing— product, price, place-
ment and promotion—can
be implemented online,
which is not possible
offline

I feel innovation is required in
offline advertising. It is very
essential to educate the reader
about the product and the
more ways you do that, the
better

Vibhas Mehta, 
Group Partners Relation
Manager, Shaadi.com 
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Meera Vankipuram

It was almost as if the ocean had
decided to make itself heard
against the incessant abuse it

had been facing for centuries. In
one of the worst natural disasters
ever, the tsunami that originated
near Indonesia and went on to
ravage almost 10 countries in
south-east Asia, the ocean let us
know its might. Any or relief effort
thereafter seemed
inadequate when

compared with the might of the
catastrophe. Amidst all the chaos,
even the marvel that is technology
could not come to the rescue.

In hindsight, though, a signif-
icant number of the causalties
could have been avoided had
India availed membership of the
Tsunami Warning System (TWS)
in the Pacific. The TWS monitors
seismological and tidal activity in
the Pacific Basin and dissemi-
nates earthquake and tsunami
warning information to its 26
member states within a matter of
hours in case of an impending
disaster.

Reports now indicate that even
without the warning system, India
had at least 40 minutes after the

Technology Beyond WorkMinister
Sharon Stone

Prince Of
Persia143 164
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first waves hit the Andaman
Islands to send out warning signals
to coastal areas.

When disaster struck Indian
shores, conventional communica-
tion systems were the first casual-
ties. In the face of adversity of
mammoth proportions, technol-
ogy came to the rescue not only in
mainland India, but also in Sri
Lanka, the Andaman and Nicobar
islands, Thailand and Indonesia.

The Web Of Hope
As the water rose, mobile and land-
line networks capitulated. Phone
calls were not possible. Strangely,
though, SMS worked. Those who
were not washed away by the
waves were able to reach relatives

only via SMSes. Bloggers

Touched By Tech

How technology lent a helping hand to relief operations in mainland India, Sri Lanka,
Thailand, Indonesia and the Andamans
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The Ocean Rises
“The sea—this truth must be
confessed—has no generosity. No
display of manly qualities—courage,
hardihood, endurance, faithfulness—
has ever been known to touch its irre-
sponsible consciousness of power.” 

—Joseph Conrad



worked overtime to broadcast the
situation in their countries.

Thai local Paola di Maio,
along with netizens in India and
the US, set up the South-East Asia
Earthquake And Tsunami Blog—
www.tsunamihelp.blogspot.com
(see box above), which was a reli-
able source of first-hand infor-
mation on the devastation
wrecked by the tsunami. This
and other community blogs have
helped people search for their
loved ones.

Relief efforts that needed
massive coordination of
resources and manpower
received an impetus from online
information hubs set up by
Google (www.google.com/
Tsunami_relief.html), the popu-
lar Web directory BoingBoing
(www.boingboing.net) and photo-
blogs and news feeds (www.
2bangkok.com/quakes.shtml).

Voluntary sector and media
organisations in India and abroad
also put up several online notices
for donations. The task of search-
ing for missing relatives and fund
raising is being coordinated by
BBC News online (http://news.bbc.
co.uk/1/hi/ talking_point), UNICEF
(www.unicefusa.org/Tsunami),
CNN.com (www.cnn.com/2004/
WORLD/asiapcf/12/28/Tsunami.

aidsites), Amazon.com, The Hindu
online (http://pay.hindu.com/thrf-
pay/thrfpay.jsp) and NDTV.com. 

Radio To The Rescue
The unassuming transistor radio
proved to be a life-saver for locals
in the Andaman and Nicobar
islands and Nagapattinam district
in Tamil Nadu, two of the worst
hit places in India, to receive
warnings—and later, information
from the Government and NGOs.

A group of amateur radio oper-
ators (‘ham’ radio) had embarked
on an expedition to the Andamans.
Gopal Madhavan of the governing
council of the Amateur Radio Soci-
ety of India, says, “When the earth-
quake and tidal waves hit the
island, the phone and electricity
went off and only the ham
network stayed alive.” Powered by a
12-volt car battery, the group set up
their equipment in Port Blair in
about three hours.  They had access
to nearly 35,000 hams globally. 

Ham operators started an
emergency network and coordi-
nated relief efforts with the
Indian Army and voluntary agen-
cies. Makeshift radio stations
were set up in tsunami-hit areas
of Tamil Nadu with control
stations in Chennai, Bangalore,
Kolkata and Delhi. They are now
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assisting rescue efforts and trying
to find missing persons in the
islands and also coordinating
with counterparts worldwide.

Rising To The Occasion
Mobile service providers in Sweden
and Denmark waived incoming
and outgoing call charges from
south-east Asia for 48 hours post-
tsunami to help survivors reach
their families. In Sri Lanka and
other nations, phone companies
used call patterns to track users
and send SMSes—the  responses
helped trace stranded tourists. 

Rudimentary Databases
IT experts from Bangalore, Shriram
Raghavan and Sudhakar Chandra,
came to the tsunami-hit Cuddalore
district, TN, to help relief work but
soon realised the lack of a nodal
point for co-ordination. 

They used MS Excel and created
a database of supplies and donors
and generated reports.         Ragha-
van states, “We had barely three
hours to create the database. We
then trained two volunteers and
handed the database to the local
District Rural Development
Agency (DRDA) officials.” 

Evidently, technology is helping
make amends. 

meera_vankipuram@thinkdigit.com

Blog buddies Peter Griffin, Rohit
Gupta, Dina Mehta (from India), Bala
Pitchandi, Megha Murthy (USA) and

Paola Di Saio (Thailand) set up the South-
East Asia Earthquake And Tsunami (SEA-
EAT) Blog—www.tsunamihelp.blogspot.
com. Digit spoke with Peter Griffin on how
the blog aided relief and rescue efforts. 

How did the world get to know about
SEA-EAT? 
A day after the tsunami struck south-east

Asia, Rohit and I decided to set up a
collaborative blog that would try to link
people who wanted to help with those
that needed help. Fortunately, we had
great media support right from the start.
Popular sites like Boing Boing, Smart
Mobs, InstaPundit and Rediff wrote about
SEA-EAT. So far we have received nearly
400 e-mails from people offering or
seeking help. 

How did you deal with the information
overload?
As the team grew, suddenly there was
way too much information on the blog.
Since Blogger didn’t support ‘sub-blogs’,
we installed a Wiki to sort the info and
make the site easily navigable. 

Our News Wiki team received a lot of
‘this is not journalism’ flak, though.
Someone then purchased the URL
(tsunamihelp.info), someone else
donated server space. We were using a

free search tool (Pico), which could
search up to 250 posts; 
but later someone ‘donated’ us a paid
search tool.

SEA EAT also seems to have inspired
‘cyber-volunteerism’.
The blog had to be updated round-the-
clock. When someone in India went to
sleep, someone in New Jersey would take
over; when that person hit the sack,
someone in California or Thailand would
take over. People were blogging from
home and office; some offered to redesign
the blog in between hectic work schedules. 

Blogger would have nearly shut us
down if a chance contact in Google hadn’t
provided us unlimited bandwidth! 

People also offered us mirror sites. An
IT company, ironically named Tsunami
Software (http://www.tsusoft.com/), even
posted a link to SEA-EAT on their site, at
the risk of losing valuable traffic. 

“The Blog Response Overwhelmed Us”
A tête-à-tête with Peter Griffin, a media consultant based in Mumbai who helped set up 
the Tsunami relief blog

A post about
a group of
orphaned
children in
Thailand
received
responses
from nearly
40 people
who wanted
to help
Dina Mehta
Media Consultant 
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Mridu Khullar

t’s that time of the year again and as
cupid aims for you and your beloved,
don’t get stuck in the rut of the same

old card-and-f lowers routine. This year,

surprise your sweetheart with digital pictures
you captured on the sly. Whether on a T-shirt
with a picture featuring you both or a Shrek-
and-princess portrait with your faces, these
ideas are sure to f loor him/her this
Valentine’s Day!

Five simple, yet great ideas to impress your beloved

Floor Your Valentine
With Digital Photography

DIGIT FEBRUARY 2005144

I

My Gurl, An A-list Celebrity!

Has your vivid imagination ever captured how

your girlfriend would look in that famous

Marilyn Monroe gown-in-the-air shot? Well,

give it a
 rest and bring out th

e imaging soft-

ware. Using software tools like Morpheus or

Fantamorph, you can easily morph your

pictures on to a celebrity’s image. With

Morpheus, you can even create Shockwave files

or movie clips using a series of pictures. If

you’re already comfortable using Adobe

Photoshop, download a variety of plug-ins that

let you do the same or even add captions, titl
es

and quotes.

Give A Digital Gift
Make your Valentine a romantic T-shirt with a picture of

the two of you inside a heart. She can wear it to a girl’s

night out and show it off! Even better, do the same on her

bag or coffee mug which she can keep at work and think

of you every time she sips on her coffee. 

How? It’s simple! Get a photo printer and a plain T-

shirt, preferably white or light-coloured; also buy iron-on

t-shirt transfers from your local computer stationery store

or the printer manufacturer’s website. After you’ve

printed the image onto the T-shirt transfer, cut it out into

a heart shape and then you can easily iron it on the tee.

Decorate with beads, glitter and other accessories to make

it truly special. You can also print your photographs onto mouse pads

and bags, calendars, mugs and any other smooth surface!

All that limits you is your creativity. 

Illustrations  Shyam Shriram  

Digital Leisure l Valentine Surprise
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Flick Thru Flip BookRemember those flip books that you made and loved

as a kid? Why not go down memory lane and make

the same thing with your digital photographs? All

you’ll need are a dozen or so pictures that are pretty

much the same, with only slight changes. If you

aren’t able to take such pictures when your

boyfriend/girlfriend isn’t looking, make the neces-

sary changes using Adobe Photoshop or any another

image-editing software. Make sure you include many

funny faces or crazy photos that have a gradual

progression. Print these images, cut them out and

clip or paste them together in order along one edge.

Flip through the book and your subject seems to

move and even do crazy things. For V-Day, you could

use pictures of you both and join them so they come

close for a hug or kiss!

Star In A Digital Movie
How about converting those early romances and

dating pictures into a movie? Yes, you read that

right. A newly-launched service allows you to

send in your photographs and have them

converted into life-like movies. A movie portray-

ing how the two of you met, fell in love and got

together would be the just the thing!

For this, find pictures that depict the various

stages in your relationship. Then, log on to Digi-

Slides.com (www.digi-slides.com) where you can

download an order form. Just fill it up and mail

it with your pictures on a CD and your own

movie (directed by and starring you and your

valenrtine) will be sent on a DVD right to your

doorstep.

Change The Settings
That picture of the two of you sitting on that roadside bench is anything

but romantic. But it can be made into a cosy twosome! Changing the

background of a picture can completely transform its feel and effect. You

could also take that picture of her college re-union in which she thinks

she looked dreadful and replace it with a better picture. Or just swap the

heads of all the people in the photograph! You need to know how to work

with ‘Layers’ for this one, though. Here’s how:

Open your picture in Photoshop, starting with Layer 1. Enlarge the

picture and cut out the face from it. Next, open the picture from where

you’ll be taking the replacement face. If you are using the same picture,

make sure to save an original copy and use that. With the help of the

‘Lasso’ tool, select the face and ‘feather’ it. Paste this on the original

picture and resize it. Adjust the colour to give it an even look. To change

the background of your picture, you need to follow a similar process, but

this time, select the background instead of the face.

Digital Leisure l Valentine Surprise
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Avinash Rai

personally thought
‘Sands of Time’ (SOT)
was a very good game,

blending just the right
amount of ‘platforming’ with
action. The chemistry
between the two leads (the
proud Prince and the lovely
Farah) felt just right.
Surprisingly, people weren’t
satisfied with the game (us
gamers like to whine!). Since
Ubisoft is one of the few
companies that actually
listen to their fans, they
gladly obliged. ‘Warrior
Within’ (WW) is basically a
darker and an extremely
violent (and frustrating)
version of Sands of Time. One
that practically bubbles with
sexual references (don’t even
get me started on the outfits).

The story picks up from
where SOT left off. After
defeating the evil Vazir, the
Prince rewinds time to make
things right. He saves his
father, his kingdom and
Farah. Everyone’s happy…
except Fate: it was the
Prince’s destiny to die and by
avoiding death, he really
messed Fate’s grand plans.
Fate, a stickler for tidiness,
sends a manifestation of
itself, called the Dahaka, to
clean things up. No man
wants to die, so you play a
Prince on-the-run, devoid of
sleep or rest, which explains
why he looks like someone
killed his pet kitten.

Now With 100 Per Cent
More Gore!
The game is tough, and no,
it’s not only because of the
crappy controls (if you want

to really enjoy this game,
play it with a joy pad). Right
from the tutorial, enemies
charge at you by the dozen.
Thankfully, disposing them
isn’t a problem, due to the
new ‘Free Form Fighting’
system. Dual wielding is now
in the house, hacking is, thus,
twice as fun. 

Pick up any weapon
dropped by your foe and use
it to your advantage (you can
even throw weapons at
enemies and cut their heads
off. How cool is that?) Every
action during combat leads
to various opportunities.
Grapple an enemy and you
can (a) cut his head off, (b)
cut him in half vertically, (c)
cut him in half horizontally,
(d) strangle him, (e) throw
him at other enemies, (f)
thrust your sword in his
back, remove it, take his

Blade of Darkness meets Sands of Time 

I

--

++ MMAASSTTEERR  OOFF  SSWWOORRDDSS  

MMAASSTTEERR  OOFF  PPAAIINN  

Awesome combat 
system
Stunning level design
Good soundtrack (if
you like metal)
Fast loading times

Repetitive at times
Too many monoto-
nous boss fights 
Bad camera angles

Im
aging  Jayan K

 N
arayanan
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He awaits me on pins and on needles

sword while he writhes in pain and
cut his head off using both the
swords, à la Gladiator. 

The combat in this game is
sweet, and will definitely bring out
the sadist in you (it did for me).
Mastering it may take you time as
there are loads of combos, but trust
me, it’s worth the wait. 

The only grouse is that there are
too many monotonous boss fights
in the game—there’s even one in
the tutorial level! That apart, the
combat system in WW is one the
best I’ve seen in any third-person
action game.

The platforming isn’t that bad
either. It’s more or less the same as
SOT with a few new moves thrown
in, such as the ability to slide down
curtains using swords—slick stuff. 

Puzzles aren’t that tough; they
just take a little bit of thinking
(which is true for most POP games).
There is a fair amount of backtrack-
ing present in the first half of the
game, which gets on your nerves
because running from tower to
tower, dodging the same traps over
and over again just doesn’t cut it. 

I Make This Look Good
Visually, the game is excellent. Just
like its predecessor, WW is bathed
in a light glow at all times; giving
the game the same dreamy look
that was present in SOT. Level
design is mind-blowing, and levels
load quickly. The Prince moves as
fluid as ever, and watching him
kick a** is certainly a treat. 

Unfortunately, the same annoy-
ing camera angles that plagued SOT
are back for the sequel as well;
these being especially painful

during sequences
where the Prince

runs from the Dahaka. 
Bosses and their minions are

well-detailed and move menacingly
enough. So, few issues with the
visual department; it’s the sound
department that’s off. Firstly, the
Prince sounds a bit cocky and some
of his dialogues are seemingly
ripped from a B-grade Van Damme
flick (I guess the Prince got a bit
too Americanised!). 

Watching the Prince slice
through his enemies is cool, but
hearing them shreik like cats is not.
Female assassins, for example,
sound like they’re experiencing
sexual ecstasy when they’re being
slaughtered. It’s this kind of cheap
commercialism that bugs you, but
thankfully there isn’t enough pres-
ent to hamper a perfectly good
gaming experience. 

Godsmack provides the tunes
for the entire game. I like listening
to metal while I’m decapitating
people as much as the next person,
but somehow the experience does
not feel very Persia-ish (Not that I
would prefer Cheb Mami screech-
ing, but still…)

WW certainly has some annoy-
ing factors but then, which game
doesn’t? I really liked the darker
tone, the metal tunes and the, er,
costumes this game had to offer. If
you’re a die hard SOT fan who
enjoyed the game for its charm you
may feel let down initially, but trust
me-give it a shot and you’ll be hack-
ing and slashing and begging for
more in no time. 

avinash_rai@thinkdigit.com

Prince Of Persia: Warrior Within
Distributed by Milestone Interactive Software
Limited
Phone: 28381614 
Web site: www.milestoneinteractive.com
Price: Rs 1,499

Hero pose. Fear me!

The swords are just a distraction

A little pressure and you fall apart? Amateurs!

Oh yeah? YOUR mother wears army boots!
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Wired, January 2005

Groping In The Shadows
JUST LIKE THE underground news networks worked
behind the scenes to throw out governments and
colonial powers, an underground network of pirates is
threatening to bankrupt the entertainment business
the world over. Jeff Howe of Wired magazine goes into
the hidden corridors of the Shadow Internet.

Just over a year ago, a hacker penetrated the corporate
servers at Valve, the game company behind the popular

first-person shooter Half-
Life. He came away with
a beta version of Half-Life
2. “We heard about it,”
says 23-year-old Frank, a
well-connected media
pirate. “Everyone thought
it would get bootlegged
in Europe.” Instead, the
hacker gave the source
code to Frank—it turned
out that he was a friend

of a friend—so that Frank could give Half-Life 2 to the world. 
“I was like, ‘Let’s do this thing, yo!’” he says. “I put it on
Anathema. After that, it was all over.”

Anathema is a so-called topsite, one of 30 or so
underground, highly secretive servers where nearly all of
the unlicensed music, movies, and videogames available on
the Internet originate. Outside of a pirate elite and the Feds
who track them, few know that topsites exist. Even fewer
can log in. 

Within minutes of appearing on Anathema, Half-Life 2
spread. One file became 30 files, became 3,000 files,
became 300,000 files as Valve stood helplessly by watching
its big Christmas blockbuster turn into a lump of coal. The
damage was irreversible—the horse was out of the barn, the
county, and the state! The original Half-Life has sold more
than 10 million games and expansion packs since its late
1998 release. Half-Life 2’s official release finally happened
in November, after almost a year of reprogramming. 

When Frank (who, like all the pirates interviewed for
this article, is identified by a pseudonym) posted the Half-
Life 2 code to Anathema, he tapped an international
network of people dedicated to propagating stolen files as
widely and quickly as possible. 

It’s all a big game and, to hear Frank and others talk
about “the scene”, fantastic fun. Whoever transfers the
most files to the most sites in the least amount of time
wins. There are elaborate rules, with prizes in the offing
and reputations at stake. Topsites like Anathema are at
the apex. Once a file is posted to a topsite, it starts a
rapid descent through wider and wider levels of an
invisible network, multiplying exponentially along the way.
At each step, more and more pirates pitch in to keep the
avalanche tumbling downward. Finally, thousands,
perhaps millions, of copies—all the progeny of that
original file—spill into the public peer-to-peer (P2P)
networks: Kazaa, LimeWire, Morpheus. 

Without this duplication and distribution structure
providing content, the P2P networks would run dry.
(BitTorrent, a faster and more efficient type of P2P file-
sharing, is an exception. But at present, there are far fewer
BitTorrent users.)
To read the entire piece, go to www.snipurl.com/digit_shadow

PC World, February 2005

Those Stupid Error messages!
NO MATTER HOW computing technology improves,
those stupid PC error messages keep coming, and
coming, and coming. Stephen Manes of PC World
magazine is as frustrated as you are.

Wonderful way to begin my day: A startup DOS-style
message appears; the PC’s screen explains that a crucial
system file is missing and that I should insert the restore CD-
ROM. But in the chamber of horrible housekeeping that is my
office, I have no idea where the disc is.

Next step: Denial. I reboot, or try to, and get the same
message. That CD has to be around somewhere. It has to. I
spend a couple of hours overturning every shred of clutter in
the place. Nothing.

Few days later, I try again. You know the thinking: Maybe it
fixed itself somehow. And then I see something I missed before.
Down in the lower-right corner of the computer manufacturer's
startup screen, I see the phrase ‘<F10=System Recovery>’.
That’s when it hits me: There is no restore disc. This is one of

those machines that comes
with rollback data on the
hard drive alone.

Admittedly, having the
restorative option on the
hard drive is handy when
you can’t find the CD. But
there’s no excuse for not
supplying a disc that
costs, what, 10 cents? 
And even worse is the
generic message that’s not
only inappropriate but
simply wrong.

This kind of thing
happens constantly. Error
messages and what I’ve
come to call “monologue
boxes” are supposed to
help you solve problems.
In reality, they’re riddled

with errors themselves—when you can figure out what they
mean. Take my copy of Norton AntiVirus, which is supposed
to update itself automatically. I’ve repeatedly run into
situations when the updater tells me that it has aborted—and,
afterward, that my virus definitions are up-to-date. Which is
correct? Who knows?

TurboTax still offers a classic in the annals of dialog-box
stupidity. When you exit, it asks, ‘Do you want to save this file?’
But what it really means is, ‘Do you want to save the changes
you made to this file?’ If you had simply been fooling around
with some what-if scenarios, the right answer might be ‘No’.
But if you were afraid you’d lose the file itself, you’d probably
pick ‘Yes’—and wipe out some of the original data. How hard is
it to get a basic question like this right?

Crummy error messages have migrated from our PCs to the
Web. The archetypal example: A site wants data in a certain
format—say, phone numbers without parentheses or hyphens—
but doesn’t say so. You enter information your way, then get a
message that says something like ‘Incorrect Data’ with no clue
as to what’s wrong. Bad enough that the site doesn’t dope out
what you meant; often it will force you to reenter not just the
phone number but everything else, too.

Read Stephen Manes’ entire rant at www.snipurl.com/digit_error

MediaWise



PCmag.com, January 12, 2005

The Top Trends At CES 2005
THE CONSUMER ELECTRONICS Show (CES) is the place to be
every year for those yearning digital nirvana. PC Mag
columnist Jim Louderback was there to take a look at the
trends that will define 2005.

1. DDiiggiittaall  TTVV  GGeettss  CChheeaappeerr  AAnndd  CChheeaappeerr::  We’ve chronicled this
on ExtremeTech, but the trend is only going to accelerate. With

30” LCD TVs
approaching $1,500,
ultrathin tube-TVs
rivaling rear-projection
models, and amazingly
cheap three-LCD RPTVs
that may just rival DLP
and plasma, it will be
easier and cheaper to
replace that aging tube
TV with a digital-
capable set. And with
all the new factories
coming on line, expect
prices to continue their
inexorable slide. 

2. PPoosstt--HHDDTTVV  WWoorrlldd
IIss  CCoommiinngg::  Here in the
US, HDTV means 720p

or 1080i. But the industry is already envisioning a world of
progressive scan 1080-double the resolution of the biggest
current sets. The plasmas and DLP projectors on display
supporting 1080p looked great. Alas, we may not have much
content to take advantage of these great-looking displays. 

3. NNoott  NNooww  FFoorr  HHiigghh--DDeeffiinniittiioonn  DDVVDD::  Both Blu-ray and HD-DVD
are ready to go, and vendors were showing off drives and players
for each. Alas, with two competing standards-and high-profile
announcements of support for each-neither will take off over the
next 18 months. Even though current DVDs look a bit pale on
today's modern HDTVs, don’t expect anything substantial until
late 2006. And if the warring factions can’t get their act together,
it could stretch out into 2008 or later. To quote Bugs Bunny,
“What a bunch of maroons!” 

4. HHoommee  MMeeddiiaa  NNeettwwoorrkkiinngg  WWiillll  BBee  BBiigg::  Yes, we all will be
moving our media around the house and to portable devices. But
the question is, “When will someone get it right?” I looked at
networking schemes from TiVo, DivX, DirecTV, and many others.
Someone will figure this one out, but none of the current solutions
are easy enough, or transparent enough, for most consumers.
Only startup Sonos seemed to understand the need for simplicity,
but its products are audio-only and expensive. 

5. DDVVRR  IIss  AA  FFeeaattuurree,,  NNoott  AA  PPrroodduucctt::  Back when TiVo and
ReplayTV launched, the digital video recorder seemed to be the
next big electronics product, after DVD. But over the last five
years, hard-drive and flash-based media recording have become
pervasive. DVR is rapidly becoming part of many consumer
devices, from satellite radio to set top boxes. DirecTV rolled out its
own homegrown versions, joining Motorola, Scientific Atlanta, and
more. Even TiVo realises that DVR alone is not enough, as it rolled
out additional services and connectivity designed to turn its box
into the hub of the digital home. Anyone planning on building a
standalone DVR ought to have their head examined. 

Read the full piece at www.snipurl.com/digit_ces
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AdWise

When you gotta...
This ad nicely gets across the message that you can,
indeed, build a truly portable desktop. The pun
complements the visual very nicely, too.

An extension of yourself
Based on a simple theme, this ad gets across the overt idea of
the smartphone being able to do many things at the same time,
and the subtle message that it can act as ‘an extension of you’.
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FirstEscape

At the age of 13, in 1998,
Nicholas Ciarelli, then a

schoolgoer at New Wood-
stock, New York, started a
Web site, publishing insider
news and rumours about
Apple, using the nom de
plume ‘Nick dePlume’. 

Three years later, his site
ThinkSecret.com was the
first to report that Apple
would debut a G4 version of
the PowerBook laptop
series. The product
launched soon after, and so
did ThinkSecret.com’s
reputation amongst Apple’s
fans—generating millions of
hits per month. 

Apple sent a series of
warnings to ThinkSecret to
stop publishing proprietary
information. When Ciarelli
predicted the arrival of two
new products in December
2004, Apple filed a lawsuit
of illegally
misappropriating trade
secrets against him. 

Now a 19-year-old
freshman at Harvard,
Ciarelli’s—and that of other
news gatherers like him—
growing influence has
raised questions about
accountability and
journalistic standards. Web
sites run by product buffs
have generated valuable
buzz. They have also irked
companies by leaking
product information. 

The suit alleges that
ThinkSecret.com induced
tipsters to break non-

disclosure agreements. 
Ciarelli established the

dePlume Organization LLC,
which is registered in New
York. It lacks the money to
defend a case against a
major corporation.

Some speculate that
Apple is after the source—
the real target is whoever
has been breaking non-
disclosure agreements. 

ONLINE REVENGE

Woman
Deletes Ex’s
Data

Police in Fukushima,
Japan, said that a woman

in her 30s illegally used her
boyfriend’s username and
password to access an
Internet game and delete
his game data. She now

faces charges in accordance
with a law banning illegal
access. The woman has
owned up that she did
delete her boyfriend’s
online game data: “I did it
as revenge for breaking up
with me.” The couple met
through the game in the
autumn of 2003, and started
a relationship after actually
meeting each other, but
they soon broke up.

The man, in his 20s, did
not suffer financially
because of her actions, but
she deleted items such as
weapons and clothes that
he had spent time in the
game collecting.

Investigators said the
woman had accessed the

Think you have the most
beautiful, most innovative

desktop around? Send it to
mmyyddeesskkttoopp@@tthhiinnkkddiiggiitt..ccoomm,,  and
Digit will publish the most 
eye-catching of them each month.

WE SURRENDER: Rohit Daya’s desktop makes us wonder at
planet Mars
Sent in by Rohit Daya

My Desktop

www.premkahani.
com

Premkahani.com says it
‘builds beautiful

relationships’. Sadly, though,
there are no relationships
being built here, beautiful or
otherwise. A ‘lucky spin’
feature on the main page
shows up a random profile-
and if the pic on that profile
happens to be large, it takes
up the entire screen, pushing
all the text away. And oh,
searches by community or
religion yield no results
whatsoever. Want to browse
profiles? You get one result
per community, and the
‘next’ and ‘previous’ buttons
don’t work!

Internet Resulting In Widespread Plagiarism
The widespread use of the Internet as a research tool has
given rise to cheating among high-school students, say
educators. It is being realised that students, accustomed to
downloading copyrighted music and such, may not realise
that copying even a few sentences constitutes plagiarism

Computer Games For Schools
Recent research by the London Institute of Education
concluded that games have a valid place in the
classroom. Games, it was found, taught life skills such as
decision making and problem solving said Futurelab, an
organisation trying to use technology for learning

The winner
will receive a
copy of
Webster’s New
World Computer
Dictionary.
By Bryan Pfaffenberger,
published by Pearson
Education
This month’s winner is 
Rohit Daya 

YOUNG AND RESTLESS

Apple Sues Teen Over Web Site  

Nicholas Ciarelli—getting under
Apple’s skin
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online role-playing game
Lineage using the man’s
username and password in
about April last year.

Lineage is an adventure
game in which players fight
enemies with characters such
as knights and magicians. 

PROLIFIC TEXTERS

UK Text
Message
Record

UK mobile owners
continue to break

records with their text
messaging. The latest
figures show that 26 billion
texts were sent in the UK in
2004. The figures were
collected by the Mobile
Data Association (MDA).
They also showed that 2.4
billion were sent in
December alone, the
highest monthly total ever.
Every day, 78 million
messages are sent—which is
more than one message per
person in the UK—and there
are no signs of a slowdown.

One of the reasons for
the growing number is that
people are using it to do
much more. Booking

cinema tickets, text voting,
and news or sports text
alerts are growing popular.

THE BLUE SCREEN OF DEATH!

Gates’
Windows
Crash

There was a buzz in the
air at the Consumer

Electronics Show (CES) 2005.
Only this time, the reason
for excitement was not
another product

launch but the keynote
address by Microsoft’s
chairman and chief
software architect, Bill
Gates himself.

Returning to the
International CES for the
seventh consecutive year,
Gates captivated the
capacity audience with yet
another riveting pre-show
keynote address.

Before that, however, he
lived through the horror of
witnessing his beloved
Windows display the BSOD
(Blue Screen Of Death) and
pop up a kernel error.

Here’s to you, Bill!
When

he finally
got going,

Gates
returned to

one of his
favourite

topics over the
past few years—

Reali-sing A
Digital Lifestyle.

The keynote
covered virtually
all aspects of
digital living such
as music, photos,
TV, portability,
gaming and so on,
which can be

enjoyed on various
devices and platforms.

This month’s winner is 
Manju Jaiswall from
Bangalore. She wins a

Two people invented the
integrated circuit (IC) at

almost the same time.
Manufacturers wanted more
out of the commonplace
transistors. But there was a

limit on how small you could
make each transistor, since it
is connected to wires and
devices. So, scientists wanted
a miniature circuit with
transistors, wires, etc.

In 1958, engineer Jack
Kilby was working for Texas
Instruments (TI). A year
earlier, research engineer
Robert Noyce, aka Mayor of

Silicon Valley, co-founded
Fairchild Semiconductor
Corporation where he
invented the integrated chip.
Noyce also founded Intel. 

It occurred to Kilby, when
sitting at TI, that all parts of
a circuit could be of silicon.

In 1959, both applied for
patents. Kilby and TI received
a US patent for miniaturised
electronic circuits while
Noyce and Fairchild received
a US patent for silicon-based
integrated circuits. The two
companies decided to cross-
license technologies after
years of legal battles, creating
a global market now worth
$1 trillion a year.

Today, an IC can be small-
er than a coin, and can hold
125 million transistors!

Making
Small Big

People Who
Changed

Computing

Mini Keypad worth Rs.995/-

by Travel Pac

The TravelPac mini Keypad is a
19-Key pad that is
ergonomically designed with an
incline for convenient data
entry. This USB device is a plug-
and-play and hot-swappable
device. It is a lightweight device
designed for a notebook.

There’s [Ctrl] and [Alt]. Now,
if only I could reach [Del]...

Jack Kilby

Robert Noyce

WIN!
A Mini Keypad by Travel Pac just by sharing an amusing picture with
a tech angle to it. The picture should be shot by you, and should not
have been published earlier.
Send your picture to digipick@thinkdigit.com.
The prize-winning picture will be published each month.

Illustration Harsho Mohan Chottoraj



XML SMELL

A Language
For Smell

Aresearcher at Huelva
University in Spain

claims to have created a
version of XML—often called
the successor to HTML—that
can transmit fragrances.
The ability to transmit
smells could have
applications in several
fields including tourism,
gaming, marketing,
medicine, and so on.

The university has
worked with researchers in
both computing and
chemistry to come up with
the concept of the XML
Smell language. It said the
initial idea was to print
smells on paper using laser
and inkjet printers, but in
this approach, the
fragrances degraded over a
short period of time. The
scientists now claim to
have developed a dual-pass
printing system, using two
polymers which degrade by
light and by touch, so that
the smell only emerges
when a document is read.

Not content with this,
researchers quickly realised
that smells could be
propagated over networks
and, of course, the Web.
They therefore created XML
Smell, which they claim
can define in a universal
and standardised way the

transmission of smell. This
will allow for the trans-
mission of fragrances by e-
mail, by SMS to a mobile
phone, or via a TV show.

Currently, the scientists
are designing a device
which will sit close to a TV,
a radio, a phone or a PC,
and which contains a
'smell palette'. The
components in the palette
get manifested according
to instructions in the XML
Smell language.

ROBO-CUP

Robots Will
Win World
Cup By
2050!

AJapanese consortium of
robotics experts has

claimed that their
engineered humans will
outplay real ones—in
football—within 45 years. 

Ishiguro and his team
are talking about the
successors to a robot called
VisiON, which is just 38 cm
tall and weighs only 2.4 kg.
VisiON operates
independently of human
input, makes its own
decisions based on
information it perceives and
recognises the football,
approaches it and delivers a
hefty kick.

It can identify an
opponent and shield the
ball. Atop its head is a 360-
degree vision sensor, so it
does not have to turn its
head at all.

Robot World Cup
tournaments have been with
us for quite some time
now—the most recent being
held in Lisbon. RoboCup
2005 is scheduled for July 
in Osaka, Japan.

Ishiguro is confident
that players of steel and
wire will one day lift the

World Cup. “The important
thing to remember is what
you see here is just the
beginning,” he says.
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Escape

NLP
Natural Language Processing
(NLP) is an Artificial Intelligence
(AI) undertaking. It aims to
process sentences written in a
language such as English so as
to extract meaning from them
and represent this meaning in a
manner that a computer can
understand. If you want to
portray yourself as an AI
practitioner, simply say that
amongst all AI disciplines, you
like NLP best and then go on to
describe how you do it. 

HHooww  ddoo  yyoouu  mmaakkee  aa
ccoommppuutteerr  uunnddeerrssttaanndd  EEnngglliisshh??
To this, you reply, “That’s what
NLP is for. You break up the
sentences into parts of speech,
and then parse it just as you
would any other string, of
course, ellipsis is one major
hurdle.” (‘Ellipsis’ means an
instance where the context is
not available.)

WWhhaatt  iiss  eelllliippssiiss??  Intimidate
your audience here. “You don’t
know what ellipsis is? Say you
reply to a question about your
name with ‘John Smith’. Here,
you haven’t specified what John
Smith is and that’s ellipsis.”

YYoouurr  aauuddiieennccee  wwiillll  pprroobbaabbllyy
aasskk  yyoouu  aatt  tthhiiss  ppooiinntt,,  ““SSoo  tthhaatt’’ss
aallll  tthheerree  iiss  ttoo  NNLLPP??  PPaarrttss  ooff
ssppeeeecchh  aanndd  ppaarrssiinngg??””
Since you don’t know too much
yourself, you launch off into
unfamiliar words— “No, no,
there’s actually much more. You
have got to consider things like
failure of substitutivity, you
have to learn to use the FOPC
and HMMs, construct working
grammars and much more.”

WWhhaatt  iiss  FFOOPPCC  aanndd  HHMMMM??
Remember to learn the full
form—First Order Predicate
Calculus. It sounds nice and AI-
ish. Of course, you deliberately
use the abbreviations in the
first instance, so you can
expand them later. HMM stands
for ‘Hidden Markov Model’.

FFiinniisshh  ooffff  wwiitthh::  “Like I said,
it’s basically the manipulation
of the parse tree. You construct
the tree and do all sorts of
things with it. I can direct you
to a tutorial if you like.”

Two distinguished gentlemen of the
Digit team are no longer single; they

have been sacrificed at the altar of
marriage. It is a sacrifice they have
invited upon themselves, having fallen
head over heels in love with two lovely
young women.

Copy Editor Robert Sovereign-Smith
aka Raaabo married
Karen at a ceremony in
which no one could
recognise Robert. He
had worn formal clothes for the first
time in his life since he’d peddled
goods as a salesman for a leading
company. Heck, he’d even shaved for the
wedding reception. 

Jayan, Digit’s lead designer, who had
kept his beau Shiny hidden from
everyone’s knowledge by cleverly
wooing her when he was in Kerala, did
no such thing. His facial hair, the pride
of his Malayalee clan, had been groomed
with as much discipline as he puts
Photoshop streaks in his opening

visuals. His beard
represents his
personality, as it did for
Osho, G B Shaw and

other hirsute champions of history.
Both Robert and Jayan are back at

work now, with all the vim and vigour
of newlyweds. We are now waiting for
the seven-year itch!

Nuptials Time!
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ROAD RAGE

Report
Roadhogs
Online

There is now an alternative
to venting anger while on

the road—go online and
report the offensive driver.
Law enforcement officers in
Arizona and Washington are
asking the public to report
reckless drivers online.

“It’s just another tool to
solicit the public’s help in
fighting aggressive
driving,” said Trooper
Johnny Alexander, a
spokesman for the
Washington State Patrol.
Motorists in Washington
can go to the state patrol’s
Web site and report areas
where aggressive driving is
consistently a problem. 

They can note what
they’ve witnessed, when
and how the incidents
occur, as well as license
plate numbers. 

DEVIOUS WORM

Breaking
News
Spreads
Worm

There’s a new, smart
worm out there. It uses

breaking news from the
CNN.com Web site and a
devious technique to keep
itself up-to-date in order to
dupe recipients into
opening attachments. 

On January 21, UK-based
security vendor Sophos said
that the Crowt.a worm
grabs its subject lines,
message content, and
attachment names from
headlines—in real-time—
from CNN’s Web site. 

The worm’s subject and
attachment filename change
to mirror the top headline
on the site.
Compiled  by Ram Mohan Rao, 

Meera Vankipuram and
Aditya Kuber

Escape

Tired of the big bad mate-
rial world and its fleeting
pleasures? Looking for

something spiritual? We are
not talking of austere lifestyles.
In today’s instant world, even
spirituality is available on a CD! 

For $19.95 (Rs 870), you
can “Travel to the astral realm.
Leave your body behind and
head for astral light. With this
CD and download, projection
has never been easier.” You
are tempted to ask why people
leading such exciting astral
lives want $19.95 from you! For

only $49.95 (Rs 2,150), you get three titles on one CD including
‘Instant Meditation’, ‘Astral Projection’, and ‘Remote Viewing’!

If you really want to know more, www.worldofalterna-
tives.com has the answer—“Accurately calibrated sine wave
frequency generators were used to generate different frequen-
cies in each ear. Experimenting through the whole range of
alpha and theta waves, it was found that a combination of 
frequencies consistently caused a complete shift in 
consciousness…” Yeah, right!

If you thought this was a con job, read ‘Don’s’ testimonial:
“Can’t believe how easy this is. Projected first time. Cool!” Huh?
There are folks like ‘Don’ with money to spare on a download
that promises nothing less than an out-of-body experience.
Experience is guaranteed and customer service is top-notch! If
nothing happens when you listen to the download, you get your
money back. Seriously, what were they and ‘Don’ thinking?

whatweretheythinking.com

http://snipurl.com/c7oa

Micro Persuasion
http://snipurl.com/bx85

“Tap Into the Flickrgeist”
Consumers are replacing Consumer Reports. We are
increasingly turning to blogs and other forms of
consumer generated media to gather the information
we need to make informed purchasing decisions.
Armed with these insights, we can easily separate
exceptionally great products from the average. 

Consumers can do this today with more than blogs
by tapping into what I call the Flickrgeist. Thanks to
RSS, as a marketer you can easily monitor your
company/product’s Flickrgeist index against your
competitors.

In case you’re not familiar with the site, Flickr is a
free photo sharing site that anyone can use to post
photographs and then “tag” them with certain labels.
Flickr makes it a snap to find all photos across its vast
community that have posted photos under a common
tag. Each tag has its own RSS feed.

Using Flickr tags, you can assess just how much
consumers are evangelising brands by stacking them
against their competitors. All you need to do is simply
replace the bracketed text below with the name of
your product and enter the URL into your browser...

The Gripe Line Weblog
http://snipurl.com/bx8a

“Is Microsoft Violating The Gator EULA?”
A thought suddenly struck me yesterday when I was

reading the press release for Microsoft’s new Windows
Anti-Spyware product. If Microsoft’s product is really
going to clean up spyware effectively, how will it do so
without violating the licensing agreement of Claria’s
Gator and other spyware/adware?

Duct Tape Marketing
http://snipurl.com/bx86

“Referral Marketing Is Target Marketing At Its
Best”
Most small business owners miss the boat when it
comes to getting a constant flow of referrals because
they start looking in all the wrong places. If they seek
referrals, most small business owners think only of
their clients. While existing clients can be a good
source of referrals, they don’t have much motivation.
They might send a client or two, but won’t think of you
day in and day out. And, that’s what your referral
marketing effort really needs.

Small Business Information
http://snipurl.com/bx87

“What A Blog Can Do For Your Small Business”
The blogging movement is picking up speed with the
launch of blogs on About.com network and the
purchase of blog software company Pyra Labs to
Google. More companies are experimenting with the
blog environment. Will blogging become the next
mainstream application like email? Will business blogs
improve your business?

Here’s taking a look
at some eye-catching
blogs. Will the new
Windows Anti-
Spyware product
violate the Gator
EULA? There’s a
review on Flickrgeist
and one about a free
photo sharing Web
site. Check out how
referral marketing
works—and finally,
there’s a blog about
blogging
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Which company has offered a
$5,00,000 (Rs 2.25 crore)

reward for information leading to
writers of the computer viruses
Blaster worm and SoBig.F? 
a. Novell b. Apple
c. Microsoft d. Symantec

Which search engine aims to
make Internet surfing easier

for the visually impaired by read-
ing out the results?
a. Scholar b. Yahoo
c. Speegle d. Google

Microsoft announced the
launch of a stripped-down

version of its Windows operating
system in January. What part of
the OS is being removed?   
a. Internet Explorer c. Games
b. Outlook Express d. Winamp

Researchers at security
software company Sophos

found that 42 per cent of all spam
sent this year came from this
single country. 
a. Tanzania         b. Germany
c. United States  d. United Kingdom 

A Chinese security group has
released sample code to

exploit two new unpatched flaws
in Microsoft Windows. Where are
these two flaws found?
a. Windows Search program and
Box Width function
b. Load Image function and
Windows Help program
c. User Rights function and
Command program
d. Internet Explorer

Name the recently
unleashed Internet worm

that identified potential victims
by searching Google, AOL and
Yahoo and spread by targeting
pages that used vulnerable
versions of the PHP Bulletin Board
(phpBB) software.
a. Santy      b. Santa
c. Elf           d. Reindeer

Toshiba is the second major
electrical appliance maker

after Sony to announce its
withdrawal from which product
market? 
a. Plasma Display TVs   b. LCDs
c. Handhelds                 d. Laptops

According to a recent study by
AMR Research, what

percentage of IT jobs required by
American companies by 2010 will
be performed by Indian firms,
saving the US nearly $30 billion
(approx Rs 130 billion) annually? 
a. 5 per cent b. 2 per cent
c. 10 per cent d. 15 per cent

Which country has advanced
its communications

infrastructure by launching
Cernet2, a high-speed Internet
backbone that connects 25
universities in 20 cities? Cernet2
achieved speeds of up to 40
gigabits per second during a trial
run conducted in December 2004,
a record for real-world
applications, where the average
speeds are about 2 to 10 Gbps for
universities.
a. India     b. Japan
c. China    d. USA
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Across
6. _____ Presario PCs from HP (6)
8. _____ Visual representations stored
in electronic form (6) 
9. Cut out to modify data (4) 
10. Base-8 notation (5)
11. Boot up upsets tarts (5) 
13. Make available (7)
16. An object-oriented Programming
in Logic (7)
17. Direct Read After Write (abbr) (4)
20. Data entered into a computer (5) 
21. Element of data storage scatters
life (4)
22. Waiter to host computer on a
network (6) 
23. Programming language named
after French mathematician (6)

Down
1. DTP package of the ’80s confused
art words (8) 
2. Microsoft's new technology

reverses heights
(abbr) (4)
3. This icon
resembles a sun dial
in a Web browser
toolbar (7)
4. Hot standby or
Warm standby? (8)
5. Ctrl+Shift+Z in
Corel (4)
7. Quick and Dirty
Operating System
(abbr) (4)
12. Locate and read
data from storage (8) 
14. Discharge cargo
to transfer computer
data (8)
15. Pre-packaged art
work (4,3) 
18. Bit end to an asynchronous
transmission! (4) 
19. Initial Graphics Exchange

Specification (abbr) (4)
21. High-speed computer (4)

Crossword 

Got an
interesting
question? 
Send it in with
the answer to
editor@thinkdigit.
com

Santa, Spammers And Flaw Fighters

1. a
2. c
3. c
4. d
5. c

This
Month’s

Answers

China’s
largest PC

manufacturer has
purchased IBM’s
personal computer business for
$1.75 billion. Name the group. 
a. Lenovo    b. Armonk
c. Beijing    d. Zhang

1

Solve the
crossword
and send your
answers to
TQ@thinkdigit.com.
If all answers are
correct, one lucky
participant could win
a copy of Webster’s New
World Computer Dictionary By Bryan

Pfaffenberger, published by Pearson Education

1. Niklas Zennstrom co-founded Skype 
2. Red Hat sent out the fake security
bulletin to Linux users 
3. JVC released Everio GZ-MC100 and
GZ-MC200, the tape-free camcorders
4. gdSuite is Google’s add-on for its
desktop search tool. 
5. Blueprint has teamed up with BT to
develop a service to host media files 
6. “Mobile digital secretaries” will be
deployed on the Nokia 6600 
7. Nordstrom.com interprets customer
enquiries by analysing search strings 
8. The UK’s free Windows XP version is
Windows XP Counterfeit Project
9. Chaska city, in the US, plans Wi-Fi
access  for most of its 15 square miles
10. Gaetano Borriello’s team at the
University of Washington team has
constructed a smartwatch that uses
RRFFIIDD  (Radio Frequency ID)

Last Month’s Answers

Last Month’s Winner
Parveen Bansal, New Delhi

Win!

6. b
7. a
8. a
9. d
10. c



A Taxing Regime
I was in south-east Asia recently, and was
shocked to know the price difference
between products available in India and
there. I purchased a Sony digital camera
(CyberShot P73), which costs Rs 18,990 in
India, but Rs 12,500 in Singapore and Rs
10,000 in Malaysia. Sony even offered me
a one-year international warranty for it.  

Indians effectively pay Rs 9,000 in
taxes for a product that costs Rs 10,000. I
don’t understand the reason for this. I
also bought a Creative MuVO Slim 256
MB for Rs 6,000 which is available for Rs
8,000 in India. The good news is both the
products I chose won the Digit ‘Zero1
2004 Award’ in the respective categories.

Saurabh Sahu,
Titilagarh (Orissa) 

Hi Saurabh,
That’s just like the icing on the cake. First you
get these products at low prices, and then your
choices win the Digit ‘Zero1 Awards’. About the
taxes: We wouldn't know whether the
government is planning to bring down tariffs
further on IT products this year, but prices of
IT products have fallen drastically in the last
three years, and will continue to fall this year.
It is only a sign of a mature market that prices
fall as demand rises. You don't have to look
further than the cell phone market—both
handsets and call charges in India were the
most expensive in the world when the services
began. Today, with almost five crore cellular
subscribers, we have one of the lowest tariffs
in the world.

—Executive Editor

English Only, Please!
I was simply blown away by Digit’s latest
offer where you offered four DVD
movies—The Lord of the Rings, Terminator 2,
Shakti, and Munna Bhai MBBS—free with
every subscription.

But guess what, I am disappointed!
Digit is read all over India, and not every
region appreciates Hindi movies. For
them, the two Hindi DVDs are a plain
waste. May I request Digit to respect the
cultural and lingual diversity our
country by giving only English movies so
that every one benefits from the offer? 

M S Karthikeyan 
Chennai

Dear Karthikeyan,
At Digit, we believe creativity knows no language
barriers. The movies we chose are some of the
greatest Hollywood and Bollywood hits; each one
of them is a masterpiece in its genre—whether
fantasy or science fiction or drama or comedy. It
will not be possible for us to change the movies
as they were chosen after careful consideration.
For now, you use the sub-titles feature on DVDs
to enjoy the Hindi movies.

—Executive Editor

Who’s Illiterate? Cops or
Executive Editor?
So, it is this balmy Thursday morning,
and I am walking around in the market
when I see the January issue of Digit. I
buy it first up, come home and read the
editorial. 

It was awesome! Mr Executive Editor
Sir, you have said it all in just a few
lines. It had just the right stuff I needed
to explain to everyone in defence of
Baazee.com CEO Avnish Bajaj. My friends
and relatives just did not seem to
understand when I told them earlier. 

Delhi has seen it all—from teachers
and parents giving us embarrassing
speeches to innocent people being taken
into custody to raiding cyber café’s. The
capital is going crazy and the reason?
Technology illiteracy!

Who can even think of arresting
Avnish Bajaj, the head of one of the few
dotcom success stories in India? Only
pot-bellied Delhi policemen!

About the so-called “tech-savvy”
media, the less said the better. They
don’t even realise that the video that
caused all this cannot even be sent
through MMS, only via Bluetooth and
Infrared cell phones. I have now come to
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Digit Forum

To post your comments on Digit Forum, 
visit www.thinkdigit.com/forum

Broadband in India = End of
PC/Tech Mags in India?

klinux
Digitized!
Might not be in the immediate future as
broadband speeds are... lousy. But, in the
near future, when the tariff war is on and
consumers get cheaper, faster and more
efficient broadband services, would
consumers/techies still want to buy
PC/Tech mags, or rather download
whatever he wants and get more articles
from online mags? 

What should Indian mags change, if
they have to compete with broadband?  

Just curious!
****************************************
saROMan
In-House Geek
Location: b4 my PIII
Depends... what r u buying the magz for...
for the software in it... or for the
contents... like Game/Hardware
reviews... new emerging trends, etc.
****************************************
ujjwal
Digitized Spammer
Location: University .Area .Delhi
Yes, to a certain extent sales would be
affected, as there are many people who
buy the magazine for the CD and software.
However, if the magazine kept Indian
specific articles like current hardware
prices, reviews of Indian ISPs, etc. people
would still buy them.
****************************************
Nemesis
Digitized Spammer
Location: New York
I agree with ujjwal... sales will b affected
but not much... countries like the US have
good broadband penetration... but still ppl
read mags... but like ujjwal said, the mags
here will have 2 carry a lot of Indian stuff
like reviews, prices, availability, etc., of
tech products in India and from an Indian
perspective...
****************************************
cheetah
Resident Techie
Location: Jalandhar
I don’t agree with that guy. 

Nobody buys the mags for software
only, we all buy because of new software
they suggest, hardware reviews and cool
site links. 

For Example: I learnt about Skype
from Digit. I learnt of the Slogger Firefox
plug in from Digit Jan 2004, and it has
changed my opinion about Firefox; now I
use Firefox only and quit using Opera. 

This is the use of these mags, they
totally change the way u think.
****************************************
Indyan
Digitized!
Location: Asansol, W.B.
As long as there r people like me who hate
reading on their pc screens, mags wud
remain alive. Also, I like da dvd.
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the conclusion that my six-year-old
nephew is more tech savvy than the
Delhi cops and the Indian media.

Anish Arora
New Delhi

Digit’s executive editor Sachin Kalbag
may be a highly technology-literate
person. All the same, I beg to differ with
him on the profound opinions expressed
by him in Digit’s January 2005 editorial
(“Out With Technology Illiteracy”).
Scientists, from prehistoric times to the
early 1960s, were simultaneously
philosophers with a deep-rooted sense of
social responsibility. 

Around the ’60s, a cataclysmic
change overtook human civilisation
including, sadly, scientists and
technologists, with an all-pervasive
social irresponsibility setting in across
all strata. The new philosophy was
expounded by the digital brahmins, who
considered the rest as untouchables.

Granted, our inventions can benefit
mankind in hundreds of ways, but if
misused, can harm in a million ways.
Individuals define the use and misuse of
inventions, don’t they? 

We are irresponsible scoundrels with
no social commitment. Our sole
commitment is to Mammon and
multinational monsters that fund and
enrich us. Avnish Bajaj belongs to this
socially irresponsible breed, and from
the strong defence put up by Sachin
Kalbag, it is evident that this breed has
an ardent fan following. 

Alas, Digit’s executive editor does

not know the implications of his
misguided writing.

SVS Rama Rao
Mumbai

Better Way To Excel!
In response to Ram Mohan Rao’s article
on ‘Microsoft Excel Nightmares’ (January
2005), I would like to point out a solution
simpler than what the writer suggests.
Rao’s solution to the first nightmare
“Excel Freezes Columns While Freezing
Rows” is: Let’s assume you need to freeze
the top row, which contains, say, names.
First, freeze the panes while at cell A1 by
going to Window>Freeze Panes. Now, go
to Window>Split. This will split the sheet
into four blocks. Go to the centre of the
split, so that the four-pronged cursor
shows. Drag it up to the bottom of the
row you want to freeze, and drag it also
to the left, all the way, beyond the first
column. Now, freeze panes again by going
to Window>Freeze Panes. You are done! 

Here is an easier way: Let’s assume
you want to freeze the top row, which
contains, say, names. Select second row by
clicking on the row number (when the
curser changes to horizontal arrow). 
Now go to Window>Freeze Pane. You 
are through.

Sushil Chauhan
Mumbai

Ram Mohan Rao’s feature on MS Excel
nightmares was interesting and useful.
Tip 3, to get rid of the “Getting Started”
Pane, was especially useful. As regards
Tip 1, we can use a simple formula for
freezing panes: If you want to freeze the
top ‘n’ rows, then position the cursor in
cell A (n+1), before freezing the panes.
And if you want to freeze the leftmost n
columns, then position the cursor in cell
(n+1)1 [i.e. the top cell in the (n+1)th

column], before freezing the panes. As
regards Tip 2, it would be good to make
all cells of the same height if you want
to see the file on the screen only. If you
want to print it, wouldn’t increasing the
height throughout the file to suit the
largest make the printout unwieldy?  

Fullar Velker
Via e-mail

Dear Sushil and Fullar,
Your inputs are most appreciated. I am sure
Digit’s readers would love your solutions.
Thank you very much indeed.

—Executive Editor

Inbox

Write to the Editor
E-mail: editor@thinkdigit.com

Snail Mail: The Editor, Digit, D-222/2, Om Sagar
Building, MIDC, TTC Industrial Estate,  Nerul, 
Navi Mumbai 400 706

Digit will publish the best letters on these pages.
Letters may be edited for clarity

For subscription queries, call the Help Desk at 
022-27629191/9200 Fax 022-27629224, or 
send an e-mail to help@jasubhai.com
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Environment-friendly Digit
I am one of those lakhs of readers
Digit has. I must also admit, I am
quite infrequent, even if I would like
to buy it every month. 

I still preserve the first copy of
Digit, which was published in June
2000. Since then, I have been buying
every now and then, whenever there
was a special issue (and there were
several). The result? I have a whole
rack at home reserved specially
for Digit copies.

For me, the biggest
attraction for buying the
magazine was the fully-loaded
CDs. They were, and now the
DVDs that are absolutely brilliant. I
still preserve all my CDs along with
their covers, lest I forget its contents.
Even today, I refer to these CDs to get
the software I require. 

A recent incident reaffirmed my
faith in the contents of your CDs and
DVDs. I am currently pursuing my
graduation in information
technology. Since my library is a Digit
subscriber, I have no problems
gobbling up all the information in
the magazine in text format. But our
college does not allow us to access
the CDs and DVDs, which become
college property. 

May I suggest that you start,
along with your current great
scheme of four movie DVDs, a CD-
only subscription, without the
magazine. I would be really happy if
you start one soon.

The primary reason for not
subscribing is because of the
magazine pile-up, and they are not
something I want to throw. Because
of this reason, the read, re-read and
re-re-read issues have just piled up
over time. 

You could engage an organisation
to collect old magazines and recycle
them to make new magazines. The
idea may seem bizarre, but you
would be the first company ever to
publish a truly environment-friendly
magazine. 

Also, it could add to your image,
giving rise to hugely positive public
opinion of your company.

Mohammed Shaik Hussain Ali
Via e-mail

Letter 
of the
Month
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Ateam of scientists at
Rambam Hospital in
Haifa, Israel, has

invented a machine that can
measure how randy one is
feeling. The gadget has been
dubbed, rather obviously, the
‘hornometer’, and calculates
whether a person is feeling
randy. British tabloid The Sun
reported that patients are
asked to watch erotic videos,

along with “films of a non-
sexy nature.”

Electrodes attached to
their heads read the electrical
responses to the images. A
computer then analyses the
data to measure the patient’s
libido levels.

Like we need a machine to
figure how sexed up we are
feeling. Or someone else, for
that matter.

People And Events That Grabbed Headlines—For Better Or For Worse

The things people do on
the Internet these days!
It seems it is possible to

become a minister over the
Net. Hollywood star Sharon
Stone did just that—getting
ordained online—in order to
officiate at the wedding of two
of her friends.

The 46-year-old actress
married restaurant owner
Michael Bourseau and stylist
Brenda Swanson in a ceremo-
ny witnessed by actors Jack
Nicholson and Robert Wagner.

The event was conducted
by Ms Stone at her luxury
home in Coldwater Canyon.

Stone Becomes
Minister On Net

After Bill Gates’ visit to
Las Vegas for the
Consumer Electronics

Show, rumours are rife that
the man is getting a PR
makeover. The Microsoft
chairman gave his first inter-
view to a blog—Gizmodo—at
the show. He also hung out
with a couple who won a
‘meet a celebrity’ contest
sponsored by Swatch. And
most of all, he agreed to be
photographed in bed with an
Apple laptop.

All this led CNET
News.com commentator Jeff
Pelline to suggest that Mr 
Gates has aged and lightened
up. Only time will tell

whether the apparent soften-
ing-up of Bill Gates is perma-
nent, or whether it’s just a
Vegas thing.

The New-look Bill Gates

Why are you living?
This is, of course,
the ultimate

question. And since you can
buy just about anything at
eBay, it turns out that you
can buy the answer to that
question, too. Refer to this
issue’s Escape for other weird
eBay auctions.

The title of the auction
was “Purpose in life—do you
need it? Get a Purpose in

Life.” It began at just 99 cents.
What the seller was offering
was what he (or she) desires
for his (or her) life. Of course,
that may or may not be the
same as what you want.

“Do you feel aimless,
undirected, and unfulfilled?
Do you desire a reason, point
and a purpose in your life? If
so you have come to the
RIGHT auction,” the item
description began. And then
the details: “the five-year plan
for your life,” “five of my best
life stories that have givin (sic)
me purpose,” and, most
important, “a certificate of
authenticity signed by me.”

Last time we checked, the
bidding had reached $5.50.

The seller is apparently
not aware of the thousands of
self-help books out there.
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Self-Help Books, Anyone?

You In The Mood, Baby?

Nonu and Cornelia
Dragoman, from Medias,

Romania, recently had a baby
and named him Yahoo, after
the Web portal. They’d had a
virtual relationship for three
months before seeing each

other and finally tying the
knot. Cornelia said, “We
named him Lucian Yahoo, one
name after my father and the
other from the computer.
These were the two elements
which guided my life.”

Conceived On The Net

Wisdom @ $5.50

Has he mellowed with age?

Anything for friends: Sharon Stone




